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Preface

Thank you for purchasing Application Storage Manager™ (ASM) MediaStor, 
the most flexible hardware management system for Microsoft® Windows® 
NT/2000. MediaStor allows you to make storage media available to the ASM 
Data Manager, and to manage the media in storage devices attached to the 
MediaStor computer. All drive, library, and media specific issues are handled 
and optimized by MediaStor, allowing clients to simply save and retrieve files 
as needed. 

MediaStor provides comprehensive drive and library management 
capabilities, allowing you to make multiple types of media and media devices 
available to Data Manager. MediaStor also monitors system warnings and 
errors, and can be configured to send alerts to specific users or computers. 

This System Guide explains how to install, configure, and utilize MediaStor to 
manage the hardware being used for file migration. It contains all the 
necessary information to achieve the best results for implementing and 
customizing your ASM automated data storage solution.

■ Chapter Summary
The following table summarizes each chapter of this guide:

Table 1.  Chapter Summary

Chapter Description
Chapter 1: Introduction 
on page 1 

This chapter provides a brief overview of the 
system, including its concepts and components.

Chapter 2: Planning Your 
MediaStor System on 
page 13 

This chapter contains planning 
recommendations, system requirements, 
storage media information, and other 
considerations for your MediaStor system.

Chapter 3: Installing 
MediaStor on page 31 

This chapter contains instructions for installing 
the MediaStor software. It also provides an 
overview of the steps required to configure 
MediaStor in order to begin managing libraries, 
towers, and standalone drives. 

Chapter 4: Working in the 
Administrator on page 43 

This chapter describes the Administrator 
interface and basic MediaStor functionality.
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Chapter 5: Managing 
Hardware on page 55 

This chapter provides details on configuring 
MediaStor hardware and managing libraries, 
towers, and standalone drives.

Chapter 6: Managing 
Storage Media on page 
99 

This chapter deals primarily with accessing 
information about the media in MediaStor 
hardware devices, as well as how to move the 
media between the Application and Scratch 
Pools.

Chapter 7: Managing the 
MediaStor Computer on 
page 111 

This chapter discusses how to manage the 
MediaStor service and MediaStor computer 
properties, as well as how to troubleshoot using 
logs and event viewing.

Chapter 8: Running 
MediaStor Reports on 
page 135 

This chapter discusses how to run MediaStor 
reports, and set up and save custom layouts for 
your MediaStor reports. It also provides 
information on the data contained in the reports.

Chapter 9: MediaStor 
Backup and Recovery on 
page 149 

This chapter discusses the functions available in 
MediaStor to allow you to effectively back up 
your MediaStor system, as well as procedures 
for restoring your MediaStor system in the event 
of disaster or failure.

Chapter 10: Remotely 
Administering MediaStor 
on page 157 

This chapter describes how to install the 
Remote Administrator component, which allows 
you to administer MediaStor from a computer 
not attached to your hardware device(s). 

“Using SCSI Manager” 
on page 171

This chapter describes the SCSI Manager utility, 
which allows you (independent of MediaStor) to 
view all SCSI devices connected to the 
MediaStor computer and perform diagnostics.

“Using Jukebox 
Manager” on page 205

This chapter describes the Jukebox Manager 
utility, which allows you (independent of 
MediaStor) to view all libraries connected to the 
MediaStor computer.

“Using RtfPad” on 
page 217

This chapter discusses how to save, print, and 
e-mail the MediaStor logs and reports using 
RtfPad. It also contains information on looking 
up errors that appear in logs in RtfPad.

“Removing MediaStor 
and Its Components” on 
page 223

This chapter provides detailed instructions for 
uninstalling MediaStor and the Remote 
Administrator.

Table 1.  Chapter Summary (Continued)

Chapter Description
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■ Related Documentation
Refer to the following additional documentation: 

• ASM Data Manager Getting Started Guide

• ASM Data Manager System Guide

• ASM Upgrade Guide

■ Online Help
Help is available online from any MediaStor dialog box. For a description of 
the dialog box, press the <F1> key. A Help window appears, outlining the 
dialog box parameters and fields.

A knowledge base help file with error descriptions, tech notes, software notes, 
fixed/known software defects is available on the StorageTek website at http://
www.support.storagetek.com. The knowledge base is also available on the 
StorageTek MediaStor program group on the Start menu. All ASM guides, 
including this one, are also available in PDF format on the installation CD. 

■ Documentation Conventions
Consistent formatting is used throughout all ASM guides to represent certain 
information.

Table 2.  Documentation Conventions

This Cue Represents
monospaced text Characters that must be typed on your screen 

exactly as they appear in this document.

<ALL CAPITALS> Keys on your keyboard used in combination or 
sequence. For example <ALT>+B means to hold 
down the <ALT> key while pressing b, and <ALT>, 
F, X means to press and release each of the keys in 
order: first <ALT>, then f, then x.

ALL CAPITALS Directory names, filenames, and acronyms.

http://www.legato.com/support/knowledgebase
http://www.legato.com/support/knowledgebase
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italics References to manual titles, chapter titles, and 
section headings; placeholders; and emphasis.

Note 
Explanatory note 
between two lines. 

Additional information needed as you follow the 
step-by-step operations in this manual.

Table 2.  Documentation Conventions (Continued)

This Cue Represents
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1Introduction

ASM MediaStor is a remote storage solution that provides transparent 
hardware control and support for multiple media types and device types. You 
can use MediaStor to make terabytes of data accessible to applications that 
need extended storage capabilities. 

For example, users on your network may typically save data to an NTFS 
volume on your Windows NT/2000 file server. If ASM Data Manager is 
installed on the file server, the Data Manager can migrate files to media in 
devices attached to a computer where MediaStor is installed. MediaStor 
receives requests from Data Manager for pieces of media in devices and 
retrieves media within a device according to those requests.

You are the architect of the ASM system. MediaStor allows you to leverage 
your existing hardware configuration or create a new one. MediaStor 
combines an easy-to-use graphical user interface with extensive device 
support to provide a device management solution that can be adapted to 
almost any Windows NT/2000 environment. Because ASM supports several 
media types, file systems, and a multitude of storage devices, you can select 
the configuration most suited to your available resources and your storage 
needs. 

Before setting up your storage system, you should be comfortable with 
MediaStor terminology and concepts. Take the time to read all sections of this 
guide, as this will help you attain the best performance, functionality, and 
organization for your storage solution.

The following sections identify key terminology and concepts that are central 
to an understanding of MediaStor. Included are descriptions of MediaStor 
modules, conceptual and practical definitions, as well as guidelines for 
planning and implementing your ASM storage strategy.

• "A MediaStor Glossary, " which follows

• “MediaStor Components” on page 4

• “The Role of a Media Service in Remote Storage” on page 8

• “MediaStor Concepts” on page 8
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■ A MediaStor Glossary
The terms used in the following concepts discussions and throughout this 
guide are described in the table below. 

Table 1.  MediaStor Glossary

Term Definition
Application Pool A reserve of pieces of media allocated for use with a 

particular Data Manager extended drive

Cluster A processing environment consisting of two or more 
server computers and other resources that act as a 
single system and enable high availability

Data Manager An ASM module that allows you to extend the storage 
capabilities of NTFS volumes by using file migration 
services to move files from the NTFS volume to other, 
less-expensive storage media

Device Hardware. Throughout this guide, the term “device” is 
used to describe towers, standalone drives, and library 
systems.

Dismount Media The process of removing media from a drive. In the case 
of a standalone drive or tower, the media is dismounted 
when you manually remove it from the drive. In the case 
of a library, the media is dismounted by an internal 
mechanism in the library that removes the piece of 
media from the drive and places it on a shelf in the 
library. 

Extended Drives An NTFS volume (hard drive) or partitioned part of a 
hard drive for which Data Manager provides file 
migration services by moving files to media and fetching 
files from media according to the parameters you set.

File Migration The movement of files and file data from one type of 
media (a hard drive) to other types of media (such as 
optical or tape media)

File System Software that provides an interfac e for saving and 
retrieving files on storage media. File systems control all 
aspects of media management, including directory/file 
structures, data layout, and data transfer. 

Hardware 
Device

A device that contains drives where media can be 
accessed
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Jukebox/ Library A hardware device containing one or more removable 
media drives, shelves for pieces of media, and a 
mechanism for moving pieces of media between the 
shelves and the drives. The terms “jukebox” and “library” 
are interchangeable. In most instances in this manual, 
the term “library” is used to refer to libraries or 
jukeboxes.

Media A physical medium on which data is written and from 
which data can be retrieved. Depending on the type of 
media, the medium may be different and the information 
may be recorded in different ways. In most instances in 
this guide, the term “media” refers to the storage media 
contained in a device managed by MediaStor.

Media Pool A reserve of pieces of media available for use with a 
particular extended drive.

Media Service An access provider for the media to which Data Manager 
migrates files. In some cases, the media service is a 
connection to a network share. In other cases, a media 
service is a device management service that retrieves a 
specific piece of media and mounts the media in a 
device such as a library when requested. MediaStor is a 
media service.

Media Type The type of a piece of media, which is determined by the 
composition of the media and the method used to record 
information on that media. Some examples of media 
types are magneto-optical, CD-ROM, DVD-RAM, and 
tape. 

Mount Media The process of inserting media into a drive. In the case 
of a standalone drive or tower, the media is mounted 
when you manually insert it in the drive. In the case of a 
library, the media is mounted by an internal mechanism 
in the library that retrieves the piece of media from a 
shelf and inserts it in the appropriate drive. 

Overwritable Describes media that allows files to be written to any 
available location on the media. For ASM, this pertains 
specifically to how the UDF file system writes files to 
some types of media.

Removable 
Media Drive

A drive where different pieces of media can be inserted 
and removed as needed, such as a CD-ROM drive

Table 1.  MediaStor Glossary (Continued)

Term Definition
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■ MediaStor Components
MediaStor is comprised of several components, and each has specific 
functionality within the system. For more information, see the following 
sections:

• "MediaStor, " which follows

• “Command Line Utilities” on page 7

MediaStor
The MediaStor component consists of the following modules:

• "MediaStor Setup, " which follows

• “MediaStor Service” on page 5

• “MediaStor Administrator” on page 5

• “MediaStor Remote Administrator Setup” on page 6

• “MediaStor Remote Administrator” on page 6

• “SCSI Manager” on page 6

• “Jukebox Manager” on page 7

• “Online Help” on page 7

Removable 
Media

Media that must be mounted in a drive before it can be 
accessed. Removable media can be inserted and 
removed as needed to allow for access to multiple 
pieces of media. 

Scratch Pool A reserve of pieces of media that have not been 
allocated for use with a particular Data Manager 
extended drive

Sequential Describes media that require files to be written in 
sequential order (one right after another) on the media. 
For ASM, this pertains specifically to how the UDF file 
system writes files to some types of media.

Stationary Drive A drive where the same piece of media is always 
mounted, such as the hard drive on your computer

Stationary Media Media that is always mounted in a drive and cannot be 
removed without removing the entire drive

Table 1.  MediaStor Glossary (Continued)

Term Definition
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MediaStor Setup
The MediaStor Setup module is used to install MediaStor and to upgrade from 
previous versions of MediaStor. The MediaStor Setup module installs the 
MediaStor Administrator, Online Help, and Jukebox and SCSI Manager 
utilities. 

The module remains in the StorageTek MediaStor program group, where it can 
be used to modify registration and license information. If necessary, the 
module can also be used to uninstall MediaStor. 

For more information on running MediaStor Setup, see “Running the Setup 
Wizard” on page 33. For more information on upgrading MediaStor, refer to 
the ASM Upgrade Guide.

MediaStor Service
The MediaStor service is a Windows NT/2000 service that runs on the 
computer where MediaStor is installed. All of the hardware devices used to 
access media in the ASM system are attached to the MediaStor computer. 
MediaStor coordinates all hardware device management in response to 
requests for media from other applications. MediaStor service functionality can 
be managed through the MediaStor Administrator, either on the MediaStor 
computer or from any remote installation of the MediaStor Administrator. 

MediaStor Administrator
The MediaStor Administrator allows you to view and configure the underlying 
structure of the MediaStor system, providing a single interface for managing 
the hardware devices in the system and the allocation of media in those 
devices. Through this module, you can manage all major aspects of the 
MediaStor system, such as: 

• Hardware (storage devices attached to the MediaStor computer) 

• Allocation of media to Data Manager extended drives

• MediaStor status (tracking of events, errors, or warnings; running of 
reports; and configuration restoration if needed)

The Administrator has an intuitive “tree” view where each of the hardware 
devices added to MediaStor are listed as nodes on the tree. The tree also has 
nodes for Application Pools, which list media that have been allocated for use 
by Data Manager. In addition, a “Scratch” media pool lists media not yet 
allocated to a Data Manager extended drive. 

Within the Administrator, you define the resources that are used by MediaStor. 
You can add and configure hardware (standalone drives, towers, and libraries) 
and configure system parameters. Devices can be set online or offline, and 
device properties can be viewed or modified through the Administrator.
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When you add media to devices in use by MediaStor, each piece of media 
appears in the Scratch Pool. Media listed in MediaStor are shown under 
nodes describing the media (original, copy, duplicate, blank, foreign, unknown, 
unformatted, and corrupt). As Data Manager services configure MediaStor for 
use as their media service, the Data Manager extended drives appear in the 
MediaStor Administrator as Application Pools. You can assign storage media 
to for use by a particular Data Manager extended drive by moving or dragging 
media from the Scratch Pool to the appropriate Application Pool.

For more information on the Administrator, see “Working in the Administrator” 
on page 43.

MediaStor Remote Administrator Setup
The MediaStor Remote Administrator Setup module is used to install the 
MediaStor Remote Administrator and to upgrade from previous versions of the 
MediaStor Remote Administrator. The MediaStor Remote Administrator Setup 
module installs only the MediaStor Administrator interface and Online Help. 

The module remains in the StorageTek MediaStor Administrator program 
group where it can be used to modify registration information. 

If necessary, the module can also be used to uninstall the MediaStor Remote 
Administrator.

For more information on running MediaStor Remote Administrator Setup, see 
“Installing the Remote Administrator” on page 159.

MediaStor Remote Administrator
Regardless of whether you are running a full installation of MediaStor or only 
the Remote Administrator, the Administrator interface for MediaStor can be 
used to configure any MediaStor computer visible on the network (provided 
security settings allow access and the MediaStor installation is the same 
version as or higher than the Remote Administrator). 

Because enterprise (remote) administration capability is automatically 
installed when you install MediaStor, you can remotely administer any 
MediaStor computer from any other MediaStor computer. 

MediaStor (full installation) needs only to be installed on computers where the 
hardware devices containing the storage media for the ASM system are 
attached.

For more information on using the MediaStor Remote Administrator, see 
“Remotely Administering MediaStor” on page 157.

SCSI Manager
The SCSI Manager utility is a diagnostic tool for performing direct SCSI device 
commands independent of the MediaStor Administrator. Included are features 
for viewing device profiles, browsing media (drives only), issuing standard or 
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vendor unique commands, and retrieving sense, log, or other data from 
devices. For more information on SCSI Manager, see “Appendix A: Using 
SCSI Manager” on page 137.

Jukebox Manager
The Jukebox Manager utility provides an interface for performing direct library 
device diagnostics independent of the MediaStor Administrator. Both SCSI 
and serial libraries can be managed through this utility. Included are features 
for viewing library profiles, performing a library inventory, performing media 
operations (mount, dismount, insert, eject, flip), and reporting errors for 
specific SCSI or serial sense information. For more information, see “Using 
Jukebox Manager” on page 205

Online Help
MediaStor contains context-sensitive help links that provide instructional help 
and examples. The online help is automatically installed with MediaStor and 
with the MediaStor Remote Administrator. Press the <F1> key at any time to 
get help on the currently displayed dialog box, window, or wizard page. There 
is also a knowledge base help file with error descriptions, tech notes, software 
notes, and fixed/known software defects available on the StorageTek website 
at http://www.support.storagetek.com. You can also access the knowledge 
base from the StorageTek MediaStor program group in the Start menu. 

ASM License Server
Licensing information for your ASM system is managed on the ASM License 
Server. The License Server is the program through which the licenses for your 
ASM products are registered and maintained. The License Server program is 
included on the ASM installation CD and can be installed on an ASM computer 
or on a separate computer, as long as that computer is visible to the ASM 
computer through the network.

Use the Edit product license information option in the MediaStor Setup Wizard 
(accessed through the StorageTek MediaStor program group) to point to the 
License Server computer once your licensing information has been registered 
in the License Server. For more information on using the License Server, refer 
to the License Server System Guide. 

Command Line Utilities
MediaStor includes several utilities that allow you to perform device 
troubleshooting independently. These utilities are located in the \Program 
Files\Legato\MediaStor\Bin\ directory, and are run from the command prompt. 
The Knowledge Base contains additional information about the command line 
utilities. However, if you are planning to run any of the command line utilities, 
we strongly recommend you contact your technical support representative.

http://www.legato.com/support/knowledgebase
http://www.legato.com/support/knowledgebase
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■ The Role of a Media Service in Remote Storage
Media services provide access to media. MediaStor was designed for use in 
conjunction with the ASM Data Manager, which provides file migration 
services. MediaStor provides device management services, passing 
commands to the robotics within hardware devices on behalf of Data 
Manager. 

For example, a Data Manager computer is storing files to media in an optical 
library managed by MediaStor. When a Data Manager computer requests a 
piece of media so it can write files to that media or retrieve files from the 
media, MediaStor sends commands to the library that cause the picker arm for 
the library to move to the shelf where the piece of media is located. The picker 
arm picks up the piece of media and inserts it in a drive for use by Data 
Manager. 

Figure 1.  MediaStor With Data Manager 

Several hardware configurations can be used with MediaStor, allowing you to 
create a storage system suited to your needs and available resources. 
MediaStor can reside on the same computer as Data Manager, or it can be 
installed on a separate computer. A MediaStor system can manage devices 
on behalf of multiple Data Manager services (computers). 

■ MediaStor Concepts
The following concepts are integral to understanding MediaStor:

• "Storage Devices, " which follows

• “Media Types” on page 10

• “MediaStor System Management” on page 10

Computer with
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attached devices via Remote
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Storage Devices
Storage devices are hardware devices that allow you to access multiple 
pieces of high-capacity removable storage media. Adding a new piece of 
media can always increase the total storage capacity available through a 
storage device. Use of a storage device through MediaStor provides you with 
practically unlimited storage space.

Note: The term “device” refers to hardware and is used throughout this guide 
to describe towers, standalone drives, and library systems. 

MediaStor can manage one or many standalone drives, towers, and library 
devices (limited only by software licenses and system bus resources). For 
more information, see the following sections:

• "Library, " which follows

• “Standalone Drive” on page 9

• “Tower” on page 9

Library
Sometimes referred to as autochangers or jukeboxes, libraries have shelves 
for storing media, one or more drives, and a robotic (or picker) arm that can be 
controlled via software to mount and dismount media. MediaStor manages 
library devices and handles mounting and dismounting of requested media 
automatically, transparent to the client application. For more information on 
adding and managing libraries in MediaStor, see “Managing Libraries” on 
page 56.

Standalone Drive
Standalone drives (internal or external) are non-library drive devices managed 
by you and MediaStor. You are responsible for mounting and dismounting 
media in standalone drive devices, and MediaStor and the Data Manager 
computers it services automatically manage the media once the media is in 
the drive.

When using standalone drives, you receive an error when you attempt to 
access data files on offline media. The MediaStor alert viewer tells you what 
media to mount, and, once the media has been mounted, you can retry the 
request and retrieve the file.

For more information on managing standalone drives, see “Managing 
Standalone Drives” on page 89.

Tower
A tower is a case containing several standalone drives. You and MediaStor 
manage tower devices. You are responsible for mounting and dismounting 
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media in tower drive devices, and MediaStor manages the media once the 
media is in the drives.

When using tower drives, you receive an error when you attempt to access 
data files on offline media. The MediaStor alert viewer tells you what media to 
mount, and, once the media has been mounted, you can retry the request and 
retrieve the file.

For more information on managing towers, see “Managing Towers” on 
page 81.

Media Types
MediaStor supports many high-capacity storage media types. The functionality 
accessible through a device depends on the type of media used in the device. 
The following table defines all media types currently supported: 

Once you have configured a MediaStor media service and created an 
extended drive in ASM Data Manager, you can allocate media to that 
extended drive through MediaStor or through Data Manager. Allocating media 
to a Data Manager extended drive makes the media available to the Data 
Manager service so that you can begin migrating files to and reading files from 
that piece of media. 

For more information on managing media, including allocating media, see 
“Managing Storage Media” on page 99. For more information on the types of 
media that MediaStor supports, see “Storage Media Considerations” on 
page 14. 

MediaStor System Management
MediaStor contains several features that allow you to administer, diagnose, 
and troubleshoot the system, as well as to back up the system and restore it in 
the event of a system failure. In addition, because the MediaStor program 

Table 2.  Currently Supported Media Types

Media Type Support Type
CD-ROM Read Only

DVD-R Read/Write

DVD-ROM Read/Only

DVD-RAM Read/Write

Magneto-Optical Read/Write

Tape Read/Write

WORM Read/Write

WORM-Tape Read/Write
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functions as a Windows NT/2000 service, part of administering the MediaStor 
computer includes administering the MediaStor service. For more information, 
see the following sections:

• "MediaStor as a Service, " which follows

• “Logs and Reports” on page 11

• “Backup and Recovery” on page 11

MediaStor as a Service
MediaStor functions as a Windows NT/2000 service rather than as a user-
mode application. As a Windows NT/2000 service, MediaStor can continue to 
be active even after you log off Windows, as long as the computer is still 
running.

You can start, pause, and stop MediaStor, as well as configure it for various 
startup settings, including automatic startup, which starts MediaStor upon 
Windows system startup, and manual startup, which allows you to start the 
service manually. You can manage the service either through the MediaStor 
Administrator or through Windows. 

For more information, see “Managing the MediaStor Service” on page 111. 

Logs and Reports
MediaStor has built-in utilities for monitoring events, errors, and warnings on 
the system. The Event Viewer contains a listing of all MediaStor events, 
errors, and warnings. This information is also logged to event logs. The Event 
Viewer and event logs can help identify and solve potential problems during 
runtime that might otherwise become critical problems if ignored. For more 
information on the Event Viewer and event logs, see “Tracking MediaStor 
Events, Errors, and Warnings” on page 127.

The MediaStor reporting feature is a useful tool for tracking system statistics. 
Using the Report Generator Wizard, you can create various reports of system 
activities, including media information, hardware configuration, and MediaStor 
registry settings. In addition, the reporting function allows you to create and 
save custom layouts for your reports, and to choose the layout you want when 
the report is run. For more information on reports, see “Running MediaStor 
Reports” on page 135.

Backup and Recovery
Because constant and reliable access to your data is one of the most critical 
parts of your system, we recommend that you have a comprehensive disaster 
recovery plan in place in the event of system problems or an entire system 
shutdown. MediaStor allows you to create a backup of your MediaStor system 
configuration, which is stored in registry settings, when needed using the 
repair disk utility.
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In the event of system failure, you can restore the MediaStor system 
configuration. For more information, see “MediaStor Backup and Recovery” on 
page 149.

In addition, if you use a clustered environment to manage fault-tolerance for 
your system, MediaStor can be installed and run on a clustered environment, 
allowing for automatic fail-safe of your MediaStor system. For more 
information, refer to Appendix A: Clustering of the ASM Data Manager Getting 
Started Guide. 
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2Planning Your MediaStor 
System

Before installing ASM MediaStor, you will want to consider the optimal 
hardware and configuration for your system. Some issues to consider include:

• The number of MediaStor computers to use

• What type(s) of hardware devices to use

• What type(s) of storage media to use

• What type(s) of file systems to use

Some organizations have existing file storage systems, and may have already 
decided on an optimum arrangement for file servers. There is no need, in 
implementing MediaStor, to modify your chosen arrangement. Additional 
hardware devices can be added to a MediaStor system as file storage needs 
on a network increase. 

For more information on planning your MediaStor system, see the following 
sections:

• "System Requirements, " which follows

• “Storage Media Considerations” on page 14

• “Windows NT/2000 Security” on page 22

• “Maximizing MediaStor Performance” on page 25

■ System Requirements
Before you install MediaStor, be sure that your hardware and operating 
system meet the MediaStor system requirements. For more information, see 
the following sections:

• "Operating System Requirements, " which follows

• “MediaStor Computer Specifications” on page 14
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Operating System Requirements
Because MediaStor functions as a Windows service, we recommend using the 
following operating systems:

• Windows NT 4.0 Server with Service Pack 6a, or

• Windows 2000 with Service Pack 2 or 3. 

The Windows NT/2000 Server editions optimize performance and are 
recommended but not required. 

If you are using a different operating system on the server on which you plan 
to install MediaStor, you must upgrade the operating system before installing 
MediaStor. Consult your Windows NT/2000 documentation for information on 
installing the operating system.

In addition, if you are planning to install MediaStor on a clustered environment, 
be sure to check your operating system requirements, and make sure the 
hardware in your cluster meets or exceeds the minimum specifications noted 
by the operating system documentation. MediaStor cluster installation is 
supported on Windows NT Enterprise Edition 4.0 with Service Pack 6a or 
Windows 2000 Advanced Server Edition with Service Pack 2 or 3 using 
Microsoft Cluster Server. For more information on using MediaStor with 
Microsoft Cluster Server, refer to Appendix A: Clustering of the ASM Data 
Manager Getting Started Guide. 

For information on the latest Windows service packs and hot fixes certified for 
use with MediaStor, contact your technical support representative. For 
information on operating system issues that may affect performance on your 
MediaStor system, consult the ASM Knowledge Base. The Knowledge Base 
can be found online at http://www.support.storagetek.com. 

MediaStor Computer Specifications

MediaStor computers should have the following minimum configurations:

• Pentium class PC 

• At least 128 MB of RAM for Windows NT, or 256 MB of RAM for Windows 
2000

• One or more SCSI host adapters supported by Windows NT/2000

• One or more SCSI or serial storage devices supported by MediaStor

■ Storage Media Considerations
Storage media is an integral part of your ASM system. The type of storage 
media you use determines how your media, and therefore your files, must be 
managed.

http://www.legato.com/support/knowledgebase
http://www.legato.com/support/knowledgebase
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MediaStor supports many high-capacity storage media types for the media to 
which files are migrated. The functionality accessible through a device 
depends on the type of media used in the device. You need to evaluate the 
following when considering what media is best suited to your MediaStor 
system:

• "Types of Media, " which follows

• “Types of Media File Systems” on page 17

Types of Media
MediaStor supports many high-capacity storage media types. Once added to 
the MediaStor system, these media are the storage to which your files are 
migrated. The following table defines all media types currently supported:  

Note: MediaStor does not currently support CD-R, CD-RW or DVD-RW 
media. 

CD-ROM Media
CD-ROM stands for Compact Disc – Read Only Memory. As its name 
indicates, CD-ROM media is read only and cannot be written to. The data is 
stamped onto the CD by the vendor and cannot be erased. CD-ROM can use 
the ISO-9660, High Sierra or Joliet file systems. Each of these are most 
effectively recognized and readable through ASM using the NTFS file system; 
however, CSS, the ASM CD file system, can also read CD-ROM media.

Table 3.  Currently Supported Media Types

Media Type Support 
Type

For More Information, See...

CD-ROM Read Only "CD-ROM Media, " which 
follows

DVD-R Read/Write “DVD-R Media” on page 16

DVD-RAM Read/Write “DVD-RAM Media” on page 16

DVD-ROM Read Only “DVD-ROM Media” on page 16

Magneto-Optical Read/Write “Magneto-Optical Media” on 
page 16

Tape (DLT, AIT, 9840, 
Magstar, 8mm DAT)

Read/Write “Tape Media” on page 16

WORM Read/Write “WORM Media” on page 16

WORM-Tape Read/Write “WORM-Tape Media” on 
page 17
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DVD-R Media
DVD-R (DVD - Recordable) media is both readable and writable; however, 
you can write data to it only once (although in multiple sessions). Once DVD-R 
media is full, you can finalize the media, at which point it becomes read-only.

DVD-RAM Media
DVD-RAM is a rewritable, high-density optical disc media. DVD originally 
stood for Digital Versatile Disc or Digital Video Disc, but is now simply referred 
to as DVD. RAM, or Random Access Memory, refers to the way data is written 
to and read from the disk. RAM media can be written to and read from 
randomly, as opposed to sequentially, accessing files and space wherever 
necessary.

DVD-ROM Media
DVD-ROM stands for DVD - Read Only Memory. As its name indicates, DVD-
ROM media is read-only; you cannot write files to it. Like CD-ROM, DVD-ROM 
media is pre-manufactured, meaning the data is stamped onto the media and 
cannot be erased. Most manufactured DVD-ROMs use the ISO-9660 file 
system format, which, like CD-ROM, is recognized by ASM using the NTFS 
file system. Be advised, however, that the ASM interface identifies DVD-ROM 
media as CD-ROM because the file system drivers cannot distinguish 
between the two types of media and only recognize the ISO-9660 file system 
format.

Magneto-Optical Media
Optical media refers to removable media that is written to by lasers. Magneto-
optical media (also often called erasable optical) are optical disks that can be 
written to, erased, and loaded with new data.

Tape Media
Tape media are electromagnetic data storage devices that are typically both 
readable and writable; however, you can write data to each sector on a piece 
of tape only once unless you reformat the media in order to reuse it. Tape 
media are read by tape drives that mount, write to and read from the tape. 
Tape media is often encased in a tape cartridge that protects the magnetic 
tape itself and makes it easily portable.

ASM supports the following types of tape media: 8mm DAT, AIT, 9840, 
Magstar, and DLT.

WORM Media
WORM stands for Write Once Read Many. WORM is an optical disk 
technology that allows you to write data to a disk only once, but read that data 
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back as often as needed. Once written to, WORM media acts just like CD-
ROM media in that the data on the media is permanent. 

WORM-Tape Media
WORM-tape media are identical to tape media, in that they are 
electromagnetic data storage devices that are typically both readable and 
writable. However, you can write to a piece of WORM-tape only once (Write 
Once Read Many), and unlike standard tape, the media cannot be reformatted 
for reuse. Once written to, WORM-tape media acts just like CD-ROM media in 
that the data on the media is permanent and cannot be altered. WORM-tape 
media are supported by drives that have firmware loaded that support WORM 
media. Please contact the specific vendor to verify that they support WORM 
media in their drives, and to acquire the firmware version that supports the 
WORM media. 

Types of Media File Systems
When a hardware device is configured, a file system must be selected for that 
device: either a Windows Native file system, an ASM file system, or a 
Universal Disk Format (UDF) file system. A file system is software that 
provides an interface for saving and retrieving files on storage media. File 
systems control all aspects of media management, including directory/file 
structures, data layout, and data transfer. 

Media can be formatted for file systems that are supported by both the media 
itself and the device (used by the media service) in which the media resides. 
Once a file system is selected for a device, all media used in the device must 
be formatted with that file system in order for the device to read from or write 
to the media. Any media containing a different file system must be reformatted 
using the supported file system to be recognized by the device.

Although multiple file systems can be used in one MediaStor service (using 
multiple devices), they cannot be mixed in the same hardware device. Multiple 
file systems are recommended only for advanced systems with higher data 
organization requirements. In general, however, one file system should be 
chosen, and all devices and media should be formatted for that file system. 
This allows all media to be interchangeable between devices.

Windows NT/2000 installs the Windows Native file system drivers, and ASM 
MediaStor installs the ASM and UDF file system drivers. There are three 
Windows Native file systems (NTFS, CDFS, and FAT), three ASM file systems 
(OSS, TSS, and CSS), and two types of UDF file systems (overwritable and 
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sequential). The following table lists MediaStor file system support by media 
type: 

When formatting media through ASM Data Manager, the option of what file 
system is used for the media is determined by the file system selected for the 
device in which the media is contained.

Note: The MediaStor interface only refers to “ASM”, “UDF”, and “NTFS” 
where media file systems are noted. The media type determines which 
file sub-system is applied. 

Each file system has benefits and limitations relating to the features and 
performance of the media to which it is applied. In some cases, you do not 
have a choice as to which file system to use: WORM, WORM-tape, and tape 
can only use an ASM file system, and DVD-R can only use the UDF file 
system. For magneto-optical and DVD-RAM media, however, you must 
choose a file system that best suits your needs. There are two factors to 
consider: media portability and media performance.

Media portability refers to the ability to read and write to media on Windows 
managed devices outside of ASM. If, for example, media used to archive files 
through ASM will be distributed to locations that do not have an ASM 
installation, media portability is a concern and should be considered when 
determining what file system and type of storage media you will use.

Media performance refers to the speed with which ASM can write to and read 
from storage media. 

Table 4.  MediaStor File System Support by Media Type

Media Type Supported File Systems
CD-ROM CDFS (Windows Native file system, read-only)

CSS (ASM file system, read-only)

DVD-R UDF file system (sequential)

DVD-RAM OSS (ASM file system)

UDF file system (overwritable)

DVD-ROM CDFS (Windows Native file system, read-only) 

Magneto-Optical OSS (ASM file system)

UDF file system (overwritable)

NTFS (Windows Native file system)

FAT (Windows Native file system, read-only)

Tape TSS (ASM file system)

WORM OSS (ASM file system)

WORM-Tape TSS (ASM file system
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As a general rule, if portability of optical media is a concern, choose Windows 
Native file systems. Windows Native file systems are overwritable, meaning 
that files are written to any available location on the media. While these file 
systems have a performance disadvantage for optical media in comparison to 
ASM file systems, they are 100% portable (media written in these formats can 
be read on any Windows system, with or without ASM). 

ASM file systems are optimized for ASM media performance. Unlike Windows 
Native file systems, which are more generic and feature-rich, ASM “storage 
subsystems” implement the minimum set of features required to store and 
retrieve data. For example, ASM file systems are sequential, meaning that 
files are written in sequential order on the media. As a result, runtime 
overhead is very low and data is contiguously organized, enhancing overall 
performance. If portability of storage media is not a concern, choose ASM file 
systems to provide the best overall system performance.

ASM supports UDF file systems in order to support the use of DVD-R media. 
Although you can format magneto-optical media using UDF, it may perform 
slower than OSS or NTFS formatted magneto-optical media, and it does not 
provide a portability advantage over NTFS. (Use FAT for magneto-optical 
media only if you want to provide access to files on media that has already 
been formatted using FAT.) Similarly, for DVD-RAM media, UDF does not 
provide a performance advantage over OSS, and media using UDF is only 
portable to the few systems that support UDF, such as Windows XP. 

Note: For optical media, NTFS is not recommended unless media portability 
is essential. Windows Native file systems are not designed for use with 
optical media. 

For more information on file systems, see the following sections:

• "Windows Native File Systems, " which follows

• “ASM File Systems” on page 20

• “UDF File Systems” on page 21

Windows Native File Systems
Windows Native file systems are provided with Windows NT/2000 and are 
loaded onto the system at the time of the operating system installation. These 
are feature-rich file systems meant for hard drives, but may be desirable for 
storage media if you have portability concerns.

ASM supports three Windows Native file systems:

• "NTFS - New Technology File System, " which follows

• “FAT - File Allocation Table” on page 20

• “CDFS - CD-ROM File System” on page 20
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NTFS - New Technology File System
This Windows Native file system is supported only by Windows and provides 
an optimized file system for large volume media. It is specially designed to 
provide fast access and management of very large volumes of information 
(gigabytes or even terabytes) and is used primarily for magnetic disks (like 
hard drives).

You can choose NTFS for magneto-optical media. 

FAT - File Allocation Table
This Windows Native file system is supported by many different operating 
systems, including DOS, Windows 95/98, and Windows NT/2000. It is an older 
file system that was designed for small-volume (less than 4 GB) management, 
and is not widely used in Windows NT/2000 server environments.

FAT is not recommended for optical storage management. It is based on older 
file system technology and does not handle large volume sizes that today’s 
media capacities require. In addition, the data storage strategy is prone to 
fragmentation and, over time, deteriorates file read/write performance.

The FAT file system is supported by ASM as a read-only file system. This 
means that ASM cannot write (migrate files) to media formatted using FAT.

You can use the FAT file system with magneto-optical media; however, you 
should only use FAT if you want to provide access to files on media that has 
already been formatted using FAT.

CDFS - CD-ROM File System
This Windows Native file system reads three types of CD-ROM and DVD-
ROM formats: ISO 9660, High Sierra, and Joliet. These formats are supported 
by many different operating systems, and are supported natively by Windows. 
Most manufactured DVD-ROM media uses the ISO-9660 format, and is 
readable by ASM using this Windows Native file system. 

ASM File Systems
ASM file systems are installed with MediaStor and are optimized for ASM 
media performance. Unlike Windows Native file systems, which are more 
generic and feature-rich, ASM “storage subsystems” implement the minimum 
set of features required to store and retrieve data. For example, ASM file 
systems are sequential, meaning that files are written in sequential order on 
the media. As a result, runtime overhead is very low and data is contiguously 
organized, enhancing overall performance. 

There are three ASM file systems:

• "OSS - Optical Storage Subsystem, " which follows

• “TSS - Tape Storage Subsystem” on page 21
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• “CSS - CD-ROM Storage Subsystem” on page 21

OSS - Optical Storage Subsystem
This ASM file system supports WORM, DVD-RAM, and magneto-optical 
media. Files are stored contiguously from the beginning to the end of each 
piece of media, with single-seek read and write access. This file system 
provides the best overall read/write performance of all optical file systems 
supported by ASM.

OSS-formatted media requires ASM for reading and writing. This type of 
media may be moved from one ASM system to another, but cannot be read 
without ASM.

When a Delete command is issued, files residing on OSS-formatted media are 
not deleted; only the file tags on the extended drive are actually deleted. 
Deleted file space cannot be reclaimed until the media is compacted (all files 
with file tags on the extended drive are moved back to the extended drive) and 
the media is reformatted. In addition, files that reside on media but whose file 
tags are deleted from the extended drive are restored to the extended drive 
when media is restored to a media folder.

If WORM media support is required, the OSS file system must be used, as it is 
the only one supported by ASM for that type of media.

TSS - Tape Storage Subsystem
TSS is the only file system provided for tape and WORM-tape media 
management. Specifically, ASM supports Digital Audio Tape (DAT) and Digital 
Linear Tape (DLT). Files are stored contiguously from the beginning to the end 
of each tape, as with all tape file systems. 

TSS-formatted media requires ASM for reading and writing. This type of 
media may be moved from one ASM service to another, but cannot be read 
without ASM. 

CSS - CD-ROM Storage Subsystem
This ASM file system supports CD-ROM media, and is provided to allow use 
of certain devices that cannot use the CDFS file system, which is a Windows 
Native file system. We recommend that you try to use the CDFS file system for 
a device and then use CSS if CDFS does not work with the device. 

UDF File Systems
ASM’s UDF implementation meets the specifications (version 2.01) laid out for 
the UDF (Universal Disk Format) file system by the Optical Storage 
Technology Association (OSTA), a nonprofit international trade association. 
For more information on OSTA, refer to the OSTA website, http://
www.osta.org.

http://www.osta.org
http://www.osta.org
http://www.osta.org
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Support for the UDF file system was added to ASM in order to support the use 
of DVD-R media, but you can also use UDF with magneto-optical and DVD-
RAM media. 

UDF is intended to allow file interchange between different operating systems; 
however, only a few operating systems, such as Windows XP, currently 
support the 2.01 specification and can read media using UDF.

There are two types of UDF file systems: overwritable and sequential. For 
more information, see the following sections:

• "Overwritable, " which follows

• “Sequential” on page 22

Overwritable
The overwritable UDF file system allows you to read files from and write files 
to DVD-RAM and magneto-optical. Files are written to any available location 
on the media.

Sequential
The sequential UDF file system allows you to read files from and write files to 
DVD-R media. Files are written in sequential order on the media, and you can 
write files to media only once, although you can write files in multiple sessions.

You can also finalize the media so that it can be read in a Windows XP 
environment. Once media is finalized, you can no longer write files to it.

■ Windows NT/2000 Security 
The user account that MediaStor uses to log on as a service must be a 
member of both the local Administrators group and the local MSAdministrators 
group, and must also have the log on as a service privilege. Since MediaStor 
uses the account entered during installation to log on the MediaStor service, 
this privilege is added to that account during installation. In addition, to 
manage the MediaStor service, the user logged into the MediaStor computer 
must also be a member of both groups (though the log on as a service 
privilege is not necessary). 

Note: If you are installing MediaStor on Windows 2000 Server in an Active 
Directory service environment, be advised that MediaStor only 
supports certain configurations. For details on those configurations, 
and any additional steps required for installing in an Active Directory 
service environment, refer to the ASM Knowledge Base. 

In order to prevent unauthorized users from connecting to MediaStor 
computers, MediaStor creates a local MSAdministrators group on the 

http://www.legato.com/support/knowledgebase
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MediaStor computer when it is installed. MediaStor then automatically adds 
the Domain Admins group for the MediaStor computer’s primary domain to the 
MSAdministrators group. 

When users log into the MediaStor computer, MediaStor checks the user 
group(s) to which they belong. Users who are only members of the 
MSAdministrators group can perform all functions in MediaStor except for 
managing the service. In order to manage the MediaStor service (start, pause, 
and stop the service, and configure service startup settings), a user must be a 
member of both the local Administrators group and a member of the 
MSAdministrators group.

You can verify whether a user is a member of local Administrators group or the 
MSAdministrators group in a few steps. Because MediaStor automatically 
includes all Domain Admins to the MSAdministrators group when you install 
MediaStor, no re-configuration of user rights may be necessary. However, in 
the event you need to either restrict administrator access to the MediaStor 
service, or you need to add or remove administrators from the local 
Administrators or MSAdministrators group, you can do so through Windows. 
For more information, see the following sections:

• "Checking Administrative Group Membership, " which follows

• “Adding Users to Administration Groups” on page 24

• “Removing Users from Administration Groups” on page 25

Note: If you are running MediaStor in a clustered environment, changes or 
additions to the Administrators and the MSAdministrators group must 
be configured on each of the servers in the cluster. 

Checking Administrative Group Membership
Only local Administrators have the necessary rights to view the membership of 
user groups. Before attempting the procedures below, be sure you are logged 
into the MediaStor computer as a local domain Administrator. 

To access the Administrators and MSAdministrators groups and users:

1. You have the following choices:

• If Windows NT is the operating system on the MediaStor computer, 
open the Windows NT Computer Manager. From the Start menu, 
select Programs ---> Administrative Tools ---> User Manager. If you are 
not already logged into the local domain, select Select Domain from 
the User menu and browse to or type in the local computer name. 

• If Windows 2000 is the operating system on the MediaStor computer, 
open the Windows 2000 User Manager. From the Start menu, select 
Programs ---> Administrative Tools ---> Computer Management.
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The groups for the local domain are listed in the Groups list. The 
MSAdministrators group was automatically added to this list when 
MediaStor was installed. In addition, all members of the local 
Administrators group were added to the MSAdministrators group during 
install. 

2. Double-click the Administrators or MSAdministrators group name (or 
highlight the name in the list and select Properties from the User menu). 
The Local Group Properties dialog box for the group appears. The 
Members list for the group lists all of the users and groups that are 
members of the selected group. 

For the MSAdministrators group, users must be listed here, or they must 
be members of a group listed here, to perform functions in MediaStor. 
Users who should have rights to manage the MediaStor service must be 
listed (or be members of groups that are listed) in both the 
MSAdministrators group and the Administrators group.

Adding Users to Administration Groups
Only local Administrators have the necessary rights to change the 
membership of user groups. Before attempting the procedures below, be sure 
you are logged into the MediaStor computer as a local domain Administrator. 

To add a user to the Administrators or MSAdministrators group:

1. You have the following choices:

• If Windows NT is the operating system on the MediaStor computer, 
open the Windows NT Computer Manager. From the Start menu, 
select Programs ---> Administrative Tools ---> User Manager. If you are 
not already logged into the local domain, select Select Domain from 
the User menu and browse to or type in the local computer name. 

• If Windows 2000 is the operating system on the MediaStor computer, 
open the Windows 2000 User Manager. From the Start menu, select 
Programs ---> Administrative Tools ---> Computer Management.

The groups for the local domain are listed in the Groups list. 

2. Double-click the Administrators or MSAdministrators group name (or 
highlight the name in the list and select Properties from the User menu). 
The Local Group Properties dialog box for the group appears. 

3. In the Local Group Properties dialog box for the group, click Add. The Add 
Users and Groups dialog box appears. 

4. Select the appropriate domain from the drop-down list of domains.

5. From the Names list, select the user name. 

6. Click Add. The user is added to the list at the bottom of the window. 
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7. When all users you want to add to the group are listed, click OK. The users 
are added to the Members list for the selected group.

Removing Users from Administration Groups
Only local Administrators have the necessary rights to change the 
membership of user groups. Before attempting the procedures below, be sure 
you are logged into the MediaStor computer as a local domain Administrator. 

To remove a user or group from the Administrators or MSAdministrators 
group:

1. You have the following choices:

• If Windows NT is the operating system on the MediaStor computer, 
open the Windows NT Computer Manager. From the Start menu, 
select Programs ---> Administrative Tools ---> User Manager. If you are 
not already logged into the local domain, select Select Domain from 
the User menu and browse to or type in the local computer name. 

• If Windows 2000 is the operating system on the MediaStor computer, 
open the Windows 2000 User Manager. From the Start menu, select 
Programs ---> Administrative Tools ---> Computer Management.

The groups for the local domain are listed in the Groups list. 

2. Double-click the Administrators or MSAdministrators group name (or 
highlight the name in the list and select Properties from the User menu). 
The Local Group Properties dialog box for the group appears. 

In the Local Group Properties dialog box for the group, highlight the user 
or group you want to remove and click Remove. The user or group is 
removed from the Members list for the selected group.

■ Maximizing MediaStor Performance
There are several ways to configure your MediaStor system to maximize 
performance and ensure data security. For more information, see the following 
sections:

• "Recommended Upgrades for Optimization, " which follows

• “Minimizing System Vulnerability” on page 28

Recommended Upgrades for Optimization
The system resources on the MediaStor computer should be taken into 
consideration when planning a MediaStor system. The size and number of 
hard drives, amount of available RAM, processing power, and network cabling 
and configuration can all affect the performance of the MediaStor system. 
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Although not required, implementation of the following methods will help you 
achieve greater system efficiency:

• "Appropriate Hardware for Desired Performance and Function, " which 
follows

• “Dedicated Host Adapter for Each SCSI Device” on page 27

• “Dedicated MediaStor Computers” on page 27

• “Two Hard Drives on the MediaStor Computer” on page 27

• “Faster Than Minimum CPU” on page 27

• “As Much RAM as Possible” on page 27

• “Multiple-processor Machines” on page 28

• “Fast Network Topology” on page 28

Appropriate Hardware for Desired Performance and Function
Hardware requirements vary depending upon an organization’s needs. A 
careful assessment of these needs should be performed to determine what 
combination of storage devices (drives and libraries) would provide the 
greatest efficiency. For example, an organization that requires many users to 
access a large amount of information at once would benefit the most from a 
library with many drives, whereas one that requires only a small amount of 
information to be accessed may only need a library with one or two drives. 

In addition to performance, you also need to make sure you have purchased 
and configured the appropriate hardware for your functional needs. In 
particular, this pertains to a system that uses DVD media. Because different 
types of DVD media can be read and written in different types of DVD drives, 
you need to be sure your hardware is configured so that the appropriate drives 
can perform the appropriate function(s). There are two particular items you 
may want to note:

• If you will be using DVD-R media and you will be keeping copies of that 
media, be advised that unfinalized DVD-R media cannot be mounted in a 
read-only drive (a drive not configured to write to DVD-R media). This 
means that if you intend to update copies of DVD-R media before the 
originals are finalized, you must have at least two DVD-R “write” drives in 
your system (one for the copy and one for the unfinalized original). This is 
not an issue if you plan to only update the copy after the original is 
finalized.

• If you will be using a library that contains both a read drive and a write 
drive, you must be sure that the drives are on separate buses (as per 
typical manufacturer instructions). As always, be sure to follow all 
manufacturer recommendations for hardware configuration before setting 
up hardware in your ASM system.
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A complete listing of MediaStor supported drives and libraries can be found in 
the Supported Device List available on the StorageTek website at: http://
www.support.storagetek.com. The Supported Device List can also be found 
on the install CD. Known hardware issues and recommendations can be 
found in the ASM Knowledgebase as well as on the StorageTek website. 

Dedicated Host Adapter for Each SCSI Device
A separate host adapter for each SCSI drive or library device will improve 
MediaStor performance. If, for example, there are three drives or libraries on 
one host adapter, then the three devices are sharing the adapter resources. If 
there is a 1:1 ratio, then all devices have optimal throughput.

Dedicated MediaStor Computers
If many other processes are running on the same machine as MediaStor, 
performance may decrease. System resources may become overloaded if 
other programs are running on the same computer, particularly if the 
MediaStor computer is running Data Manager as well. Therefore, you may 
want to consider installing MediaStor on a machine dedicated only to 
MediaStor.

We recommend that the MediaStor computer not be a Primary Domain 
Controller (PDC) or a Backup Domain Controller (BDC) for your network. 
While MediaStor can run on a PDC or BDC, for performance reasons it is not 
recommended.

Two Hard Drives on the MediaStor Computer
If you do decide to install Data Manager on the same computer where you 
install MediaStor, two hard drives – one containing Windows NT/2000 program 
files and MediaStor and one for use as an extended drive by Data Manager – 
will maximize performance. Data can be written to one drive, while system 
processes use the other drive. Dedicating one drive for data storage provides 
better read/write performance, especially in a system where large amounts of 
data is being migrated through MediaStor (for example, in a heavy scanning 
environment). If possible, avoid extending a system drive.

Faster Than Minimum CPU
In order to optimize the performance of MediaStor, we recommend that the 
MediaStor computer have a faster than minimum CPU to improve processing 
speed.

As Much RAM as Possible
The more memory on the MediaStor computer, the faster Windows NT/2000 
and MediaStor will perform and the faster data access will be. 

http://www.legato.com/resources/compatibility
http://www.legato.com/support/knowledgebase
http://www.legato.com/support/knowledgebase
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Multiple-processor Machines
MediaStor fully supports the use of multiple-processor machines. Using a 
multiple-processor machine for the MediaStor computer improves 
performance, because multiple tasks can be performed at the same time with 
each processor carrying out a separate task concurrently.

Fast Network Topology
MediaStor uses a dedicated RPC connection for communication between the 
MediaStor service and the Data Manager service. MediaStor detects and 
enables RPC settings during installation. Because MediaStor handles the 
RPC connection, no optimization of the MediaStor service/Data Manager 
connection is necessary. However, network topology and Windows NT/2000 
configuration can affect throughput between networked MediaStor service 
machines and Data Manager machines.

In cases where network MediaStor computers are installed, network cabling 
designed for high volume throughput, such as Fast Ethernet or fiber optic, can 
improve file transfer speeds between the MediaStor machines and the Data 
Manager computers using the MediaStor media service. 

Minimizing System Vulnerability
To ensure that all data in the system is safeguarded against system failure 
(including Windows NT/2000 failure), certain security measures are 
recommended. Some of these recommendations are discussed briefly in the 
following sections:

• "Using Repair Disk to Back up the MediaStor Registry, " which follows

• “Installing MediaStor in a Clustered Environment” on page 28

Using Repair Disk to Back up the MediaStor Registry
The Repair Disk feature backs up the MediaStor registry settings for the 
MediaStor computer. This provides a way to recover MediaStor settings 
without reconfiguring them in the event of a system failure on the MediaStor 
computer. As with any repair disk backup, you should save the backup of the 
MediaStor repair disk on a separate volume from the system files, and ideally 
on a separate computer. For more information on using the Repair Disk 
function to back up the MediaStor registry settings, see “Backing Up Your 
MediaStor System” on page 149. 

Installing MediaStor in a Clustered Environment
Clustering is the process of connecting two or more computers together in 
such a way that they behave like a single computer, and so that they share a 
single storage device. 
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In a cluster configuration, each computer automatically updates the other 
computer with registry information so it can intervene when needed. If one of 
the servers stops functioning, the other server assumes the workload of the 
failed server. The act of transferring functions to another server in the cluster 
is called fail-over. Fail-over ensures continuous availability of critical 
applications and data located on the cluster. 

The server computers that are part of the cluster are called nodes or systems, 
and can be either active or passive. An active node is always running and 
processing user requests. A passive node, however, is idle and does not 
process user requests until an active node fails. 

Cluster configurations can be either active/active or active/passive. 

• In an active/passive configuration, applications and services running on 
the active node transfer over to the passive node when the active node 
fails. The active node is also called the primary node, while the passive 
node is called the secondary node.

• In an active/active configuration, applications and services can be running 
on both of the active nodes and transfer over to one node if the other fails. 
The applications and services that were originally running on the failed 
node are then restored to the node when it comes back online.

MediaStor 5.2 or higher can run on an active/passive cluster environment 
where Microsoft’s Cluster Administrator is installed. In an active/passive 
cluster, MediaStor runs as a single service on the active, or primary, node. 
When the primary node fails, the service is transferred to the secondary node, 
which is then considered the primary node because it becomes active. All 
MediaStor functionality is available on the primary node and completely 
transfers in the case of a fail-over.

ASM Data Manager 5.3 or higher using MediaStor as a media service can run 
on an active/active cluster environment where Microsoft’s Cluster 
Administrator is installed; however, MediaStor itself can run only in an active/
passive cluster mode.

For detailed information on installing and configuring MediaStor in a clustered 
environment, refer to Appendix A: Clustering of the ASM Data Manager 
Getting Started Guide.
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3Installing MediaStor

Installing ASM MediaStor is an easy process, with system prompts that guide 
you through every step of the installation process. After MediaStor is installed, 
and you open the Administrator for the first time, you will be able add the basic 
components necessary to get your MediaStor system up and running. You 
may create them at this time or choose to do it later.

For more information, see the following sections:

• "Before Running the Setup Wizard, " which follows

• “Running the Setup Wizard” on page 33

• “Configuring MediaStor” on page 39

• “Licensing MediaStor” on page 39

■ Before Running the Setup Wizard
Before you run the setup wizard to install MediaStor, there are several issues 
you may need to consider, depending on your specific configuration. For more 
information, see the following sections:

• "Licensing, " which follows

• “Creating a Service Account” on page 32

• “Verifying Hardware Connections” on page 32

• “Clustering” on page 32

• “Upgrading from Previous Versions of ASM or MediaStor” on page 33

Licensing
During the installation of MediaStor, you will be prompted to select whether 
you are installing a licensed version of MediaStor or a 30-day evaluation 
version. ASM Software product licenses are managed through the ASM 
License Server, which is a separate product and installed separately from 
ASM, although the License Server software is included on the ASM CD. For 
information on installing and configuring your license server, refer to the 
License Server System Guide.



Installing MediaStor

32 Second Edition
StorageTek Proprietary

Creating a Service Account
If you do not already have a service account that you would like MediaStor to 
use to log on as a service, you should create the service account before 
installing MediaStor. The account should be an administrator on the machine 
on which you are installing MediaStor. For more information, see “Windows 
NT/2000 Security” on page 22.

Before running the installation, you should log on to the computer using this 
service account, so that you can specify the account during setup as required. 
Because the service account that MediaStor uses to log on the service 
requires the Log on as a service privilege, this privilege is automatically added 
to the account specified during setup. Creating the service account ahead of 
time, and entering that account during setup eliminates the need to add that 
privilege separately. 

Note: If you are installing MediaStor on Windows 2000 Server in an Active 
Directory service environment, the ASM service accounts require 
additional configuration to ensure that they have the security privileges 
necessary to move, store, and retrieve files over the network. For more 
information, refer to the ASM Knowledge Base. 

Verifying Hardware Connections
Before installing MediaStor, you should confirm that the hardware is properly 
configured, specifically SCSI devices. For any SCSI device to work correctly 
(regardless of its use with MediaStor), all devices and the SCSI adapter must 
be properly terminated.

Additionally, all SCSI devices should be powered on before starting Windows 
NT/2000. If the devices you are using require that specific drivers be installed, 
those drivers should be installed and access to the devices should be tested, if 
possible through Windows NT/2000 prior to adding the devices to MediaStor. 

Note: Keep in mind that SCSI cable length includes not only the external 
cable, but the internal cabling as well. For each drive, one foot of cable 
should be added to the total cable length. 

Note: For more information on SCSI and library devices, see “Appendix A: 
Using SCSI Manager” on page 137 and “Using Jukebox Manager” on 
page 205. These utilities aid in verifying hardware connections and 
troubleshooting hardware problems.

Clustering
If you are planning to run MediaStor in a clustered environment, you must 
obtain a cluster-enabled license and follow the instructions in Appendix A: 
Clustering of the ASM Data Manager Getting Started Guide to set up Microsoft 
Cluster Administrator and install MediaStor. 
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Upgrading from Previous Versions of ASM or MediaStor
If you are converting your system from a different or previous version of 
MediaStor, or if you are converting your ASM system from 3.2 or 4.2 to ASM, 
you must take additional steps to convert your system before installing 
MediaStor. For more information, refer to the ASM Upgrade Guide.

■ Running the Setup Wizard
The MediaStor setup wizard leads you through the steps to install MediaStor.

For your convenience, the setup wizard allows you to install MediaStor on 
multiple computers at once, provided those computers are visible on your 
network and you have Administrator privileges and rights to log onto the 
destination computers as a service. 

To take advantage of this feature, you may want to determine which 
computers are to have MediaStor installed on them (and configure the 
appropriate rights if necessary) before you run the installation wizard, enabling 
you to only run the installation once rather than multiple times. To configure 
the appropriate rights, see “Windows NT/2000 Security” on page 22. 

Note: If you are converting your system from a different or previous version 
of MediaStor, refer to the ASM Upgrade Guide to follow the correct 
steps to convert your system before installing MediaStor.

To run the MediaStor setup wizard:

1. Exit all applications on the computer(s) on which you want to install 
MediaStor. If other software is running, the setup wizard may not be able 
to write to all necessary files.

2. Insert the ASM setup CD-ROM into the drive. From the Windows Start 
menu, select Run. The Run dialog box appears.

3. You can either browse to the file or type the path in the Open text box:

D:\DX2000.XXX\MEDIASTOR\SETUP.EXE

(In this path, D represents the drive holding the setup CD-ROM and XXX 
represents the ASM version number.) 

4. Once the file/path appears in the Open text box, click OK. MediaStor setup 
is initiated, and then the setup wizard appears, starting with the MediaStor 
Installation page. The MediaStor Installation page briefly describes the 
installation process. 

5. Click Next. The Installation Options page appears.
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Figure 2.  MediaStor Setup -- Installation Options Page 

6. Select Install new product and then click Next. The License Agreement 
page appears.

Figure 3.  MediaStor Setup -- License Agreement Page 

7. You must accept the terms of the license agreement before you can 
proceed with the installation. Scroll to the bottom of the agreement to 
enable the Accept terms of agreement check box. Check the box, and 
then click Next. The Registration page appears. 
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Figure 4.  MediaStor Setup -- Registration Page 

8. Enter the customer name and organization name and then click Next. The 
Service Account page appears.

Figure 5.  MediaStor Setup -- Service Account Page 

9. Enter and confirm the password for the account that you want to use as 
the MediaStor service account. For more information on the MediaStor 
service account, see “Creating a Service Account” on page 32.

10. Click Next. The Product License page appears.
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Figure 6.  MediaStor Setup -- Product License Page 

11. You have two choices:

• Select the Install a 30-day evaluation license option to install 
MediaStor without using License Server. This allows you to use 
MediaStor for 30 days. After the 30-day evaluation period, you can use 
the Setup option in the StorageTek MediaStor program group to update 
your license. For more information, see “Licensing MediaStor” on 
page 39.

• Select the Install a licensed copy of the software option if you have 
installed and configured the License Server already. Type in the name 
of the computer where License Server is installed, or use the Browse 
button to find the License Server computer on the network. 

If you click Browse, the Available License Servers dialog box appears.

Figure 7.  Available License Servers Dialog Box 

The Available License Servers dialog box lists all network computers 
where License Server is installed and running, and indicates whether a 
MediaStor license is configured on that License Server. Highlight the 
License Server computer to be used to license this installation of 
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MediaStor and click OK. The Product License page returns, displaying the 
selected License Server computer in the License Server Computer Name 
text box.

12. When you finish selecting a licensing option, click Next. The Target 
Computers page appears.

Figure 8.  MediaStor Setup -- Target Computers Page 

13. You have the following choices:

• To install MediaStor only on the computer listed in the Target 
Computers list, click Next. The Summary page appears.

• To install MediaStor on other computers in addition to the one listed in 
the Target Computers list, click Add. The Browse Computers dialog 
box appears.

Figure 9.  Browse Computers Dialog Box 

14. In the Browse Computers dialog box you have two choices:
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• Under Available Computers, navigate to and select the computer on 
which you want to install MediaStor and then click Add to add the 
computer to the Selected Computers list. 

• In the Computer Name text box, type in the name or the IP address of 
the computer on which you want to install MediaStor and then click 
Add to add the computer to the Selected Computers list.

Repeat this step for each additional computer on which you want to install 
MediaStor. When you finish selecting target computers, click OK. You are 
returned to the Target Computers page. 

15. When the Target Computers list is complete, click Next. The Summary 
page appears.

16. Verify the accuracy of the information in the summary. 

17. If all information is correct, click Finish. The setup wizard copies all 
program files into the Program Files\StorageTek directory on the system 
drive, and adds MediaStor configuration entries and the program group to 
the system configuration of every target computer selected. A dialog box 
displays the status of the operation. 

18. You have the following choices:

• If you installed the program on one or more remote computers (in 
addition to or instead of the local computer), the MediaStor Setup 
Result dialog box appears, listing the installation results for each 
computer you specified. 

Figure 10.  MediaStor Setup Result Dialog Box 

Take note of any computers where a Reboot is required (or computers on 
which the installation failed) and then click OK. 

• If you installed MediaStor on the local computer, a dialog box appears, 
indicating that the MediaStor installation has been successfully 
completed. Click Start to close the setup wizard and start MediaStor, or 
click Exit to close the setup wizard without starting MediaStor.
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■ Configuring MediaStor
The following is a condensed list of the steps necessary to start using 
MediaStor to manage your library, tower, or standalone media.

To install and configure MediaStor:

1. Add and configure hardware devices. For instructions, see “Managing 
Hardware” on page 55.

2. If not already present, add media to hardware devices. For instructions, 
“Managing Hardware” on page 55.

3. In ASM Data Manager, add the MediaStor media service. This creates 
application pools in MediaStor. For instructions, refer to the Setting up 
Media Services chapter of the ASM Data Manager Getting Started Guide.

4. Allocate media to the application pools so that the media is available to 
begin migrating files to it. You can allocate media either through MediaStor 
or through Data Manager. To allocate media through MediaStor, see 
“Allocating Media to Application Pools” on page 99. To allocate media 
through Data Manager, refer to the Setting Up Media Services chapter of 
the ASM Data Manager Getting Started Guide.

■ Licensing MediaStor
If you installed an evaluation copy of MediaStor and you are ready to upgrade 
to a fully licensed copy, or if you need to change your license (for example, to 
add hardware to your system), you can update your license information 
through the MediaStor setup wizard.

Before you update the license information, be sure that you have installed and 
configured the ASM License Server, including adding the new license to 
License Server. For instructions, refer to the License Server System Guide. 

To update the MediaStor license:

1. From the Windows Start menu, select Programs, StorageTek MediaStor, 
and then Setup. The setup wizard appears, starting with the Welcome 
page.

2. Click Next. The Installation Options page appears.
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Figure 11.  MediaStor License Update -- Installation Options Page 

3. Select Edit product license information and then click Next. The Product 
License page appears.

Figure 12.  MediaStor License Update -- Product License Page 

4. Select the Install a licensed copy of the software option. Type in the name 
of the computer where License Server is installed, or use the Browse 
button to find the License Server computer on the network. If you click 
Browse, the Available License Servers dialog box appears.
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Figure 13.  Available License Servers Dialog Box 

The Available License Servers dialog box lists all network computers 
where License Server is installed and running, and indicates whether a 
MediaStor license is configured on that License Server. Highlight the 
License Server computer to be used to license this installation of 
MediaStor and click OK. The Product License page returns, displaying the 
selected License Server computer in the License Server Computer Name 
text box.

5. When you finish selecting a licensing option, click Next. The Target 
Computers page appears.

Figure 14.  MediaStor License Update -- Target Computers Page 

6. You have the following choices:

• To upgrade the MediaStor license for only the computer listed in the 
Target Computers list, click Next. The Summary page appears.

• To upgrade the MediaStor license for other computers in addition to the 
one listed in the Target Computers list, click Add. The Browse 
Computers dialog box appears.
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Figure 15.  Browse Computers Dialog Box 

7. In the Browse Computers dialog box you have two choices:

• Under Available Computers, navigate to and select the computer on 
for which you want to upgrade the MediaStor license and then click 
Add to add the computer to the Selected Computers list. 

• In the Computer Name text box, type in the name or the IP address of 
the computer for which you want to upgrade the MediaStor license and 
then click Add to add the computer to the Selected Computers list.

Repeat this step for each additional computer for which you want to 
upgrade the MediaStor license. When you finish selecting target 
computers, click OK. You are returned to the Target Computers page. 

8. When the Target Computers list is complete, click Next. The Summary 
page appears.

9. Verify the accuracy of the information in the summary. 

10. If all information is correct, click Finish. The MediaStor license is updated 
on the selected computer(s), and a message appears, indicating that the 
wizard has been successfully completed. Click Start to close the setup 
wizard and start MediaStor, or click Exit to close the setup wizard without 
starting MediaStor.
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4Working in the Administrator

Because ASM MediaStor is a Windows-based package, the same 
navigational standards apply to all of its components. The Administrator 
provides a user-friendly interface that allows you to easily create and 
configure MediaStor components as well as manage MediaStor computer 
properties and hardware on one or more MediaStor machines.

The Administrator has an intuitive “tree” view that displays the underlying 
structure of the MediaStor system. Each MediaStor computer appears as a 
primary tree node, and the configured hardware and media are grouped as 
sub-trees for ease of use. In addition, the media in the Scratch Pool and 
Application Pool(s) are grouped by media classification. You can search for 
text in the tree, as well as refresh the contents of the tree.

The Administrator can be run on the same computer where MediaStor is 
installed or from a remote workstation using the Remote Administrator. For 
more information on remote administration, see “Remotely Administering 
MediaStor” on page 157.

This chapter explains the basic layout of the Administrator, as well as its 
general functionality. Included are explanations of window features and 
methods for carrying out system operations. For more information, see the 
following sections:

• "Starting the Administrator, " which follows

• “The Administrator Window” on page 44

• “Refreshing the Administrator Window” on page 52

• “Searching in the Administrator” on page 53

■ Starting the Administrator
Starting the Administrator allows you access to media and hardware 
information. You can connect to local or remote MediaStor computers through 
the Administrator. Using the Administrator, you can add and remove hardware 
devices, set drive properties, and make media available to Data Manager by 
adding media to the Application Pools.

Upon successful connection to one or more MediaStor computer(s), the 
Administrator displays all configured MediaStor components in a tree-like 
structure.
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To open the Administrator:

• From the Windows Start menu, select Programs, StorageTek MediaStor, 
and then Administrator. The Administrator window appears. 

Figure 16.  MediaStor Administrator Window 

When the Administrator opens, it automatically connects to all registered 
MediaStor computers. If this is a full installation of MediaStor (as opposed to a 
Remote Administrator installation) the local computer is automatically 
registered, and therefore automatically appears in the Administrator. In 
addition, if you installed MediaStor on multiple target computers, MediaStor 
automatically registers and attempts to connect to all target computers 
identified during MediaStor install. Once these connections have been made, 
the Administrator displays information relevant to each connected MediaStor 
service. 

If you want to administer the MediaStor service on computer(s) other than 
those currently connected, you must register the MediaStor computers 
through the Administrator. For more information on registering MediaStor 
computers, see “Registering a Computer for Remote Administration” on 
page 163.

■ The Administrator Window
The main portion of the Administrator window is for navigation and information 
display, and is split into three panes:
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• The left pane of the window, or the tree view, contains the tree-like 
structure from which most commands are performed. For more 
information, see "The Tree View: Exploring MediaStor, " which follows. 

• The top right pane, or the contents view, displays the contents of the item 
currently selected in the tree. For more information, see “The Contents 
View: Node Details” on page 49.

• The bottom right pane, or the description view, displays a description or 
detailed properties of the item selected. For more information, see “The 
Description View: Item Details” on page 50.

Split bars separate the panes of the Administrator window. These split bars 
can be moved to change the size of each pane.

To move the split bar:

• Drag the bar to its new location.

The Administrator window also contains several additional components that 
allow you to navigate through and configure MediaStor:

• The menu bar contains the menu commands and can be found at the top 
of the window. For more information, see “Menu Bar” on page 50. 

• The Computer drop-down list, which allows you to switch between 
registered MediaStor computers, can be found just below the menu bar on 
the left. For more information, see “Computer Drop-Down List” on page 50.

• The toolbar, containing toolbar buttons that allow you to perform frequently 
used functions, can be found just below the menu bar to the right of the 
Computer drop-down list. For more information, see “Toolbar” on page 50.

• The status bar, which displays information about the selected command or 
toolbar button, can be found at the bottom of the window. For more 
information, see “Status Bar” on page 52.

The Tree View: Exploring MediaStor
The left pane of the Administrator window contains a tree showing all 
hardware configured for registered MediaStor computers.

Commands for managing MediaStor functionality can be accessed from the 
tree. When you right-click on a tree node, a shortcut menu containing 
commands for performing MediaStor functions appears. The shortcut menu 
items vary depending on what item you select in the tree view.

Each node in the tree indicates whether it is expandable; that is, whether it 
contains items beneath it. A plus sign (+) marks a node that is expandable. 
Once a node has been expanded, the plus sign changes to a minus sign (-), 
indicating that it has been expanded and can now be collapsed. 
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To expand a node:

• You have the following choices:

• Click the plus sign to the left of the node.

• Double-click the item.

• Select the item, and then choose Expand from the Tree menu.

To collapse a node:

• You have the following choices:

• Click the minus sign to the left of the node.

• Double-click the item.

• Select the item, and then choose Collapse from the Tree menu.

If a node appears with neither sign, that means it currently contains no items 
within it. For example, if the Blank node of the media tree does not have a plus 
(+) or minus (-) sign in front of it, there are no Blank media in that pool.

A Hardware node, Scratch Pool node, and Application Pools node appear 
underneath each root node for a MediaStor computer. For more information, 
see the following sections:

• "Hardware, " which follows

• “Media Pools” on page 47

You can also configure the Administrator to display the status of items in the 
tree view by color. For more information, see “Configuring Status Display” on 
page 49.

Hardware
The Hardware tree in the tree view contains all hardware devices currently 
managed by MediaStor. You can add, modify, and delete hardware devices 
managed by MediaStor from the Hardware tree. In addition, you can set 
devices online or offline and manage the insertion, movement, and ejection of 
media in the device. 

Three types of devices can be added to MediaStor: libraries, towers, and 
standalone drives.

When a hardware device is added to the MediaStor system, the media in the 
system is automatically added to the appropriate node of the Scratch Pool.

Note: While MediaStor is running and SCSI devices are in use or being 
configured, do not run any other applications that access the devices. 
Two different applications sending SCSI commands to the same 
device may cause commands to fail and may cause damage to the 
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hardware. For example, do not run SCSI Manager while configuring 
hardware. 

Media Pools
The MediaStor Administrator lists two media pool trees in the tree view: 
Scratch Pool and Application Pools. The Scratch Pool tree contains all media 
in the MediaStor system that is not currently assigned to an application. The 
Application Pools tree displays all extended drives configured for each Data 
Manager computer currently using MediaStor as a media service. 

Each application media pool is identified by three characteristics: the 
application using MediaStor as a media service, the name of the computer 
where the application is installed, and the extended drive letter. 

For example, the name of an application media pool, as it appears in the 
Application Pools tree might be: DX_WSTVERNON1_D. In this example, the 
Data Manager computer using MediaStor is identified as “DX”, the name of the 
computer running Data Manager is “WSTVERNON1”, and the “D” drive has 
been configured as a Data Manager extended drive. This naming convention 
allows you to quickly identify where you should assign the media from the 
Scratch Pool, if you choose to allocate the media through MediaStor. Media 
can also be allocated through Data Manager. 

The media in both the Scratch Pool and the Application Pools are grouped by 
class. Explanations of the classifications for media can be found in the 
following sections:

• "Original Media, " which follows

• “Copy Media” on page 48

• “Duplicate Media” on page 48

• “Blank Media” on page 48

• “Foreign Media” on page 48

• “Unknown Media” on page 48

• “Unformatted Media” on page 48

• “Corrupt Media” on page 49

Original Media
All media that have been prepared and ready for use are listed under the 
Original Media node. For a piece of media to appear in this list, the media 
must be formatted for the file system for which the hardware device is 
configured. It must also be labeled.



Working in the Administrator

48 Second Edition
StorageTek Proprietary

Copy Media
Copy media are media that are identical copies of other media in the ASM 
system. The only difference between an original piece of media and its copy is 
the serial number for each piece of media. 

Duplicate Media
Duplicate media is any media with the same serial number as another piece of 
media in the ASM system. Duplicate media is unusable with ASM and must be 
reformatted before it can be used. Reformatting assigns a different serial 
number to the media. 

Blank Media 
Blank media are media that have been formatted for use, but are not yet 
labeled. Through Data Manager, blank media can be labeled, reformatted, or 
labeled for use as a copy (if the media allows it).

Foreign Media 
Foreign media is a piece of media where the media type is recognized, but the 
media has been formatted with a file system that does not correspond to the 
file system configured for the device in which it resides. If possible, this media 
must be reformatted using the appropriate file system in order to be used.

Note: Unformatted DVD media may appear as Foreign rather than 
Unformatted if the device in which it resides is configured to use the 
UDF file system. 

Unknown Media 
Unknown media encompasses any media in the hardware device that 
MediaStor does not recognize. The problem most likely is that the media is of 
an unsupported type, though the media may not be recognized because it 
contains an unsupported file system. For more information, see “Foreign 
Media” on page 48. 

Unformatted Media 
Unformatted media usually encompasses media that was unpackaged and 
placed in the device and has not yet been formatted for the first time. This 
media will have to be formatted before it can be used.

Note: Unformatted DVD media may appear as Foreign rather than 
Unformatted if the device in which it resides is configured to use the 
UDF file system. 



The Administrator Window

ASM MediaStor System Guide 49
StorageTek Proprietary

Corrupt Media
The Corrupt Media classification identifies specifically corrupted DVD media 
using the UDF file system. Corrupt media is media that the system recognizes 
but cannot use due to problems with the media itself. Media corruption most 
often occurs as a result of a power failure while the media was being written 
to. Performing a check disk media task on the media may allow you to find and 
repair the media errors. For more information on performing a check disk 
media task, refer to the Managing Storage Media chapter of the ASM Data 
Manager System Guide. 

Configuring Status Display
You can configure the items in the tree view of the MediaStor Administrator to 
change color depending on their status. The following table lists each color 
and describes the status indicated by each color:

To configure the tree view to indicate status by color:

• From the View menu, select Enable Color. A check mark next to the 
Enable Color option signifies that the option has been enabled. If this 
option is disabled, all items in the tree view appear black, regardless of 
status.

The Contents View: Node Details
The top right pane of the Administrator window contains the contents of the 
node currently selected in the tree on the left. These contents include the 
same information displayed underneath the node in the tree when the node is 
expanded. For example, selecting the Original node of the Scratch Pool tree 
lists all available formatted and labeled media in the contents view. The same 
information is listed underneath the Original node when that node is 
expanded. You can select an item either in the tree view or in this contents 
view to make the appropriate commands available. 

Table 5.  Status Indicated by Color

Color Status
Black Online but not running a task

Green Online but with a task either pending, in progress, or 
suspended 

Red Error

Yellow Offline



Working in the Administrator

50 Second Edition
StorageTek Proprietary

The Description View: Item Details
The bottom right pane of the Administrator window contains details about the 
item currently selected in the tree on the left. This section provides helpful 
information about the current configuration and settings. For example, if a 
piece of media is selected, the description view displays information about that 
piece of media including the name, file system, serial number, total number of 
bytes, and the device in which that media is located. 

Menu Bar
The menu bar contains a list of options with commands for carrying out 
functions in the Administrator. Although functions are easily performed using 
shortcut mouse clicks, all functions can be performed through the menu 
commands as well. When you select a node in the tree view, the Edit menu 
changes to contain the same commands available on the shortcut menu for 
that node. 

Computer Drop-Down List
The Computer drop-down list displays the name of the currently active 
computer. You can activate a different MediaStor computer in the 
Administrator by either selecting the computer from the Computer drop-down 
list or highlighting the computer in the tree view of the Administrator. 

In order for a computer to appear in the Computer drop-down list, the 
computer must be registered through the Administrator. For additional 
information on registering MediaStor computers to add them to this list box, 
see “Registering a Computer for Remote Administration” on page 163.

Toolbar
The MediaStor toolbar is located directly beneath the menu bar, to the right of 
the Computer drop-down list. The toolbar contains buttons that provide quick 
access to many of the Administrator commands and features. 

To identify the function of a button, point to the button with the mouse. The 
button’s function appears in the status bar at the bottom of the window, and as 
a pop-up tool tip when the mouse is held over the button. 

The toolbar button is grayed out if it is not available for the item you have 
selected in the Administrator.

To show or hide the toolbar:

• From the View menu, select Toolbar. A check mark beside the command 
indicates that the toolbar is displayed.
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Figure 17.  Administrator Toolbar 

Table 6.  Administrator Toolbar Buttons

Button Name Menu Option Function
Connect to 
Service

From the Service 
menu, select 
Connect.

Connects to the selected 
MediaStor computer. For 
more information, see 
“Connecting to MediaStor 
Computers” on page 169.

Disconnect 
from Service

From the Service 
menu, select 
Disconnect.

Disconnects from the 
currently active MediaStor 
computer. For more 
information, see 
“Disconnecting from a 
MediaStor Computer” on 
page 169.

Service 
Manager

From the Tools 
menu, select 
Service Manager.

Opens the Service Manager 
so that you can manage the 
MediaStor service. For more 
information, see “Managing 
the Service Using the 
Administrator” on page 112.

Register 
Computer 

From the Service 
menu, select 
Register.

Displays the Register 
Computers dialog box, 
which allows you to register 
MediaStor computers for 
remote administration. For 
more information, see 

“Registering a Computer for 
Remote Administration” on 
page 163.

New From the Edit 
menu, select 
New.

Displays a dialog box that 
allows you to create a new 
object. The dialog box that 
appears is determined by 
the current selection.
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Status Bar
The status bar is located at the bottom of the Administrator window and 
displays information about the selected command or toolbar button. 
Translations of certain commands or important messages to the user appear 
on the status bar.

To show or hide the status bar:

• From the View menu, select Status Bar. A check mark beside the 
command indicates that the status bar is displayed.

■ Refreshing the Administrator Window
Refreshing updates the contents of the Administrator window and repaints 
everything in the window. The Administrator window is refreshed when each of 
the following occurs: 

• A command is performed. 

• A node in the tree is expanded or collapsed. 

• You press <F5> or select Refresh from the Tree menu. (This is considered 
a forced refresh.)

• The time specified for automatic refresh frequency has expired. For more 
information, see "Configuring Auto Refresh Frequency, " which follows.

Configuring Auto Refresh Frequency
You can configure the frequency of the automatic refresh of the Administrator 
window. The default refresh rate is 5 seconds. 

To enable or disable auto refresh:

• From the Tree menu, select Auto Refresh. 

Delete From the Edit 
menu, select 
Delete.

Deletes or removes the 
selected object.

Properties From the Edit 
menu, select 
Properties.

Displays the Properties 
dialog box for the selected 
object.

Table 6.  Administrator Toolbar Buttons (Continued)

Button Name Menu Option Function
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To change the auto refresh frequency:

1. From the Tree menu, select Auto Refresh Frequency. The Auto Refresh 
Frequency dialog box appears.

Figure 18.  Auto Refresh Frequency Dialog Box 

2. In the Frequency text box, enter the appropriate number of seconds 
between refreshes and then click OK.

■ Searching in the Administrator 
As multiple hardware devices and pieces of media, as well as multiple 
MediaStor computers (for remote administration), are added to the system, 
the MediaStor tree in the Administrator window may become so large as to 
become difficult to locate a specific node of the tree. The Find command in the 
Tree menu can be used to quickly locate occurrences of text within the 
MediaStor tree. This can be especially useful for finding a specific piece of 
media or a specific hardware device.

The Administrator searches from the currently highlighted position in the tree 
to either the end or to the beginning of the tree, depending on the direction you 
choose. To search the entire tree, select an item either at the top or bottom of 
the tree before beginning the search and select the Up or Down direction as 
appropriate.

To search for specific text in the tree:

1. From the Tree menu, select Find. The Find dialog box appears. 

Figure 19.  Find Dialog Box 

2. In the Find what text box, type the text you want to find. 

3. Select the direction in which you want MediaStor to perform the search. 
You have the following choices:

• Enable the Up option to search up in the tree from the currently 
highlighted position.
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• Enable the Down option to search down in the tree from the currently 
highlighted position. This option is enabled by default.

4. Choose whether you want MediaStor to match the case of the selected 
text. You have the following choices:

• Enable the Match case check box to find only words having a certain 
pattern of uppercase and lowercase letters. For example, select this 
option to find “MEDIA” but not “media.”

• Disable the Match case check box to find all words matching the text in 
the Find what text box, regardless of case. This option is disabled by 
default.

5. Click Find Next. The first occurrence of the text is highlighted in the tree. 

6. If the tree is not visible, move the Find dialog box by dragging its title bar.

7. To find the next occurrence, click Find Next again. 

8. When you find the text you are looking for, click Cancel to close the Find 
dialog box.

Note: After you close the Find dialog box, you can select Find Next from the 
Tree menu (or press F3) to find the next occurrence of the most 
recently specified text.
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5Managing Hardware

Three types of hardware devices can be added, modified, and deleted in 
MediaStor: libraries, towers, and standalone drives. The following sections 
contain information on hardware organization in the MediaStor Administrator, 
as well as information on managing the insertion, movement, and ejection of 
media in the devices:

• "Device Names, " which follows

• “Managing Libraries” on page 56

• “Managing Towers” on page 81

• “Managing Standalone Drives” on page 89

For a complete list of supported hardware devices, refer to the Supported 
Device List available on the StorageTek website at http://
www.support.storagetek.com. The Supported Device List is also available on 
the ASM installation CD. 

■ Device Names
When you add a device to MediaStor, you may need to select it from a list of 
available devices. MediaStor uses standardized naming conventions for 
hardware devices. Understanding the format for a device name simplifies 
identification of the device in MediaStor.

MediaStor supports standalone drives, towers, and SCSI and serial libraries. 
When SCSI devices are added and configured in MediaStor, the supported 
devices listed in the Windows registry are automatically listed for use in 
MediaStor. These devices appear in order according to their model and their 
device address. SCSI and serial addresses are displayed differently and are 
configured using different methods. For more information, see the following 
sections:

• "SCSI Device Names, " which follows

• “Serial Library Device Names” on page 56

SCSI Device Names
The SCSI address is the same as the character string that names this device 
in SCSI Manager. Look at the icon for this device in SCSI Manager; its device 

http://www.legato.com/resources/compatibility/
http://www.legato.com/resources/compatibility/
http://www.legato.com/support/knowledgebase
http://www.legato.com/support/knowledgebase
http://www.legato.com/resources/compatibility/
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name (address) is shown in quotes under the icon. For more information on 
SCSI Manager, see “Appendix A: Using SCSI Manager” on page 137.

The numbers in the device address represent the SCSI port, bus, target ID, 
and logical unit ID, respectively. For example, on a typical system with one 
host adapter, a CD-ROM drive at target ID 2 would be SCSI.0.0.2.0. The first 
zero (0) in the address is the SCSI port, the second zero is the bus, the two (2) 
is the target ID, and the third and final zero is the logical unit ID.

Serial Library Device Names
If a library with serial robotics is used, the serial port designation and the 
robotics controller ID must be provided. For example, the address for a serial 
library with one drive attached could be COM1-0. COM1 designates the 
MediaStor computer’s COM port to which the library is connected; 0 
designates the RS-232 ID for the robotics controller. Up to fifteen devices may 
be daisy-chained on a serial port.

Note: For more information on how to identify the RS-232 for your library, 
refer to the manufacturer’s documentation.

■ Managing Libraries
MediaStor supports a wide variety of libraries. (For a full list of supported 
libraries, refer to the Supported Device List available on the StorageTek 
website: ( http://www.support.storagetek.com). The Supported Device List is 
also available on the ASM installation CD. 

You can add and remove libraries in the MediaStor system. MediaStor also 
provides robotics management for libraries, allowing you to insert, eject, and 
move media within the library. MediaStor internally performs all necessary 
mount and dismount operations for media read/write requests from Data 
Manager. For more information, see the following sections:

• "Adding a Library, " which follows

• “Managing Media in a Library” on page 72

• “Modifying a Library” on page 76

• “Viewing Library Properties” on page 77

• “Setting a Library Offline” on page 79

• “Setting a Library Online” on page 79

• “Deleting a Library” on page 81

http://www.legato.com/support/knowledgebase
http://www.legato.com/resources/compatibility/
http://www.legato.com/resources/compatibility/
http://www.legato.com/resources/compatibility
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Adding a Library
MediaStor treats libraries as single storage devices. A SCSI address exists for 
the library, and one for each drive in the library. Any supported library currently 
listed in the Windows registry, as well as any supported serial library, can be 
added to MediaStor. 

The Hardware Wizard leads you step-by-step through the process of adding a 
library to MediaStor. You can configure the library at the time you create it, or 
you can access and change these configurations later through the Hardware 
Wizard and, in some cases, through the Properties dialog box for the library. 
The tabs of the Library Properties dialog box are identical to the corresponding 
pages of the Hardware Wizard.

For instructions on running the Hardware Wizard to add a library to MediaStor, 
see the following sections:

• "Starting the Hardware Wizard, " which follows

• “Configuring the Library Configuration Page” on page 59

• “Configuring the Serial Library Information Page” on page 61

• “Configuring the Library Drives Page” on page 61

• “Configuring the Library Auto Clean Page” on page 69

• “Configuring the Library Options Page” on page 70

Starting the Hardware Wizard
This section describes how to start the Hardware Wizard and configure the 
Add New Hardware Device and Select New Library pages.

To add a library: 

1. Right-click on the Hardware node and select New from the shortcut menu 
to start the Hardware Wizard. The Hardware Wizard opens, starting with 
the Add New Hardware Device page.
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Figure 20.  Hardware Wizard -- Add New Hardware Device Page 

2. Select the Library option and click Next. The Select New Library page 
appears.

Figure 21.  Hardware Wizard -- Select New Library Page 

The Select New Library page lists all of the SCSI libraries currently listed in 
the Windows Registry that have not yet been added to the MediaStor 
hardware configuration. 

3. If you are adding a serial library device, enable the Show serial library 
devices check box to show the available serial library devices. Otherwise, 
proceed to the next step.

4. Highlight the library you want to add and click Next. The Library 
Configuration page appears. For detailed information, see "Configuring the 
Library Configuration Page, " which follows.
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Configuring the Library Configuration Page
The Library Configuration page provides information on the device being 
added, and allows you to enter a device name, and select the drive type 
(media type) and default file system for the library. You can also enable or 
disable automatic initialization of the library on MediaStor startup.

When selecting the file system for the library, keep in mind that any media in 
the library to be used by ASM must also be formatted for that file system. Any 
library media formatted for a file system other than the one selected for the 
library is considered Foreign and must be reformatted before ASM can use it. 

When selecting the drive type for the library, be advised that the library type 
controls the functionality of both the drives and the media in the library. This 
pertains specifically to DVD libraries where different types of DVD drives may 
be installed. 

As long as the drives in the library are the same type as the selected drive 
type, they function as read/write drives. If a drive in the library is of a different 
type (though still compatible with the library), the drive functions as a read-only 
drive. If the library contains combo drives, these drives are set to the selected 
drive type selected for the library.

Note: If you are using DVD-R media and plan to have copies of that media in 
your ASM system, keep in mind that unfinalized media cannot be 
mounted in a read-only drive, and therefore if you plan to update 
copies of unfinalized DVD-R media, you need to have at least two 
“write” drives for DVD-R media (one for the unfinalized original and 
one for the copy). 

In addition, media in the library that is not of the same type as the drive type 
selected for the library (as long as it is compatible with the drive) is set to be 
read-only media during library inventory. For example, if you have DVD-RAM 
media in the library, but select DVD-R as the drive type for the library, all DVD-
RAM media is set as read-only media. The same is true for DVD-R media in a 
DVD-RAM drive-type library.

For libraries containing combination drives and/or different drive types, all 
media must be readable in all library drives. For example, if your library 
contains both DVD-R and DVD-ROM drives, you cannot insert DVD-RAM 
media into the library because DVD-RAM media is not readable in DVD-ROM 
drives. In addition, all read/write library media must be both readable and 
writable in all read/write library drives. 

Note: If you are configuring a read-only drive and a write drive in the same 
library, the two drives must be on separate buses. As always, you 
should follow all manufacturers recommendations for setting up 
hardware devices before adding them to your MediaStor system. 
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To configure the Library Configuration page:

1. Enter a name for the library. Library names are used only for user interface 
purposes and can be any alphanumeric string, up to 32 characters.

Figure 22.  Hardware Wizard – Library Configuration Page 

2. From the Drive Type drop-down list, select the type of drive (media) that 
the library contains.

If the library is a DVD library containing different types of DVD drives 
(including combo drives), the drive type selected for the library determines 
how the drives and the media in the library function, and which of the 
drives and media are read/write or read-only.

3. From the File System drop-down list, select the file system to be used for 
the media and drives in the library. All drives within a library must use the 
file system specified. For more information on file systems, see “Types of 
Media File Systems” on page 17.

4. Select whether to set this device online when the MediaStor service starts. 
You have the following choices:

• To set the device online when the MediaStor service starts, leave the 
default setting of enabled for the Set this device online when the 
service starts option. This allows the system to automatically set the 
library online during system startup.

• Disable the Set this device online when the service starts check box to 
prevent the library from being set online when the MediaStor service 
starts. If you disable this option, you need to set the library online 
manually.

5. Click Next. One of the following occurs:
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• If you are configuring a serial library, the Serial Library Information 
page appears. For instructions, see "Configuring the Serial Library 
Information Page, " which follows.

• If you are configuring a SCSI library, the Library Drives page appears. 
For instructions, see “Configuring the Library Drives Page” on page 61.

Configuring the Serial Library Information Page
If you are configuring a serial library, the Serial Library Information page allows 
you to choose a COM port and Device ID (if applicable) for the serial library.

To configure the Serial Library Information page:

1. On the Serial Library Information page, select the appropriate COM port to 
which the serial library will be connected to the MediaStor computer.

Figure 23.  Hardware Wizard – Serial Library Information Page 

2. If applicable, select the device ID assigned for the RS-232 interface with 
the robotics controller. Consult your hardware documentation for more 
information on the device ID (also called the RS-232 ID or the COM ID).

3. Click Next to continue. The Library Drives page appears. For instructions, 
see "Configuring the Library Drives Page, " which follows.

Configuring the Library Drives Page
When the Library Drives page initially appears, no drives are listed, as shown 
in the figure below.
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Figure 24.  Hardware Wizard – Library Drives Page 

Library drives must be added. For SCSI libraries, MediaStor contains an 
automatic configuration feature that allows you to add and configure library 
drives automatically. You can also configure your library drives manually; for 
example, if you are adding a serial library, if automatic configuration fails, or if 
you don’t want to add all of the drives in the library.

The process for adding drives is detailed in the figure below:
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Figure 25.  Adding Library Drives Process 

To configure the Library Drives page:

1.  You have the following choices:

• If you are adding a serial library, click Add. For further instructions, see 
“Manually Configuring Drives” on page 65.

• If you are adding a SCSI library and want to add drives manually, click 
Add. For further instructions, see “Manually Configuring Drives” on 
page 65.

• If you are adding a SCSI library and want to add and configure drives 
automatically, click Auto Config. For further instructions, see 
“Automatically Configuring Drives” on page 65.
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2. If you choose to add only some of the drives in a library, you must add 
reserved drives as placeholders for the drives that are not added. For 
more information, see “Adding Reserved Drives” on page 66.

Note: Some libraries are configured in a way that there are physically two 
drives, but the library firmware expects four drives. When 
automatic configuration is run, reserved drives are added for those 
bays in the library where the drive is missing.

3. If you added drives manually, be sure that the library’s drives, including 
reserved drives, are defined in the order that the vendor numbers its drive 
elements. If they are not listed in order, see “Setting Drive Order” on 
page 67 to change drive order. 

Note: If you are adding a SCSI library, you can perform a configuration 
test to see whether the library’s drives are listed in the correct 
order. For instructions, see “Testing Drive Configuration” on 
page 68.

4. Configure drive activation settings. You have the following choices:

• Leave the default setting of enabled for the Set drive online when 
library is set online option. This sets the drive online when the library 
comes online.

• Disable the Set drive online when library is set online check box to 
prevent a drive from being set online when the library comes online. 

Note: At least one drive must be configured to be set online when the 
library is set online. Otherwise, the library remains offline.

5. If you added a drive you do not want to use, delete the drive. On the 
Library Drives page, select the drive you want to delete and then click 
Delete.

Note: If you delete a drive, you may need to add a reserved drive in the 
place of the deleted drive. For instructions, see “Adding Reserved 
Drives” on page 66.

Note: If you have a hardware problem with a library drive and want to 
prevent its use, but do not want to remove the drive from the library 
configuration, you can temporarily disable the drive by setting it 
offline. In this situation, you may also want to disable the Set drive 
online when library is set online check box. For more information, 
see “Setting a Library Offline” on page 79. 

6. Once the drives are listed and configured correctly on the Library Drives 
page, click Next. One of the following occurs:

• If you are configuring a tape library, the Library Auto Clean page 
appears. For instructions, see “Configuring the Library Auto Clean 
Page” on page 69.
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• For all other types of libraries, the Library Options page appears. For 
instructions, see “Configuring the Library Options Page” on page 70.

Automatically Configuring Drives
Some SCSI libraries support automatic drive configuration, which allows you 
to add and configure the drives in one step through the interface. Automatic 
configuration automatically adds all the drives in a SCSI library and orders the 
drives as they exist in the library, with their corresponding SCSI ID, which is 
usually, but not necessarily in order of lowest to highest.

Note: Automatic configuration is not supported for serial libraries.

Note: If the library and drive are not on the same bus, automatic 
configuration fails. You must add the drives manually. For instructions, 
see "Manually Configuring Drives, " which follows.

To automatically configure SCSI library drives:

1. On the Library Drives page, click Auto Config. A message appears asking 
you to confirm the automatic configuration. 

2. Click Yes. One of the following occurs:

• If the automatic configuration is successful, a status message appears. 
Click OK. 

• If the automatic configuration fails, a message indicates that the drives 
must be added manually. For instructions, see "Manually Configuring 
Drives, " which follows.

Manually Configuring Drives
Serial libraries and some SCSI libraries do not support automatic 
configuration. Automatic configuration fails if the selected library does not 
support it. In those cases, the library drives must be added and configured 
manually. 
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To manually add library drives:

1. Click the Add button on the Library Drives page. The Select Library Drives 
dialog box appears, showing all drives currently listed in the Windows 
registry, including standalone drives. 

Figure 26.  Select Library Drives Dialog Box 

Be advised that the Select Library Drives dialog box only lists drives that 
are compatible with the drive type selected for the library (either as read/
write or read-only drives).

2. Select the drive(s) you want to add and then click OK. Be sure to only 
select actual library drives. While the system allows you to select 
standalone or external drives from this window, the configuration test run 
afterwards will fail.

Note: When manually adding drives, you must add them in the order of 
the drive number and not the SCSI ID. For example, if drive 1 has 
SCSI ID 1050 and drive 2 has SCSI ID 1040, the SCSI addresses 
of the drives do not appear in ascending order; SCSI ID 1050 
(drive 1) appears before SCSI ID 1040 (drive 2). In the Drives list 
box 1040 (drive 2) still appears first.

Note: If you add only some of the drives in the library, you must add 
reserved drives as placeholders for the drives you do not add. For 
more information, see "Adding Reserved Drives, " which follows.

Adding Reserved Drives
If you choose to add only some of the drives in a library, you must add 
reserved drives as placeholders for the drives that are not added. This is 
particularly important if your library contains drives that are not compatible with 
the drive type selected for the library, and therefore cannot be added to the 
configuration.
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Note: Some libraries are configured in a way that even though there are 
physically two drives, the library firmware expects four drives. When 
automatic configuration is run, reserved drives are added for those 
bays in the library where the drive is missing.

To add reserved drives:

1. Click Add in the Library Drives page. The Select Library Drives dialog box 
appears with a device listed as “Reserved.”

2. Highlight the Reserved Device Name entry and click OK. The Library 
Drives page appears with the reserved drive listed.

Figure 27.  Hardware Wizard – Library Drives Page with Reserved Drive 

3. Repeat this process until you have added a reserved drive in the place of 
each actual library drive that is not being added. The total number of 
drives, actual and reserved, listed in the Library Drives page must equal 
the total number of drives in the library. 

In addition, all drives in the library, including reserved drives, must be 
defined in the order that the vendor numbers its drive elements. For 
example, if you have a library with four drives and you are not using the 
third drive in the library, the reserved drive must appear in place of the 
third drive in the list. For more information, see "Setting Drive Order, " 
which follows.

Setting Drive Order
When you add drives manually, you must be sure they are ordered according 
to the drive order in the library. If you are adding a SCSI library, a configuration 
test can tell you if the order of the drives is correct.
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To change the order of a library drive: 

1. Highlight the drive and then use the up and down arrows to the right of the 
Drives list to promote or demote the drive’s position in the list. 

2. If you are adding a SCSI library, perform a configuration test to determine 
if the order of the drives is correct. For instructions, see "Testing Drive 
Configuration, " which follows.

Testing Drive Configuration
When you manually add SCSI library drives, you should perform a 
configuration test on the library to ensure the drives are ordered properly. 
Media must be present in the library before you can perform a configuration 
test. Automatic configuration should order your drives properly when they are 
added, but you may wish to perform a configuration test anyway.

Note: The configuration test function is not supported for serial libraries.

Note: Before performing a configuration test on a DVD library, make sure 
there is no unformatted media in the library. This has been known to 
cause an error in the configuration test, even though the library 
configuration itself is correct. We recommend you place a piece of 
formatted media into the library prior to the test.

To perform a configuration test: 

1. Click Test Config on the Library Drives page. A status message appears 
while the library and its drives are assessed. 

After the test is complete, a message returns stating whether the test 
succeeded. 

2. Click OK to exit the message and return to the Library Drives page. 

3. If the configuration test fails, verify each of the following:

• The drives are ordered properly. To change drive order, see “Setting 
Drive Order” on page 67.

• The number of drives in the library matches the number of drives 
listed. If any of the drives in the library are not listed, either add the 
drive manually or add a reserved drive as a placeholder. For 
instructions, see “Manually Configuring Drives” on page 65 or “Adding 
Reserved Drives” on page 66.

• No standalone or external drives have been selected. 

• There is media in the library. For DVD libraries, make sure there is 
formatted media in the library. Unformatted media may cause a 
configuration test to fail.

4. Perform another configuration test to ensure accuracy.



Managing Libraries

ASM MediaStor System Guide 69
StorageTek Proprietary

Configuring the Library Auto Clean Page
The Library Auto Clean page allows you to set up automatic cleaning options 
based on read/write usage for tape library drives. This allows you to store a 
cleaning cartridge in the library and clean the drives automatically without 
manual intervention.

If you are not configuring a tape library, the Library Options page appears. For 
instructions, see "Configuring the Library Options Page, " which follows.

To configure the Library Auto Clean page:

1. Be sure that the cleaning cartridge is resident in the library. This allows 
MediaStor to find the cleaning cartridge and insert it into the library drives 
when appropriate.

Note: The cleaning cartridge must not be placed in the first shelf of the 
library. Otherwise, the hardware inventory for the library may fail.

2. On the Library Auto Clean page, you have the following options:

• To disable automatic cleaning, select Disable automatic drive cleaning 
for this library.

Figure 28.  Hardware Wizard – Library Auto Clean Page 

• To set up automatic cleaning to occur after a specified amount of total 
read/write activity has occurred, select Clean drives when total read/
write activity is exceeded. Then enter the total number of hours the 
drive must be in use before the drive is cleaned in the Total hours of 
activity text box.

• To set up automatic cleaning to occur after a specified amount of either 
read or write activity has occurred, select Clean drives when read or 
write activity is exceeded. Then enter separately the total number of 
hours each drive must be in use for read or for write before the drive is 
cleaned.
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3. If you enabled automatic cleaning, enter the shelf number where the 
cleaning cartridge is located. The cleaning cartridge must already be 
resident in the identified shelf.

4. Click Next. The Library Options page appears. For instructions, see 
"Configuring the Library Options Page, " which follows.

Configuring the Library Options Page
The Library Options page lists all configurable options available for the library.

Figure 29.  Hardware Wizard – Library Options Page 

The configuration options that appear in the lower part of the Library Options 
page correspond to the option selected in the list in the upper part of the 
Library Options page.

To configure the Library Options page:

1. Configure the Idle drive dismount option, which allows you to specify 
whether you want to dismount media in the library after a specified amount 
of time has passed without read or write requests. You have the following 
choices:

• To allow the library to dismount media from a drive after a certain 
number of seconds has passed without a read or write request for that 
media, enable the Dismount media option. Then enter the number of 
seconds that should pass before the library dismounts the media. The 
default value is 60 seconds.

• To leave media in a drive regardless of how long the media has been 
inactive, select the Do not automatically dismount the media option. 
Media is dismounted when another piece of media must be mounted in 
the drive for a read or write request. 

2. Configure the Maximum shelves to use for inventory option, which allows 
you to specify how many shelves MediaStor should use. This feature can 
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be used to partially utilize a library with a damaged shelf or to prevent 
automatic inventory of a large number of shelves, which can take a long 
time. You have the following choices:

• Select the Use all shelves in this library option to use all of the library 
shelves to hold media for the media service. This is the default.

• Select the Use only the first __ shelves option to only use a select 
number of shelves (consecutively starting with the first shelf) to hold 
media for the media service. Then enter the number of consecutive 
shelves (starting from the first shelf and including the specified shelf) 
that MediaStor should use. 

3. Click Finish. In most cases, MediaStor requires that the computer be 
rebooted when new devices are configured. If reboot is required, 
MediaStor prompts you to reboot the computer.

Figure 30.  Reboot MediaStor Computer? Message 

4. Click Yes to reboot the MediaStor computer. Once the computer reboots, 
the device is added to the MediaStor configuration.

Note: You may receive an “Invalid Driver” error after restarting the MediaStor 
computer. This occurs most frequently on a Windows 2000 platform 
with libraries with 4 or more drives, and typically happens for one of 
two reasons: either the native Windows plug-and-play drivers claimed 
the devices before the MediaStor drivers could, or the MediaStor 
service completed startup before all of the drives were initialized. To 
clear the error, try stopping then restarting the MediaStor service. If 
that does not clear the error, contact your technical support 
representative, who may advise you to run the ScsiUpdate command 
line utility. 

Note: If you add a library to MediaStor in a clustered environment and the 
initial inventory of the library fails after the first several pieces of media, 
set the library offline and then online again, and when prompted, run a 
full inventory and force a hardware reset, in order to properly inventory 
the library. For more information on setting the library offline and 
online, see “Setting a Library Offline” on page 79 and “Setting a Library 
Online” on page 79. For more information on clustering, see Appendix 
A: Clustering of the ASM Data Manager Getting Started Guide. 
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Managing Media in a Library
When adding media to a library, certain hardware issues must be addressed. 
The procedures for adding media are dictated by the specific library being 
used. Some libraries require that the device be taken offline before inserting 
media, while other devices allow for media insertion while online. 

Library procedures differ by model. For example, some libraries have a 
mailslot into which media is placed before it is put on a shelf or mounted in a 
drive. Some libraries use magazines that hold several pieces of media, so that 
when a magazine is removed, multiple pieces of media are removed as well. 
Libraries using magazines must be taken offline before you eject the 
magazine. Once you re-insert the magazine, you can set the library online and 
it can be inventoried. Always be sure to inventory those shelves where the 
media status has changed, even if you’ve switched media on two different 
shelves.

For instructions on setting libraries online and offline, see “Setting a Library 
Offline” on page 79 and “Setting a Library Online” on page 79.

Quick access to all aspects of library media management is available through 
the Manage Media feature. Depending on the limitations of the library, you 
may be able to insert, move, and eject media using this dialog box. You can 
also monitor media status. 

To manage library media: 

1. Right-click on the name of the library in the Hardware tree and select 
Manage Media from the shortcut menu. The Manage Library Media dialog 
box appears.

Figure 31.  Manage Library Media Dialog Box 
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The Manage Library Media dialog box lists the library drives and shelves, 
along with what media is located on each shelf and the status of the 
media. 

2. You have the following choices:

• Insert a piece of media into the library. For instructions, see "Inserting 
Media, " which follows. 

• Move a piece of media from one library shelf to another. For 
instructions, see “Moving Media” on page 74.

• Eject a piece of media from the library. For instructions, see “Ejecting 
Media” on page 75.

Note: Some options may not be available, such as when the library does 
not support certain commands or has no mailslot. In those cases, 
the appropriate buttons are disabled.

3. When you finish, click Close to close the Manage Library Media dialog 
box.

Inserting Media
Some library models have individual procedures for inserting media, such as 
opening up a door to place media into the shelves. This type of model also 
requires the library be taken offline while media is inserted, and then set online 
and inventoried once the media is in place. For information about inserting 
media into your library, refer to the individual library documentation. 

If the library supports it, you can insert media using the Insert Library Media 
function.

To insert media into a library:

1. Click the Insert button in the Manage Library Media dialog box. The Insert 
Library Media dialog box appears. 

Figure 32.  Insert Library Media Dialog Box 

Note: If specific shelves are selected in the Manage Library Media dialog 
box at the time you click Insert, MediaStor automatically enables 
the Insert media to specified shelves option and enters those shelf 
numbers in the Shelves text box.
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2. There are two options for inserting media:

• To insert media to specific shelves, select Insert media to specified 
shelves and then enter the numbers of the appropriate shelves in the 
Shelves text box. 

• To automatically insert media to available shelves, select Insert media 
to first available shelves and then specify the quantity of media you are 
inserting. 

3. Click OK. The media is inserted onto the shelves as configured. The status 
of the shelf reads “Inventory Pending” until the media is mounted.

Note: If the library in use has no mailslot, special considerations apply. The 
library must be set offline before you manually place media in the shelf 
or magazine location. Once the desired media is inserted, the library 
must be set back online, and MediaStor prompts you to inventory the 
library. For instructions on setting libraries online and offline, see 
“Setting a Library Offline” on page 79 and “Setting a Library Online” on 
page 79.

Moving Media
From the Manage Library Media dialog box you can move a piece of media 
from one library shelf to another. The Move feature allows you to optimize 
system performance by keeping the most frequently used pieces of media 
closest to the library drives. It also allows you to group media for organization 
purposes, such as for each department in the workplace.

To move media in a library:

1. Click the Move button in the Manage Library Media dialog box. The Move 
Library Media dialog box appears.

Figure 33.  Move Library Media Dialog Box 

Note: If specific shelves are selected in the Manage Library Media dialog 
box at the time you click Move, MediaStor automatically enters 
those shelf numbers in the Move Media On Specified Shelves text 
box.

2. In the Move Media On Specified Shelves text box, enter the number(s) of 
the shelf/shelves where the media to be moved is currently located. 
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3. In the To Empty Shelves Starting At Shelf text box, enter the number of the 
shelf where MediaStor should start to place media. MediaStor will begin to 
move the media to that shelf and continue to place media on each 
available shelf in sequence until all moved media is remounted.

4. Click OK. The specified media is moved. 

Ejecting Media
From the Manage Library Media dialog box, you can eject a piece of 
MediaStor media from the library. You can choose to eject a specific piece of 
media, or some quantity of the least frequently used media. MediaStor 
continues to track ejected media and prompts you to reinsert the media when 
read and write requests are received.

Note: If the library in use has no mailslot, special considerations apply. The 
library must be set offline before you manually remove media from the 
shelf or magazine location. Once the media is removed, the library 
must be set back online, and MediaStor prompts you to inventory the 
library. For instructions on setting libraries online and offline, see 
“Setting a Library Offline” on page 79 and “Setting a Library Online” on 
page 79.

To eject media from a library: 

1. Click the Eject button in the Manage Library Media dialog box. The Eject 
Library Media dialog box appears.

Figure 34.  Eject Library Media Dialog Box 

Note: If specific shelves are selected in the Manage Library Media dialog 
box at the time you click Eject, MediaStor automatically enables 
the Eject media from specified shelves option and automatically 
enters those shelf numbers in the Shelves text box.

2. There are two options for ejecting media:

• To eject media on specific shelves, select Eject media from specified 
shelves and then enter the numbers of the desired shelves in the 
Shelves text box. 

• To eject the least frequently used pieces of media, select Eject least-
used media and then specify the quantity of media to be ejected. 
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3. Click OK. The specified media is ejected.

Modifying a Library
Several aspects of a library’s configuration can be changed at any time, if 
necessary. You can modify the library name, drive type, or file system setting, 
add or remove drives as needed, change the drive event settings, and 
reconfigure library options. 

Modifying a library takes you back through the steps of the Hardware Wizard 
you used to add the library. You can change the information on each of the 
pages in the same way you set the library up when you added it to MediaStor.

To modify a library:

1. Set the library offline. For instructions, see “Setting a Library Offline” on 
page 79.

2. Right-click the library you want to modify and then select Modify from the 
shortcut menu. A confirmation message appears.

3. Click Yes. The Hardware Wizard Library Configuration page appears. For 
instructions, see “Configuring the Library Configuration Page” on page 59.

4. Click Next. One of the following occurs:

• If you are configuring a serial library, the Serial Library Information 
page appears. For instructions, see “Configuring the Serial Library 
Information Page” on page 61. Then click Next. The Library Drives 
page appears. For instructions, see “Configuring the Library Drives 
Page” on page 61.

• If you are not configuring a serial library, the Library Drives page 
appears. For instructions, see “Configuring the Library Drives Page” on 
page 61.

5. Click Next. One of the following occurs:

• If you are modifying a tape library, the Library Auto Clean page 
appears. For instructions, see “Configuring the Library Auto Clean 
Page” on page 69. After you finish configuring the Library Auto Clean 
page, click Next. The Library Options page appears. For instructions, 
see “Configuring the Library Options Page” on page 70.

• If you are not modifying a tape library, the Library Options page 
appears. For instructions, see “Configuring the Library Options Page” 
on page 70.

6. Click Finish. You may be required to reboot to allow changes to be made 
to your SCSI configuration.
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Viewing Library Properties
Accessing the Library Properties dialog box and selecting each of the tabs 
allows you to view and change the settings established when the library was 
added to MediaStor. 

To view library properties:

1. Right-click the library whose properties you want to view and then select 
Properties from the shortcut menu. The Library Properties dialog box 
appears with the General tab active by default. 

Figure 35.  Library Properties Dialog Box 

Library Properties are summarized on the following tabs: 

• The General tab corresponds to the Library Configuration page of the 
Hardware Wizard you used to add the library to MediaStor, except that 
none of the fields are editable. For more information, see “Configuring 
the Library Configuration Page” on page 59.

• The Auto Clean tab, which only appears if you are viewing the 
properties for a tape library, corresponds to the Library Auto Clean 
page of the Hardware Wizard. You can edit the automatic cleaning 
settings on the Auto Clean tab. For more information, see “Configuring 
the Library Auto Clean Page” on page 69.

• The Options tab corresponds to the Library Options page of the 
Hardware Wizard. You can edit the options. For more information, see 
“Configuring the Library Options Page” on page 70.

• The Statistics tab contains information about media mounts and file 
read and write statistics. For more information, see "The Statistics Tab, 
" which follows.

2. As with most Properties functions in ASM, when you finish you have three 
options:
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• To save changes and close the Properties dialog box, click OK.

• To save changes and keep the Properties dialog box open, click Apply.

• To discard all changes made since the Properties dialog box was 
opened (or since the Apply button was last used) and close the 
Properties dialog box, click Cancel.

The Statistics Tab
When you select a drive in the Drives list and click the Statistics tab in the 
Library Properties dialog box, the mount information and Drive I/O totals for 
that drive are shown.

Figure 36.  Library Properties – Statistics Tab 

The following table describes each of the items appearing on the Statistics tab:

Table 7.  Library Properties Dialog Box – Statistics Tab Items

Item Description
Mount Count Number of mounts per current session

Dismount Count Number of dismounts per current session

Exchange Count Number of times media on a shelf is exchanged with 
media in a drive per current session

Flip Count Number of pieces of media that were flipped during 
current session

Insert Count Number of pieces of media that were inserted during 
current session

Eject Count Number of pieces of media that were ejected during 
current session

Hardware Errors Number of hardware errors encountered per current 
session
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Setting a Library Offline
If a library is experiencing hardware problems or needs to be opened for 
maintenance or troubleshooting, it should first be taken offline. Once the 
problem is corrected, the library may then be placed back online.

To set a library offline:

1. Right-click the library in the Hardware tree. If the library is online, the Set 
Offline option is active in the shortcut menu. 

2. Select Set Offline from the shortcut menu. A confirmation message 
appears.

3. Click Yes.

Setting a Library Online
A library must be online in order for MediaStor to perform media functions in 
that library. If the library is offline, then all drives are inactive and programs 
cannot write to or read from the media. You can, however, view shelf position 
and label information for offline media in a library. This information appears in 
the Manage Library Media dialog box, which can be accessed by right-clicking 
on the name of the library in the Hardware tree and selecting Manage Media 
from the shortcut menu.

To set a library online:

1. Right-click the library in the Hardware tree. If the library is offline, the Set 
Online option is active in the shortcut menu.

2. Select the Set Online option from the shortcut menu. The Set Library 
Online dialog box appears.

Read File Count Number of read requests during current session

Read Byte Count Number of bytes of files read during current session

Write File Count Number of write requests during current session 

Write Byte Count Number of bytes of files written during current 
session

Valid Since The date from which the statistics on this tab are 
calculated

Clear Statistics 
button

To clear the statistics and reset the date from which 
the statistics on this tab are calculated, click Clear 
Statistics.

Table 7.  Library Properties Dialog Box – Statistics Tab Items 

Item Description
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Figure 37.  Set Library Online Dialog Box 

3. Choose whether you want to inventory the shelves in the library. You have 
the following choices:

• To set the library online without inventorying shelves (the latest shelf 
inventory is assumed to be accurate), select Do not inventory any 
shelves. 

• To inventory only certain shelves, select Inventory specified shelves 
and then enter the number of each shelf to be inventoried. To inventory 
a certain range of shelves, specify the first and last shelf numbers 
(separated by a hyphen [-]) from lowest to highest. You can also 
specify individual shelves by listing the shelf numbers separated by 
commas.

• To inventory every shelf in the library, select Inventory all shelves in 
this library. Note that an inventory of the entire library may take a long 
time. This is the default. 

Note: If a library is configured not to be set online automatically on 
startup, the first time the library is set online, all shelves are 
inventoried.

Note: MediaStor stores which shelves contain media and the applicable 
media labels in the Windows registry. When a library inventory is 
performed, MediaStor checks each shelf for changes in the status 
of the shelves or the media. For shelves selected for inventory, 
MediaStor mounts the media and reads the labels.

4. If you do not want to perform a full inventory of all shelves, full and empty, 
upon setting the library online, disable the Force a reset of hardware 
media inventory check box. 

5. Click OK. One of the following occurs: 

• If you left the defaults (full inventory and hardware reset), the library is 
inventoried and set online.
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• If you changed the defaults, a warning message appears. To return to 
the Set Library Online dialog box and change your selections, click No. 
To continue setting the library online, click Yes.

Note: Media is not mounted to a library drive that is offline. This is helpful for 
troubleshooting, repair, and maintenance of library drives without 
deleting the library from MediaStor. Never service any device while it is 
online, including offline drives that reside in an online library. 

Deleting a Library
A library can be deleted from the MediaStor hardware configuration at any 
time. Once a library is deleted, it is permanently removed from configuration. 
In order to use this library, it must again be added through the Hardware 
Wizard. Care should be taken when deleting a library, as it may be more 
helpful to set the library offline if it is to be used again. This is helpful if a 
problem occurs with the library and it is necessary to remove it only 
temporarily from the configuration.

To delete a library from MediaStor:

1. Set the library offline. For instructions, see “Setting a Library Offline” on 
page 79.

2. Right-click the library you want to delete and then select Delete from the 
shortcut menu. A confirmation message appears.

3. Click Yes.

Note: You may be required to reboot to allow changes to be made to your 
SCSI configuration.

■ Managing Towers 
A tower is a group of standalone (non-library) drives in which you manually 
mount and dismount media during runtime. You can manage the drives in 
each tower and set them online or offline. From the shortcut menu on each 
tower’s node in the Hardware tree, you can add, modify, and delete towers 
and their drives. 

For more information, see the following sections:

• "Adding a Tower, " which follows

• “Modifying a Tower” on page 86

• “Viewing Tower Properties” on page 87

• “Setting a Tower Offline” on page 88
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• “Setting a Tower Online” on page 88

• “Deleting a Tower” on page 88

Adding a Tower
The Hardware Wizard leads you step-by-step through the process of adding a 
tower to MediaStor. You can configure the tower at the time you create it, or 
you can access and change these configurations later through the Hardware 
Wizard. The tabs of the Tower Properties dialog box are identical to the 
corresponding pages of the Hardware Wizard.

Any drive currently listed in the Windows registry can be added to MediaStor. 

Note: The Windows Registry contains an inventory of all SCSI devices 
connected, powered on, and responding upon startup. For a full list of 
supported towers, refer to the Supported Device List available on the 
StorageTek website: http://www.support.storagetek.comand on the 
install CD. 

To add a tower:

1. Right-click on the Hardware node and select New from the shortcut menu 
to start the Hardware Wizard. The Add New Hardware Device page 
appears. 

Figure 38.  Hardware Wizard -- Add New Hardware Device Page 

2. Select the Tower option and click Next. The Tower Configuration page 
appears.

http://www.legato.com/resources/compatibility/
http://www.legato.com/resources/compatibility
http://www.legato.com/support/knowledgebase
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Figure 39.  Hardware Wizard – Tower Configuration Page 

3. In the Name text box, enter a name for the tower. Tower names are used 
only for user interface purposes and can be any alphanumeric string, up to 
32 characters.

4. Select the type of media the tower uses. MediaStor detects the type of 
tower and enters that type by default.

5. Select whether to set the tower online when the MediaStor service starts. 
You have the following choices:

• To set the tower online when the MediaStor service starts, leave the 
default setting of enabled for the Automatically set this device online 
when the server starts option. This allows the system to automatically 
set the tower online during system startup.

• Disable the Automatically set this device online when the server starts 
check box to prevent the tower from being set online when the 
MediaStor service starts. If you disable this option, you need to set the 
tower online manually.

6. Click Next. The Tower Drives page appears.
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Figure 40.  Hardware Wizard -- Tower Drives Page 

7. To add drives to the tower, click Add. The Select New Tower Drive(s) 
dialog box appears. This dialog box lists all drives currently available for 
addition to the tower configuration. 

Figure 41.  Select New Tower Drive(s) Dialog Box 

8. Select the drives you want to add and then click OK. The Tower Drives 
page reappears listing the drives that have been added.
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Figure 42.  Hardware Wizard -- Tower Drives Page with Drive Added 

For each drive added, the Tower Drives page shows the SCSI device 
name along with the default file system selected for the drive.

9. If necessary, highlight each drive in the list and select the appropriate file 
system for the drive from the File System drop-down list. For more 
information on file systems, see “Types of Media File Systems” on 
page 17.

Note: You cannot combine different file systems within a single tower. All 
drives must use the Windows Native file system, ASM file system, 
or UDF file system.

10. Make sure the tower drives are listed in the same order that they exist in 
the tower. To change the order of a drive, select the drive and then use the 
up and down arrows to the right of the Drives list to promote or demote the 
drive’s position in the list.

11. Configure the drive activation settings for each drive. You have the 
following choices:

• Leave the default setting of enabled for the Set drive online when 
tower is set online option. This sets the drive online when the tower 
comes online.

• Disable the Set drive online when tower is set online check box to 
prevent a drive from being set online when the tower comes online. 

Note: At least one drive must be configured to be set online when the 
tower comes online. The tower cannot be set online without any 
online drives.

12. To delete a drive from the tower configuration, select the drive from the 
Drives list and then click Delete.

13. Click Finish.
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Note: Adding some devices causes MediaStor to prompt you to reboot. 

Modifying a Tower
A tower’s configuration can be modified at any time, if necessary. You can 
modify the tower name and startup setting, add or remove drives as needed, 
and change the drive activation settings. 

Modifying a tower takes you back through the Hardware Wizard you used to 
add the tower to MediaStor. You can change the information on each of the 
pages in the same way you set the tower up when you added it to MediaStor.

To modify a tower:

1. Set the tower offline. For instructions, see “Setting a Tower Offline” on 
page 88.

2. Right-click the tower you want to modify and then select Modify from the 
shortcut menu. A confirmation message appears.

3. Click Yes. The Hardware Wizard Tower Configuration page appears.

Figure 43.  Hardware Wizard -- Tower Configuration Page 

The Tower Configuration page is identical to the page you configured 
when you added the tower except that you cannot change the tower type. 
For instructions, see “Adding a Tower” on page 82.

4. Click Next. The Tower Drives page appears and is also identical to the 
page you configured when you added the tower.

5. Click Finish. You may be required to reboot to allow changes to be made 
to your SCSI configuration.
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Viewing Tower Properties
Accessing the Tower Properties dialog box allows you to view the settings 
established when the tower was added to MediaStor. 

Note: Properties can also be viewed for individual drives within the tower. 
Drive properties for tower drives include the General tab, with general 
drive information, and the Statistics tab. For details on these tabs, see 
“Viewing Standalone Drive Properties” on page 92.

To view tower properties:

1. Right-click the tower whose properties you want to view and then select 
Properties from the shortcut menu. The Tower Properties dialog box 
appears. 

Figure 44.  Tower Properties – General Tab 

The information provided is described in the following table:

2. As with most Properties functions in ASM, when you finish you have three 
options:

• To save changes and close the Properties dialog box, click OK.

Table 8.  Tower Properties General Tab Information

Item Description
Tower Type The type of media the tower uses

Status Whether the tower is online or offline

Name The name assigned to the tower

Drive Count The number of drives in the tower

Auto Set Online Whether the device is automatically set online when 
MediaStor starts
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• To save changes and keep the Properties dialog box open, click Apply.

• To discard all changes made since the Properties dialog box was 
opened (or since the Apply button was last used) and close the 
Properties dialog box, click Cancel.

Setting a Tower Offline
If a tower is experiencing hardware problems or needs to be opened for 
maintenance or troubleshooting, it should first be taken offline. Once the 
problem is corrected, the tower may then be placed back online.

To set a tower offline:

1. Right-click the tower in the Hardware tree. If the tower is online, the Set 
Offline option is active in the shortcut menu.

2. Select Set Offline from the shortcut menu. A confirmation message 
appears.

3. Click Yes.

Note: As some tower drives support automatic eject (for example, HP), and 
some do not (for example, Ricoh), MediaStor does not automatically 
eject media when set offline. Media must be ejected using the front 
panel of the drive.

Setting a Tower Online
A tower must be online for MediaStor to perform media functions using drives 
in that tower. If the tower drives are offline, they are inactive and you cannot 
view media statistics, or write to or read from the media. 

When a tower is set online, MediaStor inventories the media inserted to 
determine if it recognizes the file format. If the media has never been 
formatted, or if it has been formatted for a file system other than the one 
configured for the drive, MediaStor identifies the media as “foreign.”

To set a tower online:

1. Right-click the tower in the Hardware tree. If the tower is offline, the Set 
Online option is active in the shortcut menu.

2. Select Set Online from the shortcut menu. A confirmation message 
appears.

3. Click Yes.

Deleting a Tower
A tower can be deleted from MediaStor at any time. Once a tower is deleted, it 
is permanently removed from configuration. In order to use this tower again, it 
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must be added through the Hardware Wizard. Care should be taken when 
deleting a tower, as it may be more useful to set the tower offline if the tower is 
to be used again. This is helpful if a problem occurs with the tower and it is 
necessary to remove it only temporarily from the configuration.

To delete a tower from MediaStor:

1. Set the tower offline. For instructions, see “Setting a Tower Offline” on 
page 88.

1. Right-click the tower you want to delete, and then select Delete from the 
shortcut menu that appears. 

2. Click Yes. 

Note: If an ASM file system was used in the device, you must reboot to allow 
Windows drivers to reclaim the device for use within Windows. 
Additionally, drive letters may not be reassigned to devices using 
Windows file systems until after reboot. 

■ Managing Standalone Drives
Standalone drives can be useful as alternate devices, especially in the case of 
library malfunction. Standalone drives are non-library drives in which you 
manually mount and dismount media during runtime. 

For more information, see the following sections:

• "Adding a Standalone Drive, " which follows

• “Modifying a Standalone Drive” on page 92

• “Viewing Standalone Drive Properties” on page 92

• “Setting a Standalone Drive Offline” on page 97

• “Setting a Standalone Drive Online” on page 97

• “Deleting a Standalone Drive” on page 97

Adding a Standalone Drive
The Hardware Wizard leads you step-by-step through the process of adding a 
standalone drive to MediaStor. You can configure the standalone drive at the 
time you create it, or you can access and change these configurations later 
through the Hardware Wizard.

Once a standalone drive has been added to the MediaStor hardware 
configuration, it appears in the Hardware tree. A drive can be modified at any 
time if necessary. 
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The Windows Registry contains an inventory of all SCSI devices connected, 
powered on, and responding upon startup. Any supported standalone drive 
currently listed in the Windows registry can be added to MediaStor. For a full 
list of supported devices, refer to the Supported Device List available on the 
StorageTek website: http://www.support.storagetek.com/, and on the install 
CD. You can also open SCSI Manager to see if the configuration file is loaded 
for the device. If it is, you can configure the device in MediaStor. 

To add a standalone drive:

1. Right-click on the Hardware node and select New from the shortcut menu 
to start the Hardware Wizard. The Add New Hardware Device Page 
appears.

Figure 45.  Hardware Wizard -- Add New Hardware Device Page 

2. Select the Standalone drive option and click Next. The Select New Drive 
page appears.

Figure 46.  Hardware Wizard -- Select New Drive Page 

http://www.legato.com/resources/compatibility/
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The Select New Drive page lists of all the standalone drives currently listed 
in the Windows Registry that have not yet been added to MediaStor. 

3. Select the standalone drive you want to add and click Next. The 
Standalone Drive Configuration page appears.

Figure 47.  Hardware Wizard -- Standalone Drive Configuration Page 

4. In the Name text box, enter a name for the standalone drive. Standalone 
drive names are used only for user interface purposes and can be any 
alphanumeric string, up to 32 characters.

5. From the Drive Type drop-down list, select the type of drive (media) that 
the standalone drive contains.

6. Select the file system the standalone drive uses. For more information on 
file systems, see “Types of Media File Systems” on page 17.

7. Select whether to set the standalone drive online when the MediaStor 
service starts. You have the following choices:

• To set the standalone drive online when the MediaStor service starts, 
leave the default setting of enabled for the Set this device online when 
the server starts option. This allows the system to automatically set the 
standalone drive online during system startup.

• Disable the Set this device online when the server starts check box to 
prevent the standalone drive from being set online when the MediaStor 
service starts. If you disable this option, you need to set the standalone 
drive online manually.

8. Click Finish.

Note: You may be required to reboot to allow changes to be made to your 
SCSI configuration.
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Modifying a Standalone Drive
A standalone drive’s configuration can be modified at any time, if necessary. 
You can modify the standalone drive name, drive type, file system, and startup 
setting. 

Modifying a standalone drive takes you back through the Hardware Wizard 
you used to add the standalone drive to MediaStor. You can change the 
information in the same way you set the standalone drive up when you added 
it to MediaStor.

To modify a standalone drive:

1. Set the standalone drive offline. For instructions, see “Setting a 
Standalone Drive Offline” on page 97.

2. Right-click the standalone drive you want to modify and then Select Modify 
from the shortcut menu. A confirmation message appears.

3. Click Yes. The Hardware Wizard Standalone Drive Configuration page 
appears.

Figure 48.  Standalone Drive Configuration Page 

The Standalone Drive Configuration page is identical to the page you 
configured when you added the standalone drive. For instructions, see 
“Adding a Standalone Drive” on page 89.

4. Click Finish. You may be required to reboot to allow changes to be made 
to your SCSI configuration.

Viewing Standalone Drive Properties
Accessing the Standalone Drive Properties dialog box and selecting each of 
the tabs allows you to view the settings established when the standalone drive 
was added to MediaStor. 
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To view standalone drive properties:

1. Right-click the standalone drive whose properties you want to view and 
then select Properties from the shortcut menu. The Standalone Drive 
Properties dialog box appears with the General tab active by default. 

Figure 49.  Standalone Drive Properties – General Tab 

2. Select and view the information on each of the tabs as necessary. For 
more information, see the following sections:

• "The General Tab, " which follows

• “The Media Tab” on page 94

• “The Statistics Tab” on page 95

Note: The Media tab appears only when there is media in the drive and 
the drive is online.

3. As with most Properties functions in ASM, when you finish you have three 
options:

• To save changes and close the Properties dialog box, click OK.

• To save changes and keep the Properties dialog box open, click Apply.

• To discard all changes made since the Properties dialog box was 
opened (or since the Apply button was last used) and close the 
Properties dialog box, click Cancel.

The General Tab
The General tab provides general information about the standalone device 
and the configuration.

To view the General tab:

• Select the General tab of the Standalone Drive Properties dialog box.
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Figure 50.  Standalone Drive Properties – General Tab 

The General tab contains the following information:

The Media Tab
The Media tab provides general information about media currently in the drive. 
This tab appears only when there is media in the drive and the drive is online.

To view the Media tab:

• Select the Media tab of the Standalone Drive Properties dialog box.

Table 9.  Standalone Drive Properties – General Tab Information

Item Description
Device Name The name of the interface to which the device is 

connected

Description The device description derived from the inquiry string for 
the device provided by the hardware manufacturer and 
referenced in the Windows NT/2000 Registry

Device Type The type of media used by the device in which the drive is 
contained

Drive Type The type of media the drive uses

Status Whether the drive is online or offline

Name The name assigned to the drive when the drive was 
added to MediaStor

File System The file system selected when the drive was added to 
MediaStor

Auto Set Online Whether the device is set online when MediaStor starts
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Figure 51.  Standalone Drive Properties – Media Tab 

The Media tab contains the following information:

The Statistics Tab
The Statistics tab provides statistics on drive usage.

To view the Statistics tab:

• Select the Statistics tab of the Standalone Drive Properties dialog box.

Table 10.  Standalone Drive Properties – Media Tab Information

Item Description
Name The name of the piece of media, taken from the volume 

label on the media

Serial Number The serial number for the piece of media

Label Time The date and time the media was labeled

Size The amount of data on the media

Status The current status of the media

Class The media classification being used to track the function 
of the media (such as original or copy)

Type The type of media in the drive

File System The file system for the media

View All Media 
Properties

Allows you to view the Media Properties dialog box for the 
media in the drive. For more information, see “Viewing 
Media Properties” on page 102.
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Figure 52.  Standalone Drive Properties – Statistics Tab 

• The Statistics tab contains the following information:

Table 11.  Standalone Drive Properties – Statistics Tab Information

Item Description
Mount Count The number of times media has been mounted in 

the drive

Flip Count The number of times media in the drive has been 
flipped

Read File Count The number of files read from media in the drive

Read Byte Count The total number of bytes of files read from media in 
the drive

Write Byte Count The total number of bytes of files written to media in 
the drive

Write File Count The number of files written to media in the drive

Media Errors The total number of errors that have occurred 
relating to media in the drive

Hardware Errors The total number of errors that have occurred 
relating to the drive hardware

Valid Since The date from which the statistics on this tab are 
calculated

Clear Statistics 
button

To clear the statistics and reset the date from which 
the statistics on this tab are calculated, click Clear 
Statistics.
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Setting a Standalone Drive Offline
If a device is experiencing hardware problems or needs to be opened for 
maintenance or troubleshooting reasons, it should first be taken offline. Once 
the problem is corrected, the device may then be placed back online. Once a 
drive is offline, it is inactive and you cannot view media statistics or write to or 
read from the media.

Standalone drives always require the drive be taken offline while media is 
ejected or inserted. Once inserted, place the drive online to read the media. 

Note: As some standalone drives support automatic eject (for example, HP), 
and some do not (for example, Ricoh), MediaStor does not 
automatically eject media when set offline. Media must be ejected 
using the front panel of the drive.

To set a standalone drive offline:

1. Right-click the drive in the Hardware tree. If the drive is online, the Set 
Offline option is active in the shortcut menu.

2. Select Set Offline from the shortcut menu. A confirmation message 
appears.

3. Click Yes.

Setting a Standalone Drive Online
A drive must be online in order for MediaStor to perform media functions using 
that drive. For example, standalone drives always require the drive be taken 
offline while media is ejected or inserted. Once inserted, place the drive online 
to read the media. 

When a drive is set online, MediaStor inventories the media inserted to 
determine if it recognizes the file format. If the media is unsupported by 
MediaStor or has been formatted for a file system other than the one 
configured for the drive, MediaStor identifies the media as ‘foreign.’

To set a standalone drive online:

1. Right-click the drive in the Hardware tree. If the drive is offline, the Set 
Online option is active in the shortcut menu.

2. Select Set Online from the shortcut menu. A confirmation message 
appears.

3. Click Yes.

Deleting a Standalone Drive
A standalone drive can be deleted from MediaStor at any time. Once a drive is 
deleted, it is permanently removed from configuration. In order to use this 
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drive again, it must be added through the Hardware Wizard. Care should be 
taken when deleting a drive, as it may be more useful to set the drive offline if 
it is to be used again. Setting a drive offline is helpful if a problem occurs with 
the drive and it is necessary to remove it temporarily from the configuration. 

To delete a standalone drive from MediaStor:

1. Set the standalone drive offline. For instructions, see “Setting a 
Standalone Drive Offline” on page 97.

2. Right-click the drive you want to delete, and then select Delete from the 
shortcut menu that appears. 

3. Click Yes.

Note: You may be required to reboot to allow changes to be made to your 
SCSI configuration.
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6Managing Storage Media

By adding media to the MediaStor hardware devices, you create a supply of 
storage media that you can allocate for use by connected ASM Data Manager 
services. Media are listed in the MediaStor system as soon as they are 
inserted in the device and inventoried. 

Media that have been added to the system but have not yet been allocated to 
a Data Manager extended drive appear in the Scratch Pool media tree. Media 
that have been allocated to a Data Manager extended drive can be found 
under their specific extended drive node in the Application Pools media tree. 

When a piece of media is initially added to a media device, MediaStor 
evaluates the media, and places it in one of the eight nodes in the media tree. 
Which node it is placed in depends on the media’s attributes, such as whether 
the media is formatted with a recognized file system, or if the media is not yet 
labeled. Once media attributes are determined, the media is added to the 
appropriate media class node. For more information on media class nodes, 
see “Media Pools” on page 47. 

The following sections deals primarily with accessing information about the 
media and how to move the media between the Application and Scratch 
Pools:

• "Allocating Media to Application Pools, " which follows

• “Moving Media to the Scratch Pool” on page 101

• “Viewing Media Properties” on page 102

• “Deleting Media” on page 109

For more information about the types of media that MediaStor supports, see 
“Storage Media Considerations” on page 14.

■ Allocating Media to Application Pools
Once you have configured a MediaStor media service and created an 
extended drive in ASM Data Manager, you can allocate media to that 
extended drive using the Allocate Media to Application Pool feature in 
MediaStor. Allocating media to a Data Manager extended drive makes the 
media available to the Data Manager service so that you can begin migrating 
files to and reading files from that piece of media.
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Note: You can also allocate media to an extended drive through the Data 
Manager interface. For instructions, see the Managing Storage Media 
chapter of the ASM Data Manager System Guide.

To allocate media to an application pool:

1. You have the following choices:

• Select the piece of Scratch Pool media you want to allocate and then 
drag it to the application pool to which you want to allocate it. Click Yes 
on the confirmation message that appears. The media is allocated to 
the application pool.

• Right-click a piece of Scratch Pool media and then select Allocate 
Media to Application Pool from the shortcut menu that appears. The 
Allocate Media to Application Media Pools dialog box appears.

Figure 53.  Allocate Media to Application Media Pools Dialog Box 

2. From the Application Media Pools drop-down list, select the Application 
Pool to which you want to allocate media.

3. Highlight the media you want to assign (or “allocate”) to that Application 
Pool.

4. Click Allocate. The selected media pool appears to the right of the media 
in the Media list.
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Figure 54.  Allocate Media to Application Media Pools Dialog Box 

5. Repeat steps 2 through 4 for any remaining media you want to assign to 
any available Application Pool.

6. If you allocate media to an Application Pool incorrectly, highlight the media 
and click Deallocate.

7. When finished, click OK. In the tree view, the selected media is moved to 
the appropriate Application Pool(s). In Data Manager, the media appears 
under the Original media node for the extended drive.

■ Moving Media to the Scratch Pool
If you want to remove a piece of media from an Application Pool (ASM Data 
Manager extended drive), you can do so from either Data Manager or from 
MediaStor. Within Data Manager, you “deallocate” the media; within 
MediaStor, you move the media back to the Scratch Pool. For instructions on 
deallocating media in Data Manager, refer to the Managing Storage Media 
chapter of the ASM Data Manager System Guide.

To move media to the Scratch Pool:

1. You have the following choices:

• Select the piece of application pool media you want to move and then 
drag it to the Scratch Pool.

• Right-click the piece of Application Pool media that you want to move 
to the Scratch Pool, and then select Move Media to Scratch Pool from 
the shortcut menu that appears.

A warning message appears to remind you that once removed, the media 
will no longer be available to the application.
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Figure 55.  Move Media to Scratch Pool Warning Message 

2. Click Yes to remove the media from the Application Pool and place it in the 
Scratch Pool.

■ Viewing Media Properties
The properties command is always available for every piece of media in the 
MediaStor system, regardless of the current use, assignment, or status of the 
media. The Media Properties window consists of up to four tabs, including: 
General, Space, Location, and Statistics. The tabs that appear depend on the 
type of media and its status. For example, the Statistics tab does not appear 
for Blank media. 

To view media properties:

1. In the tree view of the Administrator, right-click the media whose properties 
you want to view, and then select Properties from the shortcut menu that 
appears, or press <F2>. The Media Properties dialog box appears.

Figure 56.  Media Properties Dialog Box 

2. View and modify the settings on each of the tabs as necessary. For more 
information, see the following sections:

• "The General Tab, " which follows

• “The Location Tab” on page 105
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• “The Space Tab” on page 106

• “The Statistics Tab” on page 107

3. As with most Properties functions in ASM, after making changes you have 
three options:

• To save changes and close the Properties dialog box, click OK.

• To save changes and keep the Properties dialog box open, click Apply.

• To discard all changes made since the Properties dialog box was 
opened (or since the Apply button was last used) and close the 
Properties dialog box, click Cancel.

The General Tab
The General tab of the Media Properties dialog box provides identifying 
information for the selected media. For all except foreign, blank, and 
unformatted media, you can use this tab to enter a brief description of the 
media. This description is then used for media reports.

To view the General tab:

• Click the General tab.

Figure 57.  Media Properties – General Tab 

The information on the tab is separated into three sections: Volume, Attributes, 
and Description. The following table describes each of the items appearing on 
the General tab:
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Note: For blank, foreign, unknown, unformatted, and corrupt media, the 
General tab displays “N/A” in the Name, Serial Number, and Label 
Time fields, and the Description field is not available for editing.

Media Serial Numbers
Because media can be taken from one ASM system and imported or placed in 
another, media name is not sufficient for tracking media. While not 
recommended, ASM does allow more than one piece of media with the same 
name. Therefore, ASM must use the serial number of media to track the 
media and the files migrated to the media. 

ASM can support more than one piece of media with the same name on an 
extended drive, provided they have different serial numbers. If ASM identifies 
two pieces of media with the same serial number, it classifies one as Duplicate 
and requires that it be reformatted (which gives the media a new serial 
number) before it can be used.

Media serial numbers provide a way to track all ASM media uniquely, 
irrespective of the ASM system in which they were formatted. The serial 
number is an eight-byte integer, represented as a hexadecimal string in the 
following format: XXXXXXXXYYYYYYYY. The serial number is broken down 
as follows:

Table 12.  Media Properties – General Tab Information

Item Description
Name Name assigned to the media when labeled.

Serial Number Serial number of the media. For more information, see 
"Media Serial Numbers, " which follows.

Label Time Date and time the media was labeled.

Status Current status of media (typically online or offline).

Class Current class of media, corresponding to the media’s listing 
in the media pool tree. For more information, see “Media 
Pools” on page 47.

Type The type of storage media.

File System The media’s file system.

Description An editable field where you can enter a media description 
to be used for media reports. The maximum number of 
characters that can be entered into the Description text box 
is 64.
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The Location Tab
The Location tab of the Media Properties dialog box provides information 
about the physical and logical location of the selected media. You can also 
enter an offline location for the media, which is used for mount requests and 
media reports. This location is also shown when a MEDIA NOT FOUND error 
appears.

To view the Location tab:

• Click on the Location tab.

Figure 58.  Media Properties – Location Tab 

The information on the tab is separated into three sections: Physical, 
Media Pool, and Offline Location. The following table describes each of 
the items appearing on the Location tab:

Table 13.  Serial Number Interpretation

Position Description
(XXXXXXXX) The serial number from the Windows system boot drive 

(usually drive C:). Windows assigns this number when 
the hard drive is formatted. This number is unique for all 
hard disks.

(YYYYYYYY) The encoded date/time that the media was labeled, 
expressed in seconds elapsed since midnight on January 
1, 1970.
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Note: For blank, foreign, unknown, unformatted, and corrupt media, the 
Location tab displays “N/A” for the Folder field, and the Offline Location 
text box is unavailable for editing. 

The Space Tab
The Space tab of the Media Properties dialog box provides statistical 
information on the physical and logical capacity of the media.

To view the Space tab:

• Click on the Space tab.

Figure 59.  Media Properties – Space Tab 

Table 14.  Media Properties – Location Tab Information

Item Description
Drive The drive in which the media is mounted.

Library The library in which the media is located, and the media’s 
location in the library (drive and/or shelf number).

Name The name of the media pool to which the media is 
assigned.

Application The name of the application using the media.

Offline Location Physical location where offline media are stored. Enter 
up to 32 characters in the text box (for example, Second 
Floor Storage Room, Shelf 25D).
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The information on the tab is separated into two sections: Physical 
Capacity and Logical Capacity. The following table describes each of the 
items appearing on the Space tab:

Note: For blank, foreign, unknown, unformatted, and corrupt media, the 
Space tab displays “N/A” for all fields in the Logical Capacity region of 
the tab. For unformatted media, the Space tab displays “N/A” for all 
fields in the Physical Capacity region. For blank, unknown, 
unformatted, and corrupt media, the Total Space is set to zero.

The Statistics Tab
The Statistics tab of the Media Properties dialog box provides statistics 
relating to mounts, file input and output, and errors for the selected media. 

Note: The Statistics tab does not appear for foreign, unformatted, blank, or 
corrupt media.

To view the Statistics tab:

• Click on the Statistics tab.

Table 15.  Media Properties – Space Tab Information

Item Description
Bytes per Sector Number of bytes written to the media per sector 

(determined by media)

Number of Sectors Total number of sectors on media

Total Space Total media space, in bytes

Sectors per 
Cluster

Number of sectors per cluster

Free Clusters Number of free clusters on the piece of media

Used Clusters Number of used clusters on the piece of media

Total Clusters Total number of clusters on the piece of media

Free Space Free space in bytes on the piece of media

Used Space Written space in bytes on the piece of media

Total Space Total space in bytes on the piece of media
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Figure 60.  Media Properties – Statistics Tab 

The information on the Statistics tab is separated into three sections: 
Mount Information, I/O Information, and Error Information. It also provides 
information on the date from which the statistics are calculated. The 
following table describes each of the items appearing on the Statistics tab:

Table 16.  Media Properties – Statistics Tab Items

Item Description
Mount Count Number of mounts per current session

Last Mount Time Time the media was last mounted

Read File Count Number of read requests during current session

Read Byte Count Number of bytes of files read during current session

Last Read Time Time the media was last read

Write File Count Number of write requests during current session

Write Byte Count Number of bytes of files written during current 
session

Last Write Time Time the media was last written

Media Errors Number of errors encountered per current session

Valid Since The date from which the statistics on this tab are 
calculated

Clear Statistics 
button

To clear the statistics and reset the date from which 
the statistics on this tab are calculated, click Clear 
Statistics.
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■ Deleting Media
Once you delete media from MediaStor, you can remove the media from the 
media device. If you do not remove the media from the hardware device, it 
reappears in the Scratch Pool the next time the device is inventoried (if the 
media is still present at that time). 

The hardware device must be set offline before media in the device can be 
deleted. In addition, only Scratch Pool media can be deleted from MediaStor.

To delete media from media pools:

1. Move the media you want to delete to the Scratch Pool. For instructions, 
see “Moving Media to the Scratch Pool” on page 101.

2. Make sure the hardware device where the media is located is offline. For 
instructions, see one of the following sections:

• “Setting a Library Offline” on page 79

• “Setting a Tower Offline” on page 88

• “Setting a Standalone Drive Offline” on page 97

3. You have the following choices:

• Select the media you want to delete. From the Edit menu, select 
Delete.

• Select the media you want to delete. Press the DELETE key.

• Right-click the media you want to delete and then select Delete from 
the shortcut menu that appears.

A confirmation message appears.

4. Click Yes. You can now remove the media from the hardware device.

5. Set the hardware device back online. For instructions, see one of the 
following sections:

• “Setting a Library Online” on page 79

• “Setting a Tower Online” on page 88

• “Setting a Standalone Drive Online” on page 97

Note: If you do not remove the deleted media from the hardware device, you 
can set the device online without inventorying the media and the 
deleted media will not appear. Deleted media still resident in the device 
reappears in MediaStor the next time the device is inventoried.
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7Managing the MediaStor 
Computer

ASM MediaStor contains several functions that allow you to administer, 
diagnose, and troubleshoot MediaStor. In addition, because the MediaStor 
program functions as a Windows NT/2000 service, part of administering the 
MediaStor computer includes administering the MediaStor service. This 
chapter discusses the available tools for administering your MediaStor 
computer through the Administrator interface (and through Windows where 
applicable). 

The Service Properties dialog box lets you view and manage MediaStor 
computer configuration, including general information about the MediaStor 
installation.

Troubleshooting can be done using the diagnostic utilities in the Tools menu 
and the Service menu. You can look up error definitions in the Administrator 
using the Error Glossary feature. Information on each of these utilities is 
provided in this chapter. 

For more information, see the following sections:

• "Managing the MediaStor Service, " which follows

• “Configuring MediaStor Service Properties” on page 120

• “Tracking MediaStor Events, Errors, and Warnings” on page 127

■ Managing the MediaStor Service
MediaStor functions as a Windows NT/2000 service rather than as a user-
mode application. As a Windows service, MediaStor can be configured for 
various startup settings, including automatic startup, which starts MediaStor 
upon Windows system startup, and manual startup, which allows you to start 
the service manually. You can also disable the service, which prevents the 
service from starting until that status is changed to either manual or automatic. 

As a Windows NT/2000 service, MediaStor can continue to be active even 
after you close the Administrator and log off Windows, as long as the 
computer is still running.

Since the service will continue to run as long as the computer is running, if you 
are planning to shut down the MediaStor computer, we highly recommend 
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stopping the MediaStor service before doing so. This allows the service to 
complete whatever function it was performing before the system shuts down. 
In the case where ASM is writing a file to media, stopping the service before 
shutting down the computer reduces the possibility of file write and/or media 
errors occurring during shutdown. 

You can manage the service either through the Administrator or through 
Windows. 

Note: If MediaStor is installed in a clustered environment, the MediaStor 
service should only be stopped, paused, or started using the Cluster 
Administrator. You should not manage services through either the 
Service Manager or the Windows Services feature. If you stop the 
service in the Administrator or through the Windows Services feature, 
the system detects that the service failed and fails over to the other 
node in the cluster. For more information on clustering, see Appendix 
A: Clustering of the ASM Data Manager Getting Started Guide.

For more information, see the following sections:

• "Managing the Service Using the Administrator, " which follows

• “Managing the Service Using the Windows NT Control Panel” on page 115

• “Managing the Service Using the Windows 2000 Administrative Tools” on 
page 117

Managing the Service Using the Administrator
Management of the MediaStor service can be performed through the 
Administrator using the Service Manager. You can start, pause, and stop the 
service, as well as change the startup type and the account MediaStor uses to 
log on as a service.

You can manage the MediaStor service on more than one computer if the 
computers are registered in the Administrator even if the computer is not 
currently connected through the Administrator. MediaStor computers that are 
not connected are listed in the tree view with a status of (Disconnected). 
For more information on registering remote MediaStor computers, see 
“Registering a Computer for Remote Administration” on page 163.

To manage the service through the Administrator:

1. In the Administrator, select the computer for which you want to manage 
the MediaStor service by choosing the computer from the Computer drop-
down list or by selecting the extended drive of the computer whose service 
you want to manage.

2. Open the Service Manager. From the Tools menu, select Service 
Manager, or click the Service Manager toolbar button.
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Figure 61.  Service Manager Toolbar Button 

The Service Manager dialog box appears.

Figure 62.  Service Manager Dialog Box 

The Service Manager indicates the status of the MediaStor service just 
below the traffic light signal in the center of the Service Manager dialog 
box. A green light indicates the service is started, a yellow light indicates 
the service is paused, and a red light indicates the service is stopped. 
Stopping the service suspends all user and application access to the 
hardware devices and the media in those devices. 

3. Configure the service settings as necessary. You have the following 
choices:

• To stop the service, double-click Stop. A confirmation message 
appears. Click Yes.

• To pause the service, double-click Pause. A confirmation message 
appears. Click Yes.

• To start the service, double-click Start. A confirmation message 
appears. Click Yes.

• To edit service settings, including the startup type and the account 
MediaStor uses to log on as a service, click Edit Service Settings. For 
more information, see "Configuring Service Settings in the 
Administrator, " which follows.

4. When you finish configuring service settings, click Close to return to the 
Administrator. 

Configuring Service Settings in the Administrator
The MediaStor service, like any Windows NT/2000 service, can be set to start 
in a number of ways. For example, you may want the service to start 
immediately upon system startup, or you may want the ability to manually start 
or even disable the service. 
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You may also need to change the user name or password for the account that 
MediaStor uses to log on as a service. 

Note: If you change the account that MediaStor uses to log on as a service, 
be sure the new account you are using has the Log on as a service 
privilege. 

To edit service settings through the Service Manager:

1. In the Service Manager dialog box, click Edit Service Settings. The Edit 
Service Settings dialog box appears.

Figure 63.  Edit Service Settings Dialog Box 

2. Select a startup type. You have the following choices:

• Choose Automatic if you want the service to start every time the 
Windows system starts. This is the default.

• Choose Manual if you want the service to be started by a user or by a 
dependent service.

• Choose Disabled to prevent the service from starting until the startup 
type is changed to Automatic or Manual.

3. In the Log On As section, This Account option is enabled by default and 
should contain the login and password entered on installation of MediaStor 
on the computer. You have the following choices:

• To change the domain name or user name MediaStor uses to log on, 
enter the new name(s) in the This Account text box.

• To change the password MediaStor uses to log on, enter the new 
password in the Password text box. Then re-enter the password in the 
Confirm Password text box.

• To have the service log in as the system account, enable System 
Account.
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Note: Unless you have specific reason to do so, you should not enable 
the System Account option for logon. The local system account 
may not have all of the rights necessary to perform all MediaStor 
functions, particularly if Data Manager resides on a different 
machine.

4. Click OK to save your changes and return to the Service Manager. 

Managing the Service Using the Windows NT Control Panel
The Control Panel in Windows NT allows you to modify the service while 
working in Windows. The Services option in the Control Panel allows you to 
start and stop Windows NT services as well as configure service parameters 
for services running on the local machine, including the MediaStor service.

To manage the service using Windows NT:

1. On the MediaStor computer, open the Windows Service Manager. From 
the Start menu, select Control Panel and then Services. 

Figure 64.  Windows NT Services Dialog Box 

2. From the services list, select StorageTek MediaStor.

3. You have the following choices:

• To stop the service, click Stop. A confirmation message appears. Click 
Yes.

• To start the service, click Start.

• To pause the service, click Pause. A confirmation message appears. 
Click Yes.

• To edit service settings, including the startup type and the account 
MediaStor uses to log on as a service, click Startup. For more 
information, see "Configuring Service Settings in Windows NT, " which 
follows.

4. When you finish configuring service settings, click Close to close the 
Services dialog box.
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Configuring Service Settings in Windows NT
The MediaStor service, like any Windows NT service, can be accessed and 
edited through the Services option in the Windows NT Control Panel. You can 
change the startup options for the service, to set the service to start 
immediately upon system startup, or to be started manually. There is also an 
option to disable the service. 

You can also change the user name and/or password for the account that 
MediaStor uses to log on as a service.

Note: If you change the account that MediaStor uses to log on as a service, 
be sure the new account you are using has the Log on as a service 
privilege. 

To edit service settings through Windows NT:

1. In the Services dialog box, select StorageTek MediaStor and then click 
Startup. The Service dialog box appears.

Figure 65.  Service Dialog Box 

2. Select a startup type. You have the following choices:

• Choose Automatic if you want the service to start every time the 
Windows system starts. This is the default.

• Choose Manual if you want the service to be started by a user or by a 
dependent service.

• Choose Disabled to prevent the service from starting until the startup 
type is changed to Automatic or Manual.

3. In the Log On As section, the This Account option is enabled by default 
and should contain the login and password entered on installation of 
MediaStor on the computer. You have the following choices:

• To change the domain name or user name MediaStor uses to log on, 
enter the new name(s) in the This Account text box.
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• To change the password MediaStor uses to log on, enter the new 
password in the Password text box. Then re-enter the password in the 
Confirm Password text box.

• To have the service log in as the system account, enable System 
Account.

Note: Unless you have specific reason to do so, you should not enable 
the System Account option for logon. The local system account 
may not have all of the rights necessary to perform all MediaStor 
functions, particularly if Data Manager resides on a different 
machine.

4. When you finish configuring service settings, click OK to save your 
changes and return to the Services dialog box.

Managing the Service Using the Windows 2000 
Administrative Tools

The Administrative Tools application in Windows 2000 allows you to modify 
the system while working in Windows. The Services and Applications option in 
the Administrative Tools allow you to start and stop Windows 2000 services as 
well as configure service parameters for services running on the local 
machine, including the MediaStor service.

To manage the service using Windows 2000:

1. On the MediaStor computer, open the Windows Service Manager. From 
the Start menu, select Programs, Administrative Tools, and then Services. 
The Services dialog box appears.

Figure 66.  Windows 2000 Services Dialog Box 

2. From the services list in the right pane of the Services dialog box, select 
StorageTek MediaStor.
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3. You have the following choices:

• To stop the service, click the Stop button or choose Stop from the 
Action menu.

• To start the service, click the Start button or choose Start from the 
Action menu.

• To pause the service, click the Pause button or choose Pause from the 
Action menu.

• To stop and then restart the service in one step, click the Restart button 
or choose Restart from the Action menu.

• To edit service settings, including the startup type and the account 
MediaStor uses to log on as a service, double-click on the service to 
open the StorageTek MediaStor Properties dialog box. For more 
information, see "Configuring Service Settings in Windows 2000, " 
which follows.

4. When you finish configuring service settings, click the Close button to 
close the Services dialog box.

Configuring Service Settings in Windows 2000 
The MediaStor service, like any Windows 2000 service, can be accessed and 
edited through the Services and Applications option in the Windows 2000 
Administrative Tools. You can change the startup options for the service, to set 
the service to start immediately upon system startup, or to be started 
manually. There is also an option to disable the service. 

You may also need to change the user name or password for the account that 
MediaStor uses to log on as a service.

Note: If you change the account that MediaStor uses to log on as a service, 
be sure the new account you are using has the Log on as a service 
privilege. 

To edit service settings through Windows 2000:

1. In the services list of the Services dialog box, double-click StorageTek 
MediaStor. The StorageTek MediaStor Properties dialog box appears with 
the General tab active by default.
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Figure 67.  StorageTek MediaStor Properties Dialog Box 

2. From the Startup type drop-down list, select a startup type. You have the 
following choices:

• Choose Automatic if you want the service to start every time the 
Windows system starts. This is the default.

• Choose Manual if you want the service to be started by a user or by a 
dependent service.

• Choose Disabled to prevent the service from starting until the startup 
type is changed to Automatic or Manual.

3. Select the Log On tab. 



Managing the MediaStor Computer

120 Second Edition
StorageTek Proprietary

Figure 68.  StorageTek MediaStor Properties Dialog Box – Log On Tab 

4. The This account option is enabled by default and should contain the login 
and password entered on installation of MediaStor on the computer. You 
have the following choices:

• To change the domain name or user name MediaStor uses to log on as 
a service, enter the new name(s) in the This account text box.

• To change the password MediaStor uses to log on, enter the new 
password in the Password text box. Then re-enter the password in the 
Confirm password text box.

• To have the service log in as the system account, enable Local System 
account.

Note: Unless you have specific reason to do so, you should not enable 
the System Account option for logon. The local system account 
may not have all of the rights necessary to perform all MediaStor 
functions, particularly if Data Manager resides on a different 
machine.

5. When you finish configuring service settings, click OK to save your 
changes and return to the Services dialog box.

■ Configuring MediaStor Service Properties
MediaStor allows you to view and configure MediaStor service properties. 
Each MediaStor computer has a Service Properties dialog box that displays 
tabs of information pertaining to the MediaStor service. These tabs include: 
General, Alerts, and Licensing Information. 
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To configure MediaStor service properties:

1. From the Service menu, select Properties. 

Figure 69.  Service Properties Dialog Box 

2. Modify and view the settings on each of the tabs as necessary. For more 
information, see the following sections:

• "The General Tab, " which follows

• “The Alerts Tab” on page 122

• “The Licensing Information Tab” on page 126

3. As with most Properties functions in ASM, after making changes you have 
three options:

• To save changes and close the Properties dialog box, click OK.

• To save changes and keep the Properties dialog box open, click Apply.

• To discard all changes made since the Properties dialog box was 
opened (or since the Apply button was last used) and close the 
Properties dialog box, click Cancel.

The General Tab
The General tab displays identifying information for the MediaStor computer.

To view the General tab:

• Click the General tab in the Service Properties dialog box.
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Figure 70.  Service Properties – General Tab 

The following table describes each of the items appearing on the General 
tab.

The Alerts Tab
The Alerts tab of the Service Properties dialog box allows you to configure 
MediaStor to send alerts to specific users, workstations, email addresses, or 
domains. An alert is a message box that appears to notify the recipient of an 
error or warning on the MediaStor system. 

Figure 71.  Alert Message 

Alerts can be sent to a specific computer or user, to an entire domain, or to an 
email address.

Table 17.  Service Properties – General Tab

Item Description
Computer Name The Windows computer name for the MediaStor 

computer

Installation Date The date that MediaStor was installed (or updated)

Version The installed version of MediaStor
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A default alert for both warnings and errors is created for the MediaStor 
computer when MediaStor is installed.

To configure alerts:

1. Click the Alerts tab on the Service Properties dialog box.

Figure 72.  Service Properties – Alerts Tab 

2. You have the following choices:

• Add an alert. For more information, see "Adding an Alert, " which 
follows.

• Edit an existing alert. For more information, see “Editing an Alert” on 
page 125.

• Delete an alert. For more information, see “Deleting an Alert” on 
page 125.

3. If you configured any email alerts, enter the name of the mail server being 
used to deliver the alerts in the Mail Server text box at the bottom of the 
Alerts tab. The well-known port for SMTP servers is supported, so no 
additional configuration should be required for use with mail servers, 
routers, or firewalls.

Note: An email client must be installed and configured on the MediaStor 
computer on which you are configuring the alert in order for email 
alerts to work.

Adding an Alert
To send alerts to specific users, workstations, email addresses, or domains, 
you need to add an alert from the Alerts tab of the Service Properties dialog 
box.
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To add an alert:

1. On the Alerts tab of the Service Properties dialog box, click Add. The Alert 
Settings dialog box appears. 

Figure 73.  Alert Settings Dialog Box – Adding an Alert 

2. From the Type drop-down list box, select the type of alert that you would 
like to configure. You have the following choices:

• Computer

• Domain

• E-Mail

• User

3. In the Send To text box, enter the email address, domain name, user 
name, or computer name to which you want alerts sent. 

4. Below the Send To box you may configure the following options:

• If you want the alert to be sent for warnings and errors, enable both the 
Notify warnings and Notify errors check boxes.

• If you want an alert to be sent for warnings but not for errors, enable 
the Notify warnings check box.

• If you want an alert to be sent for errors but not warnings, enable the 
Notify errors check box.

• If you want to temporarily disable the alert, disable both the Notify 
warnings and Notify errors check boxes. You can enable either of 
these options at a later time.

5. When you are finished choosing the alert settings, click Add. The 
information in the Send To box disappears, and the recipient is added to 
the alerts listing. 

6. You have the following choices:

• Repeat steps 2 through 5 to add another alert. 

• If you are finished configuring alerts, click Close on the Alert Settings 
dialog box. The alert appears in the Alert list in the Alerts tab.
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Editing an Alert
Once Alerts have been established, you can edit them.

To edit an alert:

1. On the Alerts tab of the Service Properties dialog box, select the alert you 
want to edit and then click Edit. The Alert Settings dialog box appears.

Figure 74.  Alert Settings Dialog Box -- Editing an Alert 

2. You have the following choices:

• To change the type of alert that is sent, select a type from the Type 
drop-down list box.

• To change the email address, domain name, user name, or computer 
name to which you want alerts sent, enter the new value in the Send 
To text box.

• To change whether warnings are sent as alerts, enable or disable the 
Notify warnings check box.

• To change whether errors are sent as alerts, enable or disable the 
Notify errors check box.

• To temporarily disable the alert for the recipient, disable both the Notify 
warnings and Notify errors check boxes. You can enable either of 
these options at a later time.

3. When you finish editing the alert, click OK. The edited alert appears in the 
Alert list in the Alerts tab.

Deleting an Alert
If you no longer need an alert, you can delete it.

To delete an alert:

1. On the Alerts tab of the Service Properties dialog box, select the alert you 
want to delete and then click Delete. A confirmation message appears.

2. Click Yes.
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The Licensing Information Tab
The Licensing Information tab of the Service Properties dialog box displays 
license information for the MediaStor computer. 

To view the Licensing Information tab:

• Click the Licensing Information tab in the Service Properties dialog box.

Figure 75.  Service Properties – Licensing Information Tab 

The following table describes each of the items appearing on the Licensing 
Information tab. 

Table 18.  Service Properties – Licensing Information Tab

Item Description
Licensee The user information entered during the MediaStor 

installation.

Company The company information entered during the 
MediaStor installation.

License Server The name of the computer containing the installation of 
License Server that is currently administering the 
MediaStor licenses for this MediaStor service.

Licensing Details Detailed description of the Data Manager and 
MediaStor licenses configured in the License Server. 
This includes the number of Data Manager licenses, 
the number of MediaStor licenses, and type and file 
size capacity of the media services available for use 
with Data Manager, including the hardware licensed 
for MediaStor.



Tracking MediaStor Events, Errors, and Warnings

ASM MediaStor System Guide 127
StorageTek Proprietary

■ Tracking MediaStor Events, Errors, and Warnings
MediaStor has built-in utilities for monitoring events, errors, and warnings 
within the system. The Event Viewer contains a listing of all MediaStor events, 
errors, and warnings. This information is also logged to event logs. Errors and 
warnings are logged automatically, while MediaStor must be configured to log 
other events.

The Event Viewer and event logs provide a quick look at the activities of 
MediaStor. Logs can help identify and solve potential problems during runtime 
that might otherwise become critical problems if ignored. You can also look up 
errors you find in the logs, and configure event logging. If the Event Viewer 
and event logs become large and cumbersome to navigate, you can clear 
them.

For more information, see the following sections:

• "Using the Event Viewer, " which follows

• “Using Event Logs” on page 128

• “Looking up Errors” on page 129

• “Configuring Event Logging” on page 130

• “Clearing the Event Viewer and Event Logs” on page 133

Using the Event Viewer
The Event Viewer displays all events for the MediaStor service. If you do not 
want to automatically save a record of the events on your MediaStor computer, 
you can disable event logging in the Service Event Configuration dialog box 
and simply monitor events in the Event Viewer. For more information on 
disabling event logging, see “Configuring Event Logging” on page 130.

You can also take a “snapshot” of the contents of the Event Viewer and save it 
for later use. A snapshot is a capture of up to the last 2048 lines of the Event 
Viewer.

To open the Event Viewer:

• From the Service menu, select Event Viewer.

To take a snapshot of the Event Viewer:

• From the File menu in the Event Viewer, select Snapshot. The snapshot 
appears in RtfPad. You can save, print, and email the snapshot from 
RtfPad. For more information, see “Using RtfPad” on page 217.
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Using Event Logs
In addition to the viewing capabilities offered by the Event Viewer, MediaStor 
also contains three event logs that save events, errors, and warnings for the 
MediaStor computer to log files.

• The All Events log lists all activities on the MediaStor service. Event 
logging is useful for tracing events of interest to you. You can configure 
which events are traced.

• The Errors Only Log lists only MediaStor system errors and is a useful tool 
for detecting and diagnosing those errors. 

Note: You can use the System Error Lookup feature to obtain additional 
information about each error, including the error’s name and 
description, and to quickly translate error codes that appear in 
MediaStor. For more information, see “Looking up Errors” on 
page 129.

• The Warnings Only Log lists only MediaStor system warnings to warn you 
of possible problems in MediaStor, such as requests for media that could 
not be satisfied because the media was not present on the ASM system 
(not in any drive or library). The purpose of this list is to provide a simpler 
means of discovering where problems exist that are hindering MediaStor 
performance.

Errors and warnings also appear in the Event Viewer, but the Errors Only Log 
and Warnings Only Log provide a more precise focus on these important 
events. You can also configure errors and warnings to be sent out as alerts to 
a specific domain, user, computer, or email address so that you are 
automatically notified when they occur. For more information, see “The Alerts 
Tab” on page 122.

Because they are necessary for system diagnostics, error and warning logging 
cannot be disabled. If technical support is needed, you may be asked to open 
these logs and specify the information reported.

When opened, the logs slow down MediaStor performance. When closed, the 
impact they have on performance is insignificant. The logs should be opened 
and used only for debugging purposes.

Note: Because tracing events impedes system performance, no events are 
traced by default, though errors and warnings are logged automatically 
because of their necessity for troubleshooting. For more information, 
see “Configuring Event Logging” on page 130.

To open a log:

1. From the Service menu, select Event Logs. A shortcut menu appears.

2. Select the log you want to view. You have the following choices:
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• All Events

• Warnings Only

• Errors Only

The selected log appears in RtfPad. The log displays both the time and a 
message for each event. The most recent events are last on the list (the 
list automatically scrolls to display the most current events).

3. You can save, print, and email the log from RtfPad. For more information, 
see “Using RtfPad” on page 217.

4. When you finish, open the File menu in RtfPad and then select Exit to 
close the log.

Looking up Errors
Each MediaStor error is displayed as an error number. The MediaStor error 
lookup feature allows you to obtain additional information about the error, 
including the error name and description, and to quickly translate the error 
codes provided in MediaStor messages. 

To look up an error:

1. You have the following choices:

• In the Administrator window, open the Help menu and then select Error 
Glossary. The System Error Lookup dialog box appears. Enter the 
error number in the Error Number text box and click Look Up.

• Press <CTRL>+E. The System Error Lookup dialog box appears. 
Enter the error number in the Error Number text box and click Look Up.

• Highlight the error code number in the event log and then select Error 
Lookup from the View menu in RtfPad.

• Highlight the error code number in the event log and then press F2.

The error string (if applicable) and its description are displayed in the 
System Error Lookup dialog box.
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Figure 76.  System Error Lookup Dialog Box 

2. You have the following choices:

• Click the forward or backward arrow buttons to scroll through the list of 
system errors. 

• When you finish, click Close to exit the dialog box.

Configuring Event Logging
Event logging is necessary only when tracing events of interest to you. You 
can configure which events are traced. Because tracing events impedes 
system performance, no events are traced by default, though errors and 
warnings are logged automatically because of their necessity for 
troubleshooting.

MediaStor allows you to configure which events are logged, and whether to 
trace the local service events or remote procedure calls (remote 
administration events). 

For all logs, you can control the format of the log entries, and adjust the 
maximum sizes for the log files. For the All Events Log, you can disable 
logging and enable the tracing of events upon startup. You can enable logging 
to the Windows Application Log for the Warnings Only Log and the Errors Only 
Log.

For more information, see the following sections:

• "Log Properties Configuration, " which follows

• “Event Tracing Configuration” on page 132

Log Properties Configuration
You can control several aspects of logging functionality, including log entry 
format, log file size, event logging, automatic startup of event logging, and 
logging of errors and warnings to the Windows Application Log. 
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To configure log properties:

1. From the Service menu, select Event Settings. The Service Event 
Configuration dialog box appears. The Configuration tab is active by 
default.

Figure 77.  Service Event Configuration Dialog Box – Configuration Tab 

2. In the Line Format section, specify logging of particular event attributes. 
These options are enabled by default. You have the following choices:

• To disable logging the time each event occurs, disable the Time check 
box.

• To disable logging the date each event occurs, disable the Date check 
box.

• To disable logging the thread the event used to communicate with the 
processor, disable the Thread ID check box.

3. In the Event Log section, configure logging to the All Events Log. Event 
logging is enabled by default; however, no events are traced. For 
information on selecting events to trace, see "Event Tracing Configuration, 
" which follows. You have the following choices to configure event logging:

• To change the maximum size in megabytes (MB) for the log file, enter 
a new value in the Maximum Log Size text box. The default size is 5 
MB. After the maximum log size is reached, the log is truncated from 
the beginning of the file (oldest events).

• To disable logging to the All Events Log, enable the Disable log file 
(viewer only) check box. Events are still logged to the Event Viewer.
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• To automatically initiate event logging when MediaStor is started, 
enable the Trace messages on startup check box.

4. In the Warning Log section, configure logging to the Warnings Only Log. 
You have the following choices:

• To change the maximum size in MB for the log file, enter a new value 
in the Maximum Log Size text box. The default size is 5 MB. After the 
maximum log size is reached, the log is truncated from the beginning 
of the file (oldest events).

• To enable logging of MediaStor warnings to the Windows Application 
Log, enable the Write to Windows Application Log check box. Since 
MediaStor warning logs are cleared when the service is restarted, 
enabling this option allows the Windows Application Log to maintain a 
running log of MediaStor warnings regardless of whether the service is 
running. 

Note: To access the Windows Application Log, open the Start menu. 
Then select Programs, Administrative Tools, and Event Viewer. 

Note: You cannot disable logging to the Warnings Only Log and Errors 
Only Log.

5. In the Error Log section, configure logging to the Errors Only Log. You 
have the following choices:

• To change the maximum size in MB for the log file, enter a new value 
in the Maximum Log Size text box. The default size is 5 MB. After the 
maximum log size is reached, the log is truncated from the beginning 
of the file (oldest events).

• To enable logging of MediaStor errors to the Windows Application Log, 
enable the Write to Windows Application Log check box.

6. You have the following choices:

• If you want to begin tracing events, click Apply to save your changes 
and then select the Trace tab to configure which events should be 
traced. For more information on tracing events, see "Event Tracing 
Configuration, " which follows.

• If you are finished configuring log properties, click OK to save your 
changes and close the Service Event Configuration dialog box.

Event Tracing Configuration
You can configure which events are to be traced and reported to the Event 
Viewer and the All Events Log. By default, all event tracing is disabled. Unless 
instructed to enable tracing of events by a technical support representative, 
you can leave the default settings in place. 
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Note: Event tracing configuration affects events only; errors and warnings 
relating to events of the types listed are logged regardless of event 
tracing settings. 

Note: Enabling event tracing hinders performance and should be performed 
only when debugging is required. 

To configure events to be logged:

1. From the Service menu, select Event Settings. The Service Event 
Configuration dialog box appears. 

2. Click the Trace tab. The System drop-down list displays System 
Processing by default.

Figure 78.  Service Event Configuration – Trace Tab 

3. From the System drop-down list, select whether to trace System 
Processing (local machine service events) or Remote Procedure Calls 
(remote administration service events). 

4. In the Options list, enable the check box next to an event to begin tracing 
that event.

5. When you are finished, click OK to save the new settings and close the 
Service Event Configuration dialog box. 

Clearing the Event Viewer and Event Logs
You can manually clear the information in the Event Viewer and the event 
logs. Event logs have a specific size limitation, after which the log is truncated 
from the beginning of the file. While the log size is regulated through automatic 
truncation (see “Configuring Event Logging” on page 130 for more 
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information), large logs are often cumbersome and difficult to navigate. 
Clearing event logs regularly makes it easier to find new information.

Note: You may want to save your log before clearing it. To save a log, open it 
and then select Save from the File menu in RtfPad.

To clear the Event Viewer or an event log:

1. From the Service menu, select Event Logs. A shortcut menu appears.

2. You have the following choices:

• To clear the Event Viewer and the All Events Log, select Clear Event 
Log.

• To clear the Warnings Only Log, select Clear Warning Log.

• To clear the Errors Only Log, select Clear Error Log. 

3. Click Yes on the confirmation message that appears.
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8Running MediaStor Reports

The ASM MediaStor reporting feature is a useful tool for tracking system 
statistics. Using the Report Wizard, you can create various reports of system 
activities, including media information, hardware configuration, and MediaStor 
registry settings.

You can run the following reports in MediaStor:

• The Media Report provides detailed information on the selected piece(s) 
of media. For more information, see “Media Report” on page 137.

• The Hardware Configuration Report provides detailed information on the 
hardware devices configured in MediaStor. For more information, see 
“Hardware Configuration Report” on page 139.

• The Product Registry Information Report lists all of the MediaStor 
information contained in the Windows registry for the selected MediaStor 
computer(s). For more information, see “Product Registry Information 
Report” on page 140.

You can also create custom layouts for your reports. Custom layouts are 
particularly useful because they can be saved and reused every time you run 
a report.

Since MediaStor is designed to allow you to manage multiple registered 
MediaStor computers from a single Administrator interface, you can run any 
one of the available reports on multiple computers. You can also run more 
than one report at a time, allowing you to view several different aspects or 
details about several different registered MediaStor computers in one 
consolidated report.

For more information, see the following sections:

• "Creating Reports, " which follows

• “Report Layout Editor” on page 141

■ Creating Reports
The Report Wizard allows you to create various reports of system activities on 
one or more registered MediaStor computers, including information about 
each of its components and media. It also allows you to run more than one 
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report at a time so that you can view several different aspects or details about 
several different registered MediaStor computers in one consolidated report.

To open the Report Wizard:

1. From the Tools menu, select Report Generator. The Report Wizard opens, 
starting with the Select Report(s) To Run page.

Figure 79.  Report Wizard – Select Report(s) To Run Page 

The Select Report(s) To Run page lists all available MediaStor reports. A 
description of the report appears as a pop-up text box when you rest the 
mouse pointer on any report option.

2. Select the appropriate report type(s).

Note: If you choose multiple reports to run, the appropriate Report 
Wizard pages for each report are merged to form one wizard to 
lead you through the report generation process.

3. Click Next. The Select Computer(s) page appears.
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Figure 80.  Report Wizard – Select Computer(s) Page 

The Select Computer(s) page lists all registered and connected MediaStor 
computers.

4. Select the MediaStor computer(s) for which you want to generate a report 
and then click Next. The next page of the Report Wizard for the selected 
report(s) appears. For more information, see the following sections:

• "Media Report, " which follows

• “Hardware Configuration Report” on page 139

• “Product Registry Information Report” on page 140

Media Report
The Media Report includes information on the selected media, either as a 
summarized list or a detailed description of properties. Information displayed 
in the detailed report includes location information, file system, total/free 
space, and read/write/mount statistics. 

To run a Media Report:

1. After you select the MediaStor computer(s) for which you want to generate 
a report and then click Next, the Select Media page appears.
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Figure 81.  Report Wizard – Select Media Page 

The Select Media for Media Report page lists all available media for which 
you can generate a report. It lists the MediaStor computer where the 
media is located and the name of the media.

2. From the Listed Media drop-down list, select one of the media types to 
narrow the number of media listed in the Media list and make it easier to 
find and choose media for the report.

3. From the Media Pool drop-down list, select a media pool. This also 
narrows the number of media listed in the Media list, and may make it 
easier to find and choose media for the report.

4. Select the media for which you want to generate the report and then click 
Next. The Options page appears.

Figure 82.  Report Wizard – Media Report Options Page 
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5. If there is more than one layout/computer listed, select the one you want to 
use for your report. To edit a selected layout, click Edit Layouts. For 
instructions, see “Report Layout Editor” on page 141.

6. Select the amount of detail you want on the report: Full or Summary.

7. Click Next. The Summary page appears. 

8. Review the information in the Summary page. 

9. If the information in the summary is correct, click Finish. The report 
appears in RtfPad. As with any information appearing in RtfPad, you can 
save, print, or email the report. For more information, see “Using RtfPad” 
on page 217.

Hardware Configuration Report
The Hardware Configuration Report provides detailed information on the 
hardware devices configured in MediaStor. This includes hardware properties 
and whether the device is automatically set online when the service starts. Full 
reports also display statistics for the media in each hardware device.

To run a Hardware Configuration Report:

1. After you select the MediaStor computer(s) for which you want to generate 
a report and then click Next, the Options page appears.

Figure 83.  Report Wizard – Hardware Configuration Report Options 
Page 

2. If there is more than one layout/computer listed, select the one you want to 
use for your report. To edit a selected layout, click Edit Layouts. For 
instructions, see “Report Layout Editor” on page 141.

3. Select the amount of detail you want on the report: Full or Summary.

4. Click Next. The Summary page appears. 
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5. Review the information in the Summary page. 

6. If the information in the summary is correct, click Finish. The report 
appears in RtfPad. As with any information appearing in RtfPad, you can 
save, print, or e-mail the report. For more information, see “Using RtfPad” 
on page 217.

Product Registry Information Report
The Product Registry Information Report provides a complete listing of all 
information contained in the Windows registry about the MediaStor service on 
the selected MediaStor computer(s). The report information includes a listing 
of all registry keys (and associated values) used by MediaStor.

To run a Product Registry Information Report:

1. After you select the MediaStor computer(s) for which you want to generate 
a report and then click Next, the Options page appears.

Figure 84.  Report Wizard – Product Registry Information Report Options 
Page 

2. If there is more than one layout/computer listed, select the one you want to 
use for your report. To edit a layout, select the layout from the list and click 
Edit Layouts. For instructions, see “Report Layout Editor” on page 141.

3. Select the amount of detail you want on the report: Full or Summary.

4. Click Next. The Summary page appears. 

5. Review the information in the Summary page. 

6. If the information in the summary is correct, click Finish. The report 
appears in RtfPad. As with any information appearing in RtfPad, you can 
save, print, or email the report. For more information, see “Using RtfPad” 
on page 217.
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■ Report Layout Editor
The Report Layout Editor allows you to define the font, font sizes, tab stops, 
and header and footer contents for MediaStor reports. The styles and layouts 
can be set and saved as report defaults; however, you can override these 
options whenever necessary.

MediaStor also allows you to create and save new layouts on different 
MediaStor computers. These layouts are available for use any time a report is 
run for that MediaStor computer, regardless of whether the report is being run 
from that MediaStor computer or from a remote MediaStor computer.

To customize report layouts: 

1. You have the following choices:

• If you are in the process of running a report and you want to edit an 
existing layout, select the layout on the Options page of the Report 
Generator Wizard and then click Edit Layouts.

• If you are in the process of running a report and you want to create a 
new layout, on the Options page of the Report Generator Wizard, click 
Edit Layouts.

• If you are not in the process of running a report, open the Tools menu 
and then select Report Layouts. 

The Report Layout Editor dialog box appears.

Figure 85.  Report Layout Editor 

2. You have the following choices:

• Create a new layout. For more information, see "Creating a New 
Layout, " which follows.

• Change the header or footer for a report layout. For more information, 
see “Changing Headers and Footers for Layouts” on page 142.
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• Edit layout styles. For more information, see “Editing Layout 
Paragraph Styles” on page 144.

• Rename a layout. For more information, see “Renaming a Layout” on 
page 146.

• Switch from one layout to another. For more information, see 
“Switching from One Layout to Another” on page 147.

• Preview a layout. For more information, see “Previewing a Layout” on 
page 147.

• Delete a layout. For more information, see “Deleting a Layout” on 
page 148.

Creating a New Layout
Creating a layout is as simple as giving it a name. When creating a layout, 
remember that each layout should be identified by a descriptive name to make 
the layout easy to identify for use with your reports. 

To create a new layout:

1. In the Report Layout Editor dialog box, click New. The Enter New Layout 
Name dialog box appears.

Figure 86.  Enter New Layout Name Dialog Box 

2. In the text box, type a name. Click OK. A new layout is created with that 
name and the default layout settings. To modify the default settings, see 
the following sections: 

• "Changing Headers and Footers for Layouts, " which follows

• “Editing Layout Paragraph Styles” on page 144

Changing Headers and Footers for Layouts
You can configure a customized header and footer for each report layout using 
the Report Layout Editor. 

The header and footer can contain dynamic codes that retrieve specific 
values, such as date, time, user name, and domain, and write them directly 
into the header or footer. Placing these dynamic codes in custom headers or 
footers, and thereby on the reports generated with a custom layout, can help 
you identify, file, and retrieve reports later.
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To change a header or footer for a layout:

1. Verify that the correct report appears in the Name drop-down list in the 
Report Layout Editor.

2. Click in either the Header Text box or the Footer Text box and type or edit 
the desired text. 

3. To insert a dynamic code in the text, place the cursor in the Text box where 
you want the code value to appear. If you do not want to insert a dynamic 
code in the text, skip to step 7.

4. Click Insert Code under the appropriate text box. The Select Report Code 
to Insert dialog box appears.

Figure 87.  Select Report Code To Insert 

5. Select the code that you want to insert. You have the following choices:

6. Click OK to insert the code and return to the Report Layout Editor dialog 
box.

Table 19.  Report Code Options

Option Description

User name Inserts the user name of the current 
Windows user

Network 
domain

Inserts the domain on which MediaStor is 
running

Date Inserts the system date the report is 
generated

Time Inserts the system time the report is 
generated

Report name Inserts the name given to the report when 
generated

Product version Inserts the MediaStor version generating the 
report
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Note: Spaces are not automatically inserted around the code. If you want 
spaces to appear before or after the value the code inserts, place 
spaces in the text box before and after the code where you want 
spaces to appear.

7. Choose whether to use a dotted line as a divider between the header or 
footer and the report body. You have the following options:

• If you do not want a dotted line to separate the header from the report 
body, disable the Use divider below header check box. This option is 
enabled by default.

• If you do not want a dotted line to separate the footer from the report 
body, disable the Use divider above footer check box. This option is 
also enabled by default.

8. You have the following choices:

• To preview the report layout, click Preview.

• To save changes and keep the Report Layout Editor dialog box open, 
click Update.

• To save changes and close the Report Layout Editor dialog box, click 
OK.

Editing Layout Paragraph Styles
The Report Layout Editor allows you to customize the look of your reports by 
giving you font, size, color, and other stylistic options for each type of 
paragraph used in generating report output. This makes it easier to call 
attention to specific information in the reports and may make your reports 
easier to read and interpret.

To edit styles for a layout:

1. Verify that the correct report appears in the Name drop-down list in the 
Report Layout Editor.

2. Click Edit Styles. The Report Layout - Styles dialog box appears. 
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Figure 88.  Report Layout - Styles Dialog Box 

Each paragraph type has a drop-down list containing all available style 
profiles. 

3. You have the following choices:

• To use an existing style profile, select the profile from the drop-down 
list next to the paragraph type you want to change.

• To create a new profile, click the Edit button to the right of profile drop-
down list. The Report Style Editor dialog box appears.

Figure 89.  Report Style Editor Dialog Box 

Select the desired characteristics for Font, Font Size, Text Color, and 
Alignment from the appropriate drop-down lists. 

Enable or disable the Underline and Bold characteristics for the paragraph 
by clicking in the check box next to each option. 

Click OK to save your changes to the paragraph style and return to the 
Report Layout - Styles dialog box. Your new style properties appear in the 
profile drop-down list.

4. Once you have configured all necessary styles, you can preview the report 
layout by selecting the Preview button on the Report Layout - Styles dialog 
box. A Report Layout Preview appears in RtfPad.
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Figure 90.  Report Layout Preview – Sample Report 

5. When you are satisfied with your layout styles, click OK to save changes 
and return to the Report Layout Editor dialog box.

Renaming a Layout
If necessary, you can rename an existing custom layout.

To rename a layout:

1. In the Report Layout Editor dialog box, make sure that the correct layout 
appears in the Name drop-down list.

2. Click Rename. The Enter New Layout Name dialog box appears.

Figure 91.  Enter New Layout Name Dialog Box 

3. In the text box, type the new name. 

4. Click OK. The new name appears in the Name text box in the Report 
Layout Editor dialog box.
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Switching from One Layout to Another
If you have created or made edits to a report layout and you want to create or 
edit another one, you should click Update to save your changes. If you select 
another layout from the Name drop-down list or click New without clicking the 
Update button, MediaStor prompts you to save unsaved changes to the 
current layout. 

Figure 92.  Save Changes? 

To save changes, click Yes. Or, to discard changes that you have made since 
the last time you clicked Update, click No.

Previewing a Layout
You can preview a report layout so that you know what the report will look like 
before you run it.

To preview a layout:

1. In the Report Layout Editor dialog box, make sure the correct layout 
appears in the Name drop-down list.

2. Click Preview. A Report Layout Preview appears in RtfPad.
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Figure 93.  Report Layout Preview – Sample Report 

3. When you finish, close the preview by selecting Exit from the RtfPad File 
menu.

Deleting a Layout
If you no longer need a custom report layout, you can delete it.

To delete a layout:

1. In the Report Layout Editor dialog box, make sure the layout you want to 
delete appears in the Name text box.

2. Click Delete. A confirmation message appears. 

3. Click Yes.
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9MediaStor Backup and 
Recovery

Because constant and reliable access to your data is one of the most critical 
parts o-f your system, we recommend that you have a comprehensive disaster 
recovery plan in place in the event of system problems or an entire system 
shutdown. ASM MediaStor contains a registry utility that can help you back up 
and restore the MediaStor configuration, even when the problem is a minor 
one. 

For more information, see the following sections:

• "Backing Up Your MediaStor System, " which follows

• “Restoring Your MediaStor System” on page 153

■ Backing Up Your MediaStor System
You can create a backup of your MediaStor system configuration, which is 
stored in registry settings, when needed using the repair disk utility. In the 
event of a MediaStor computer crash, you can then use the registry backup to 
restore the MediaStor configuration.

The repair disk utility can be used to create a backup copy of the registry 
information for the MediaStor system. MediaStor automatically updates the 
repair disk backup after the following actions: 

• Every 15 minutes 

• When the service starts or stops

• When hardware is added or deleted

• When hardware is inventoried

• When the repair disk backup location is changed (through the 
Administrator)

You can set the location where the repair disk is automatically saved, set a 
location for a copy of the repair disk for the current MediaStor configuration, or 
restore MediaStor registry settings using the Repair Disk Wizard. 

This section provides procedures for setting the backup location for your 
repair disk and for creating a copy of the repair disk backup. For more 
information, see the following sections:
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• "Setting the Repair Disk Backup Location, " which follows

• “Copying the Repair Disk Backup” on page 151

For information and instructions on restoring a repair disk file, see “Restoring 
MediaStor Configuration” on page 153.

Setting the Repair Disk Backup Location
The Repair Disk Wizard allows you to designate where MediaStor stores the 
repair disk backup it creates. In order to ensure fail-proof disaster recovery, 
the backup should be copied to a location separate from your Windows server 
files. Ideally, you should copy it to a different volume. 

Note: The repair disk backup should be backed up regularly to an additional 
location. Besides allowing for an additional backup of the repair disk 
file, this also allows for “versioning” of repair disk backup copies, in the 
event the last saved repair disk is corrupt or otherwise unusable for 
system restore.

To set the repair disk location:

1. From the Tools menu, select Repair Disk. The Repair Disk Wizard 
appears.

Figure 94.  Repair Disk Wizard – Introduction Page 

2. Choose Set the automatic repair disk location and then click Next. The 
Automatic Repair Disk Location page appears.
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Figure 95.  Repair Disk Wizard -- Automatic Repair Disk Location Page 

3. In the Location text box, enter the directory to which the repair disk backup 
should be saved. To browse to a directory, click Browse. You must use a 
UNC path.

4. Once you have entered a path in the Location text box, click Next. The 
Summary page appears.

5. Review the information in the summary.

6. If the information in the Summary is correct, click Finish to complete the 
wizard. A progress message appears, indicating that the auto disk repair 
location is being saved. Once the message disappears, the location 
setting is complete.

Copying the Repair Disk Backup
In addition to designating where the repair disk backup is stored, the Repair 
Disk Wizard also allows you to store a copy of the current repair disk at will. 
We highly recommend regularly creating a copy of the repair disk, in order to 
be sure you have a usable copy of your system configuration. In addition, 
because the normal repair disk is saved at a minimum of every 15 minutes, if 
some corruption took place before the new repair disk was saved, the primary 
copy of your repair disk file may be unusable for system restoration. 

When you use the Repair Disk Wizard to set a location for a copy of the 
current configuration, MediaStor creates a copy of the MediaStor configuration 
as soon as the wizard is completed. The copy is a one-time backup and does 
not update regularly. 

Note: Setting a location for a copy of the current configuration does not affect 
the location for automatic backup. MediaStor continues to back up 
MediaStor registry information to the location set for automatic repair 
disk creation. 
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To copy the current repair disk backup:

1. From the Tools menu, select Repair Disk. The Repair Disk Wizard 
appears.

Figure 96.  Repair Disk Wizard – Introduction Page 

2. Select Copy current repair disk information to another location and then 
click Next. The Copy Repair Disk Information page appears.

Figure 97.  Repair Disk Wizard -- Copy Repair Disk Information Page 

3. Enter a directory path and file name in the File Name text box. To browse 
to a directory and/or file, click Browse.

4. Once you have entered a path in the File Name text box, click Next. The 
Summary page appears.

5. Review the information in the summary.

6. If the information in the Summary is correct, click Finish to complete the 
wizard. A progress message appears, indicating that the copy disk repair 
location is being saved. Once the message disappears, the copy is 
complete.
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■ Restoring Your MediaStor System
In the event of catastrophic system failure, the same MediaStor utility that 
allows you to create backups of your registry settings also allows you to 
restore those backups to your MediaStor system. The restore function for the 
repair disk utility makes recovery and re-configuration of your system after a 
disaster both faster and more accurate.

This section provides information and procedures for restoring the registry 
configuration in the event you ever need to restore your MediaStor system 
after a disaster or catastrophic system failure.

When a system failure or disaster occurs, the following steps should be taken 
in order to most effectively restore your MediaStor system.

To restore your MediaStor system:

1. If necessary, reformat the MediaStor computer hard drive. 

2. Reinstall Windows NT/2000.

3. Reinstall MediaStor. For instructions, see “Installing MediaStor” on 
page 31.

4. Restore the repair disk (MediaStor registry) file. For instructions, see 
"Restoring MediaStor Configuration, " which follows.

These steps should be sufficient to get your MediaStor system back up and 
running after a disaster or system failure. As always, however, if you run into 
any problems, contact your technical support representative for assistance.

Restoring MediaStor Configuration
When a system failure or disaster occurs on your MediaStor computer, you 
can restore your MediaStor registry configuration by using the Repair Disk 
Wizard to restore the backup copy of the registry settings after you have 
reinstalled all of the necessary software components.

To restore the registry configuration:

1. From the Tools menu, select Repair Disk. The Repair Disk Wizard 
appears.
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Figure 98.  Repair Disk Wizard – Introduction Page 

2. Choose Restore service configuration from a repair disk and click Next. 
The Restore Repair Disk page appears.

Figure 99.  Repair Disk Wizard -- Restore Repair Disk Page 

3. Enter the directory path and file name for the repair disk file in the File 
Name text box. To browse for a file, click Browse.

4. Click Next. The Restore Repair Disk – Warning page appears.

Figure 100.  Repair Disk Wizard -- Restore Warning Page 

 



Restoring Your MediaStor System

ASM MediaStor System Guide 155
StorageTek Proprietary

5. Read the Restore Repair Disk – Warning page carefully.

6. When you finish, click Next. The Restore Repair Disk – Note page 
appears. 

Figure 101.  Repair Disk Wizard -- Restore Note Page 

This page provides a reminder that the current product configurations will 
be overwritten with the saved configuration from the specified repair disk 
location.

7. To continue, click Next. The Summary page appears.

8. Review the information in the summary carefully.

9. If the information in the Summary is correct, click Finish to complete the 
wizard. The registry information is copied, and the backup MediaStor 
configuration is restored to your machine. 

10. Restart the MediaStor computer. 

After restoring your MediaStor system, you may want to run one or more of the 
available MediaStor reports to make sure that your system has been returned 
to the appropriate state. For more information, see “Running MediaStor 
Reports” on page 135.
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10Remotely Administering 
MediaStor

You can administer the ASM MediaStor system both from the computer on 
which MediaStor is installed and from remote computers. You can use the 
Administrator function that comes with a full installation of MediaStor to 
administer other MediaStor computers, or you can install the Remote 
Administrator, which simply provides you with the Administrator interface and 
the registration capability to attach remotely to one or more networked 
MediaStor computers. The remote administration function is the same whether 
you use a MediaStor Administrator (full installation) or a Remote Administrator. 

The MediaStor computer(s) you plan to manage must be the same version or 
higher as the Administrator you are using (either a Remote Administrator, or a 
full MediaStor Administrator). For example, a MediaStor version 5.40.102 
installation can be remotely administered using a lower 5.4 version or another 
version 5.4.102 Administrator. However, a version 5.4.102 Administrator will 
not be able to connect to a lower version 5.4 MediaStor service; the lower 
version MediaStor Administrator will need to be upgraded. 

This chapter covers installation of the Remote Administrator, and briefly 
outlines procedures for starting the Remote Administrator for the first time. It 
also covers registering a MediaStor computer so that you can remotely 
administer it, and connecting to and disconnecting from MediaStor computers. 
For more information, see the following sections:

• "Before Installing the Remote Administrator, " which follows

• “Installing the Remote Administrator” on page 159

• “Starting the Remote Administrator the First Time” on page 163

• “Registering a Computer for Remote Administration” on page 163

• “Connecting to MediaStor Computers” on page 169

■ Before Installing the Remote Administrator
Before you install the Remote Administrator, you need to consider the 
following requirements:

• "Operating System Requirements, " which follows
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• “Windows NT/2000 Security” on page 158

• “Clustering” on page 158

Operating System Requirements
All ASM Remote Administrators, including the MediaStor Remote 
Administrator, can be installed and run on computers that use the following 
operating systems: 

• Windows NT 4.0 with Service Pack 6a, or 

• Windows 2000 with Service Pack 2 or 3 

• Windows XP

Consult your Windows documentation for information on installing the 
operating system.

Windows NT/2000 Security
Remote administration of MediaStor computers works through a Remote 
Procedure Call (RPC) connection that enables communication between a 
remote MediaStor Administrator and the MediaStor computer. Security for that 
connection is managed by managing membership of the MSAdministrators 
group on the MediaStor computer. To administer the MediaStor system 
through a remote installation of the MediaStor Administrator, you must be a 
member of the MSAdministrators group. For more information, see “Windows 
NT/2000 Security” on page 22.

In addition, for your convenience, the Remote Administrator setup wizard 
allows you to install the Remote Administrator on multiple computers at once, 
provided those computers are visible on your network and you have 
Administrator privileges on those computers. To take advantage of this 
feature, you may want to determine which computers are to have the Remote 
Administrator installed on them and make sure you have administrative 
privileges on those machines before you run the setup wizard. This will enable 
you to run the installation only once rather than multiple times.

Clustering
If you choose to install the Remote Administrator in a clustered environment, 
install the program on the Primary server. Once the installation is replicated to 
the Secondary server, register each computer you want to remotely administer 
on both the Primary server and the Secondary server. For more information on 
Clustering, see Appendix A: Clustering of the ASM Data Manager Getting 
Started Guide. 
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■ Installing the Remote Administrator 
For Remote Administrator workstations connecting to a MediaStor computer, a 
full MediaStor setup is not necessary. Connecting workstations need access to 
the Administrator only. A Remote Administrator installation sets up the 
Administrator interface as well as online help on the computer.

To install the Remote Administrator:

1. Exit all applications on the computer(s) on which you want to install the 
Remote Administrator. The Remote Administrator setup wizard may not be 
able to write to all necessary files if other software is running.

2. Insert the ASM installation CD-ROM into the drive. 

3. From the Start menu, select Run. The Run dialog box appears.

4. You can either browse to the following file or type the path in the Open text 
box:

D:\DX2000.XXX\MEDIASTOR REMOTE ADMINISTRATOR\SETUP.EXE

(In this path, D represents the drive holding the setup CD-ROM and XXX 
represents the ASM version number.) 

5. Once the file/path appears in the Open text box, click OK. MediaStor 
Remote Administration setup is initiated (which may take up to two 
minutes), and the Installation page appears. The Installation page briefly 
describes the installation process. 

6. Click Next. The Installation Options page appears.

Figure 102.  Remote Administrator Setup Wizard -- Installation Options 
Page 

7. Select Install new product and then click Next. The License Agreement 
page appears. 
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Figure 103.  Remote Administrator Setup Wizard -- License Agreement 
Page 

8. You must accept the terms of the license agreement before you can 
proceed with the installation. Scroll to the bottom of the agreement to 
enable the Accept terms of agreement check box. Check the box, and 
then click Next. The Registration page appears. 

Figure 104.  Remote Administrator Setup Wizard -- Registration Page 

9. Enter your name and the name of your organization and then click Next. 
The Target Computers page appears. 
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Figure 105.  Remote Administrator Setup Wizard -- Target Computers 
Page 

10. You have the following choices:

• To install the Remote Administrator only on the computer listed in the 
Target Computers list, click Next. The Summary page appears.

• To install the Remote Administrator on other computers in addition to 
the one listed in the Target Computers list, click Add. The Browse 
Computers dialog box appears. 

Figure 106.  Browse Computers Dialog Box 

11. In the Browse Computers dialog box you have two choices:

• Under Available Computers, navigate to and select the computer on 
which you want to install the Remote Administrator and then click Add 
to add the computer to the Selected Computers list. 

• In the Computer Name text box, type in the name or the IP address of 
the computer on which you want to install the Remote Administrator 
and then click Add to add the computer to the Selected Computers list.
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Repeat this step for each additional computer on which you want to install 
the Remote Administrator. When you finish selecting target computers, 
click OK. You are returned to the Select Target Computers page. 

12. Click Next. The Summary page appears.

13. Verify the accuracy of the information in the summary. 

14. If all information is correct, click Finish. Remote Administration Setup 
copies all program files onto the system and adds Remote Administrator 
entries and the program group to the system configuration for each target 
computer selected. A progress bar displays the status of the operation. 

When the installation is complete, one of the following occurs:

• If you installed the Remote Administrator on one or more remote 
computers (in addition to or instead of the local computer), the 
MediaStor Administrator Setup Result dialog box appears, listing the 
installation results for each computer you specified. 

Figure 107.  Setup Result Dialog Box 

Take note of any computers that need to be restarted (or computers on 
which the installation failed) and then click OK. Be sure to restart each 
computer on which it is required before you start the Remote 
Administrator.

• If you installed the Remote Administrator on the local computer, a 
message appears, indicating that the Remote Administration 
installation has been successfully completed. Click Start to close the 
Remote Administration Setup wizard and open the Administrator, or 
click Exit to close the Remote Administration Setup wizard without 
starting the Administrator.
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■ Starting the Remote Administrator the First Time
Because the Remote Administrator functions as an interface for MediaStor 
services installed on other machines, you must register the other computers 
through the Administrator in order to use the remote functionality. 

To start the Remote Administrator:

1. From the Start menu, select Programs, StorageTek MediaStor 
Administrator, and then Administrator.

The first time you start the Remote Administrator, a message appears 
prompting you to register a MediaStor computer to the Remote 
Administrator.

Figure 108.  Register a Computer? Message 

2. You have the following choices:

• To close the message box, but leave the empty Administrator window 
open, click No.

• To begin registering computers, click Yes. For more information and 
detailed instructions on registering MediaStor computers, see 
"Registering a Computer for Remote Administration, " which follows.

■ Registering a Computer for Remote 
Administration

You can administer MediaStor both from the computer on which MediaStor is 
installed and from remote computers. You can use the Administrator function 
that comes with a full installation of MediaStor to administer other MediaStor 
computers, or you can install the Remote Administrator, which simply provides 
you with the Administrator interface and the registration capability to attach 
remotely to any networked MediaStor computer. Only computers where the 
same or higher version of MediaStor is currently installed can be registered. 

The remote administration function is the same whether you use a MediaStor 
Administrator (full installation) or a MediaStor Remote Administrator. 
Regardless of which Administrator function you have installed, you have to 
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register the remote MediaStor computer in order to allow the Administrator you 
are running to find and connect to the remote MediaStor computer.

You can register MediaStor computers either using the auto-detect function or 
by adding the MediaStor computers manually. For procedures, see 
"Registering Computers Using Auto-Detect, " which follows, or “Registering 
Computers Manually” on page 166.

Registering Computers Using Auto-Detect
For large systems with several MediaStor computers, the manual registration 
process becomes unwieldy since you must browse to and select each 
computer on the network. The Auto-Detect Wizard allows you detect and 
select all currently running MediaStor services on the network without 
browsing the system to find individual MediaStor computers.

Note: The auto-detect function will only detect MediaStor installations whose 
version matches that of the Administrator you are running. To register 
a MediaStor service running a higher version than the Administrator, 
you must register the computer manually. 

To register MediaStor computers using the Auto-Detect Wizard:

1. From the Service menu in the Administrator in which you want to register 
the computer(s), select Register, or click the Register Computer toolbar 
button.

Figure 109.  Register Computer Toolbar Button 

The Register Computers dialog box appears.

Figure 110.  Register Computers Dialog Box 
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All computers already registered with the currently open Administrator 
appear in the Register Computers dialog box. If you are registering 
through a Remote Administrator and you have not yet registered any 
MediaStor computers, the Register Computers dialog box is blank.

2. Click Detect to start the Auto-Detect Wizard. The Introduction Page 
appears.

3. Read the Introduction and click Next. The Computer List page appears.

Figure 111.  Auto-Detect Wizard -- Computer List Page 

The Auto-Detect Wizard detects all computers on which MediaStor is 
installed and where the MediaStor service is actively running. 

Note: The Auto-Detect Wizard does not detect MediaStor computers that 
have been powered off or where the MediaStor service has been 
stopped, or where the MediaStor version does not match that of 
the Administrator you are running.  

4. Select the computer(s) you want to register and click Next.

Note: If a computer that you want to register does not appear in the 
Computers Detected list, you need to register the computer 
manually. See "Registering Computers Manually, " which follows.

5. Review the summary to make sure the computers you want to register are 
listed.

6. If the information in the summary is correct, click Finish. The selected 
computers are registered and appear in the Register Computers dialog 
box. 
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Figure 112.  Register Computers Dialog Box with a Computer Registered 

7. If you inadvertently list a computer you do not want to register, or you wish 
to delete a previously registered computer, select that computer and click 
Delete. Then click Yes on the confirmation message that appears.

8. Once the computers you want to remotely administer appear in the 
Register Computers dialog box, click Close. The Administrator attempts to 
connect to all registered MediaStor computers. All registered computer 
name(s) appear in the Computer drop-down list located directly beneath 
the menu bar in the Administrator, and in the tree view of the Administrator 
window.

The Administrator can be used to manage the MediaStor service on all 
registered and connected MediaStor computer(s). You can switch between 
registered computers by selecting different computer names from the 
Computer drop-down list or by selecting the computers in the tree view of the 
Administrator.

Registering Computers Manually
If the Auto-Detect Wizard does not detect a MediaStor computer you want to 
remotely administer, or if you want to select the computers yourself, you can 
register them manually. In addition, if you want to register a MediaStor 
computer that is running a higher version of the service than that of the 
Administrator, you will need to register the computer manually. 
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To manually register a MediaStor computer:

1. From the Service menu in the Administrator in which you want to register 
the computer(s), select Register, or click the Register Computer toolbar 
button.

Figure 113.  Register Computer Toolbar Button 

The Register Computers dialog box appears.

Figure 114.  Register Computers Dialog Box 

All computers already registered with the currently open Administrator 
appear in the Register Computers dialog box. If you are registering 
through a Remote Administrator and you have not yet registered any 
MediaStor computers, the Register Computers dialog box is blank.

2. Click Add. The Select Computer dialog box appears.
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Figure 115.  Select Computer Dialog Box 

The Select Computer dialog box contains a list of machines on the current 
network. MediaStor must be installed on the remote computer before it can 
be registered for remote administration. 

3. You have the following choices:

• Select the MediaStor computer you want to register and click OK.

• Double-click the computer you want to register.

The Register Computers dialog box appears, listing the selected 
computer. 

4. Repeat steps 2 and 3 for each computer you want to register.

5. If you inadvertently list a computer you do not want to use as a MediaStor 
service, or you wish to delete a previously registered computer, select that 
computer and click Delete. The computer is removed from the list.

6. Once the appropriate computers appear in the Register Computers dialog 
box, click Close. The Administrator attempts to connect to all registered 
MediaStor computers. All registered computer name(s) appear in the 
Computer drop-down list located directly beneath the menu bar in the 
Administrator, and in the tree view.

The Administrator can be used to manage the MediaStor service on all 
registered and connected MediaStor computer(s). You can switch between 
registered computers by selecting different computer names from the 
Computer drop-down list or by selecting the computers in the tree view of the 
Administrator.
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■ Connecting to MediaStor Computers
When the Administrator is opened, it attempts to connect to all registered 
MediaStor computers (including the local computer for full installations of 
MediaStor). Once these connections have been made, the window displays 
information pertaining to each MediaStor service. The Administrator allows 
you to switch easily between registered MediaStor computers by selecting the 
computers in the tree view, or by selecting different computers from the 
Computer drop-down list.

Figure 116.  Computer Drop-Down List 

Remember, to successfully connect to a MediaStor computer in order to 
administer it, you must be a member of the MSAdministrators group on the 
computer you want to administer. For more information, see “Windows NT/
2000 Security” on page 22.

Disconnecting from a MediaStor Computer
You may wish to disconnect from the currently active MediaStor computer. 
Disconnecting from the active service removes that computer’s MediaStor 
components from the tree view, though the computer still appears, listed with a 
status of (Disconnected).

To disconnect from the active MediaStor computer:

1. In the tree view of the Administrator, select the computer from which you 
want to disconnect. 

2. From the Service menu, select Disconnect, or click the Disconnect toolbar 
button. 

Figure 117.  Disconnect Toolbar Button 

MediaStor removes the selected computer’s components from the tree 
view, and the computer is listed with a status of (Disconnected).

Reconnecting to a MediaStor Computer
Disconnected MediaStor computers appear in the tree view of the 
Administrator with a status of (Disconnected). Reconnecting MediaStor 
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computers re-displays their configured components so that you can administer 
them.

To reconnect to a MediaStor computer:

1. In the tree view of the Administrator, select the computer to which you 
want to connect.

2. From the Service menu, select Connect, or click the Connect toolbar 
button.

Figure 118.  Connect Toolbar Button 

MediaStor connects to the selected computer, and the computer’s 
MediaStor components appear in the tree view of the Administrator so that 
you can administer them.
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AUsing SCSI Manager

SCSI (Small Computer System Interface) is a hardware interface that allows 
for the connection of up to seven peripheral devices, such as libraries, or 
optical and CD-ROM drives, to a single SCSI board, called a SCSI host bus 
adapter. Thus, seven different devices are using only one expansion slot in the 
computer.

SCSI Manager is a software utility that provides an interface for viewing and 
troubleshooting SCSI devices. Shipped withASM MediaStor, SCSI Manager 
allows you to view SCSI device profiles and status, browse media data, and 
perform SCSI commands to manipulate the library. Through the SCSI 
Manager, you can see libraries and drives and view inquiry strings without 
going through MediaStor. SCSI Manager also provides configuration 
information that indicates whether the device is supported in the current 
version of MediaStor.

A working knowledge of SCSI, including commands and hardware 
connectivity, is necessary to fully utilize SCSI Manager features. The greater 
your SCSI knowledge, the more powerful this utility can be. For example, 
when you contact technical support, SCSI Manager provides a common 
interface in which the support representatives can guide you through 
troubleshooting hardware problems. For information on SCSI commands, 
refer to the SCSI Command Reference guide provided with the SCSI device 
(for example, your library).

For more information, see the following sections:

• "SCSI Concepts, " which follows

• “Supported Device Types” on page 174

• “Starting SCSI Manager” on page 175

• “Viewing a Device Profile” on page 177

• “Browsing Media” on page 178

• “Writing and Reading Data Files” on page 181

• “Device Window Commands” on page 184

• “Common Menu Commands” on page 186

• “Jukebox Menu Commands” on page 193

• “Drive Menu Commands” on page 197
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• “Shutting Down and Exiting SCSI Manager” on page 202

■ SCSI Concepts
Before using SCSI Manager, you should be familiar with certain areas and 
terms. The following concepts are important for use with SCSI Manager:

• "Hex, " which follows

• “CDB (Command Descriptor Block)” on page 173

• “Sense Data” on page 173

• “Element” on page 174

• “Buffer” on page 174

Hex
When commands are performed in SCSI Manager, the results appear in hex 
numbers. Hex is short for hexadecimal, which means 16. This is a base 16 
numbering system used as shorthand for representing binary numbers. Each 
half byte (four bits) is assigned a hex digit as listed in the following table:

Table 20.  Decimal And Hexadecimal Represented As Binary

Decimal Hexadecimal Binary
0 0 0000
1 1 0001
2 2 0010
3 3 0011
4 4 0100
5 5 0101
6 6 0110
7 7 0111
8 8 1000
9 9 1001
10 A 1010
11 B 1011
12 C 1100
13 D 1101
14 E 1110
15 F 1111
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In a hex number, each digit position has a value 16 times greater than the one 
to its right. Two hex digits make up one byte; for example, A7 is equivalent to 
decimal 167 (10 X 16 + 7 X 1).

CDB (Command Descriptor Block)
A SCSI command and its parameters are sent as a block several bytes long 
(6, 10, or 12 bytes) called the Command Descriptor Block (CDB). A CDB 
contains the operation code, Logical Unit Number (LUN), block address, and 
transfer length fields. The CDB is required for all SCSI Manager commands. 
For more detailed information, refer to the SCSI specification and particular 
device manual.

Sense Data
When a SCSI command is carried out, its status is reported on two levels: a 
brief status in the Status field in the upper part of the Device window and a 
more detailed status in Sense Data. The Status field reports information such 
as whether execution of a command was successful or an error occurred, or 
other information such as “busy.” This status does not give any detailed 
information. 

If the status reads “Check Condition,” it means that some condition exists that 
prevented successful completion of the command. It could be an error in the 
CDB, a hardware problem, or some external problem. Issuing the Request 
Sense command (for more information, see “Request Sense” on page 190) 
gives you detailed information on the condition, referred to as Sense Data. 
Sense Data is a set of flags and indicators that are continuously updated to 
reflect the current status. It is presented in a hierarchical manner, starting with 
general conditions and proceeding to specific conditions, as follows:

1. SENSE-KEY

2. ADDITIONAL SENSE CODE (ASC)

3. ADDITIONAL SENSE CODE QUALIFIER (ASCQ)

The Sense Key defines the class of error or condition information. There are 
fifteen Sense Keys, which classify the device condition as a hardware or 
software problem, fatal or recoverable error, and so on. The ASC together with 
the ASCQ provide more detailed information. For specific descriptions, refer to 
the SCSI specification and particular device manual.

Example:

ERR 16:34 (00151) [DE_JUKE.c, 1828] DE: Jukebox error encountered on 
DISMOUNT

Operation

00 00 00 ….DeviceName:SCSI2000
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….ScsiCdb:a5 00 02 bc 01 f4 00 00 00

…

….BusStatus:4h

….TargetStatus:2h, CHECK CONDITION

….SenseData:70 00 06 00 00 00 00 0a 00

….00 00 00 29 00 00 00 00 00

….SenseKey:6h, UNIT ATTENTION

….AddSenseCode:29h

….AddSenseQual:0h

….ScsiError: 9824, SCSI_ERR_DEV_RESET

….JukeError: 9728, JUKE_ERR_DEV_RESET

Element
Elements are components in a library, including individual storage slots, 
mailslots, optical, CD-ROM, and tape drives, and picker mechanisms. Many 
SCSI commands refer to this term; for example, Read Element Status and 
Position to Element, which positions the transport element (picker) in front of 
another element (for example, a drive). For more information, see “Read 
Element Status” on page 194 and “Position to Element” on page 196.

Buffer
A buffer is a reserved segment of memory used to hold data while it is being 
processed. In SCSI Manager, the buffer is contained and displayed in the 
bottom part of the Device window and includes information about the specific 
SCSI device. When commands are performed, the results are shown in the 
buffer area, which is located in the bottom portion of the Device window. This 
buffer contains a scroll bar in order to view complete results.

Buffer length refers to the amount of space allotted in the bottom display 
portion of the Device window. Each command using the buffer has a default 
buffer length, in bytes. This number is usually adequate, but can be changed if 
necessary.

■ Supported Device Types
When SCSI Manager is initialized, it seeks out all SCSI autochangers and 
drives currently connected to the system. The following table lists the types of 
supported devices
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:

Note: Serial libraries are not accessible through SCSI Manager. Only SCSI 
devices appear. For information on accessing and controlling serial 
libraries, see “Appendix B: Using Jukebox Manager” on page 167.

■ Starting SCSI Manager
Once you start SCSI Manager, you can begin using the utility to manage the 
SCSI devices in your MediaStor system.

To start SCSI Manager: 

1. Be sure that neither Jukebox Manager nor the MediaStor service is 
running. SCSI Manager cannot initialize if MediaStor or Jukebox Manager 
is running. Only one of these services can access devices at a time. For 
more information, see “Shutting Down and Exiting Jukebox Manager” on 
page 174 and “Managing the MediaStor Service” on page 91.

2. From the Windows Start menu, select Programs, then ASM MediaStor, 
Utilities, and then SCSI Manager. The SCSI Manager window appears and 
SCSI Manager automatically initializes.

Table 21.  SCSI Manager Supported Devices

Device Description
CD-ROM Standalone CD-ROM drive
TAPE Standalone tape drive (tape media cannot be 

browsed)
DVD-ROM Standalone DVD-ROM drive
DVD-R Standalone DVD-R drive
DVD-RAM Standalone DVD-RAM drive
OPTICAL MEMORY Standalone optical drive
WORM MEMORY Standalone WORM drive
JUKEBOX Library, either optical, DVD-RAM, DVD-R, DVD-

ROM, CD-ROM, WORM, WORM-tape, or tape
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Figure 119.  SCSI Manager Window 

As SCSI Manager initializes, it looks for all SCSI devices on the system 
and lists them in the Device List window, shown in the figure above. The 
following information appears for each device in the Device List window:

Note: If SCSI Manager fails to initialize, you can initialize it manually. 
From the File menu in SCSI Manager, select Initialize. A check 
mark appears beside the Initialize command in the File menu, and 
the Device List window appears.

Note: If you close a Device window or shut down SCSI Manager, the 
Device List window also closes. You can reopen it by selecting the 
Device List option from the System menu (when SCSI Manager is 
initialized).

3. From the Device List window, you have the following choices:

• View a device’s profile. For more information, see "Viewing a Device 
Profile, " which follows. 

Table 22.  Device List Window Columns

Column Description
Name The SCSI device address
Description The device vendor and model
Configuration Whether the device driver is loaded in the ASM supported 

device list. If the device driver is not loaded, you cannot see 
the device when adding hardware to MediaStor.

Driver The driver that has control of the device. If the device is 
configured with a Windows Native file system (NTFS), the 
drivers listed are SCSIDISK, SCSICDRM, or SCSITAPE; if 
the device is configured with an ASM file system, SCSIALL is 
listed as the driver.
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• Open a Device window for a device, from which you can view and 
manage the device. To open a Device window, select the device you 
want to view and manage, and then click Select. (You can also double-
click the device to open the Device window.)

Figure 120.  Device Window 

The Device window displays command status and results information for 
the selected device, providing a concise view of device events. The device 
description, including the SCSI ID, appears in the title bar of the Device 
window so that you can easily note which device’s information is displayed 
in the active window.

The Device window is clear of all data until a command is performed. All 
commands for a device must be performed while the Device window for a 
device is active. Any command executed affects the active window.

When a command is performed, it is listed in the upper part of the Device 
window, along with status and other statistics. These statistics give insight 
into the inner workings of the SCSI command. The buttons at the right of 
the window become active and inactive depending upon the command 
performed. If an option is available after a command is performed, the 
button is enabled for use. This chapter describes each command and 
further options that can be performed.

■ Viewing a Device Profile
Since all SCSI devices are different and have slightly different functionality, the 
Device Profile is helpful for determining not only the SCSI ID and description 
of the device, but also particular functions of the device. For example, some 
libraries require that the library perform the media eject, and some require that 
the drive perform the media eject (with no intervention from the library). The 
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Device Profile tells you which features a specific device supports, and 
therefore whether those commands are applicable for the device.

To view a Device Profile:

1. From the Device List window, select the device whose profile you want to 
view and then click Profile. The Device Profile appears, with the SCSI 
address listed in the title bar. 

Figure 121.  Device Profile Dialog Box 

2. When you finish, click OK to close the Device Profile dialog box and return 
to the Device List window.

■ Browsing Media
Browsing media allows you to read sectors one-by-one, or to read specific 
sectors on the media. In addition, you can search for occurrences of a data 
pattern on the media. 

Browsing is disabled by default, so that in order to browse media, you must 
enable browsing in the Device window. 

Note: When browsing is enabled, no other SCSI commands can be 
performed for the device. For example, commands in the Drive and 
Jukebox menus are not available while browsing is enabled. 

To enable browsing:

1. Be sure that the media you want to browse is mounted and spun-up in the 
drive. Media must be mounted and spun-up before you can enable 
browsing.

2. Click the Enable Browse button in the Device window. The contents and 
active buttons in the Device window and available menu commands 
change to reflect that browsing is enabled. In addition, the Command field 
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at the top of the Device window displays “Read Sector”, and the Enable 
Browse button changes to Disable Browse. 

Figure 122.  Device Window with Browsing Enabled 

3. You have the following choices:

• To move forward from sector to sector in order, click the forward arrow 
button. You can also open the Drive menu, select Browse, and then 
choose Next Sector.

• To move backward from sector to sector in order, click the backward 
arrow button. You can also open the Drive menu, select Browse, and 
then choose Previous Sector.

• To search for a specific sector or group of sectors, see "Searching 
Sectors, " which follows.

• To go directly to a specific sector, see “Going to a Specific Sector” on 
page 180.

4. When you finish, click the Disable Browse button on the Device window to 
disable browsing. The Device window changes to reflect that browsing has 
been disabled, and previously unavailable SCSI commands are now 
available in the SCSI Manager menus.

Searching Sectors
When browsing sectors on a piece of media, you can search for a specific 
sector or group of sectors.

To search for sectors:

1. With browsing enabled, click the Search button in the Device window, or, 
from the Drive menu, select Browse and then Search. The Search dialog 
box appears.
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Figure 123.  Search Dialog Box 

2. In the Start Sector Number text box, enter a starting sector number.

3. Select the direction in which you want to search. Choose Forward if you 
want to search forward through the sectors, or choose Backward if you 
want to search backward through the sectors.

4. Select a search option. You have the following choices:

• To search for a blank sector, choose Blank Sector.

• To search for a written sector, choose Written Sector.

• To search for an ASCII pattern, choose ASCII Pattern. 

• To search for a Hex pattern, choose Hex Pattern. 

5. If you chose to search for an ASCII or Hex pattern, enter the pattern in the 
Pattern text box.

6. If you chose to search for an ASCII pattern, choose whether to search for 
Unicode.

7. Click OK. The search results appear in the lower portion of the Device 
window.

Going to a Specific Sector
If you know the sector of media you want to browse, you can go directly to that 
sector.

To go to a specific sector:

1. Click the Goto button in the Device window, or, from the Drive menu, select 
Browse and then Goto Sector. The Goto Sector dialog box appears.

Figure 124.  Goto Sector Dialog Box 

2. You have the following choices:
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• To go to the first sector of the media, select First.

• To go to the last sector of the media, select Last.

• To go to a specific sector, select Other and then enter the number of 
the sector in the Sector Number text box.

3. Click OK. The Sector information appears in the lower portion of the 
Device window.

Performing a Speed Test
You can perform a Speed Test to determine the time required to read a 
specific number of sectors on a piece of media.

To perform a speed test:

1. With browsing enabled, open the Drive menu. Select Browse and then 
Speed Test. The Speed Test dialog box appears.

Figure 125.  Speed Test Dialog Box 

The default value is to start the test at sector 0 and to read 2500 sectors.

2. To change the sector at which the speed test begins, enter the sector 
number in the Read Start Sector text box.

3. To change the number of sectors to test, enter the number in the Number 
Of Sectors text box.

Note: If necessary, you can return the values in the Read Start Sector 
and Number Of Sectors text box by clicking Default.

4. Click OK to start the speed test. After the test is performed, a message 
appears with the number of seconds required to read the specified number 
of sectors.

■ Writing and Reading Data Files
You can create a data file that contains all of the data appearing in the buffer, 
which is displayed in the lower part of the Device window. (For more 
information on the buffer, see “Buffer” on page 174.) This allows you to save 
information at the time it appears. 
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Data files are saved with a .DAT extension and can be opened in SCSI 
Manager. When opened, they appear in the lower part of the active Device 
window. 

For more information, see the following sections:

• "Writing Data Files, " which follows

• “Reading Data Files” on page 183

Writing Data Files
When creating a data file, you must decide between Binary and ASCII format. 

• Binary information is stored in a binary coded form, such as data, text, 
images, voice, and video. One byte (8 bits) can hold values from 0 to 255. 
Two contiguous bytes (16 bits) can hold values from 0 to 65,535.

• An ASCII file contains data made up of ASCII characters. It is essentially 
raw text. In ASCII format, each byte in the file contains one character that 
conforms to the standard ASCII code. Program source code, DOS batch 
files, macros, and scripts are written as straight text and stored as ASCII 
files. ASCII text files become a common denominator between 
applications that do not import each other’s formats. If both applications 
can import and export ASCII files, files can be transferred between them.

To write a data file:

1. Enable media browsing so that there is data in the buffer. For more 
information, see “Browsing Media” on page 178. Other data can be 
accessed through the following commands:

• “Inquiry” on page 188

• “Request Sense” on page 190

• “Receive Diagnostics” on page 191

• “Mode Sense” on page 192

• “Custom Command” on page 192

• “Read Sector” on page 198

• “Read Capacity” on page 200

2. From the File menu, select Write Data File. The Write Data File dialog box 
appears.



Writing and Reading Data Files

ASM MediaStor System Guide 183
StorageTek Proprietary

Figure 126.  Write Data File Dialog Box 

3. Select a format option. You have the following choices:

• Choose Binary Format to write the data file to a binary format.

• Choose ASCII Format to write the data file to an ASCII format.

4. Click OK. A dialog box appears allowing you to select a file location. The 
default location is the Bin directory within the program folder in C:\Program 
Files\Legato\.

Figure 127.  Write Data File Dialog Box -- Choose Location 

5. Select the directory in which you want to save the file.

6. In the File name text box, enter a file name.

7. Click Save. A confirmation message appears.

8. Click OK.

Reading Data Files
Saved data files can be accessed through SCSI Manager, with the file data 
displayed in the lower portion of the Device window. Use the scroll bar on the 
right side if necessary to view the entire file.

Note: You must disable browsing to read data files, because the buffer (lower 
part of the Device window) must be empty in order to read the data file 
to the buffer.
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To read a data file:

1. Be sure that media browsing is disabled. When browsing is disabled, the 
Enable Browse button appears on the Device window.

2. From the File menu, select Read Data File. The Read Data File dialog box 
appears.

Figure 128.  Read Data File Dialog Box 

3. Navigate to and select the file you want to read, and then click Open (or 
double-click the file).

4. The data file information appears in the lower portion of the Device 
window.

Figure 129.  Device Window with Data File Displayed 

■ Device Window Commands
From the Device window, you can view additional Sense Data and the current 
status of the SCSI device. For more information, see the following sections:

• "Sense Structure/Sense Dump, " which follows

• “SCSI Request” on page 185
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Sense Structure/Sense Dump
You can view additional Sense Data when you click the Sense Structure or 
Sense Dump buttons in the Device window. Sense Data can be useful for 
troubleshooting problems with the device. For more information on Sense 
Data, see “Sense Data” on page 173.

The following figures show examples of the data that appears when these 
buttons are selected.

Figure 130.  Sense Structure Dialog Box 

Figure 131.  Sense Dump Dialog Box 

Click OK in either the Sense Structure or Sense Dump dialog box to close it.

SCSI Request
Clicking the SCSI Request button in the Device window allows you to view the 
current status of the SCSI device. The device status is returned in a standard 
format with a Sense Code in byte 2, and an Additional Sense Code (ASC) and 
Additional Sense Code Qualifier (ASCQ) in bytes 12 and 13. (For more 
information on Sense Data, including the ASC and ASCQ, see “Sense Data” 
on page 173.)
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Figure 132.  SCSI Request Dialog Box 

Click OK to close the SCSI Request dialog box.

■ Common Menu Commands
The Common menu contains commands commonly used for communicating 
with SCSI devices. For more information, see the following sections:

• "Test Unit Ready, " which follows

• “Rezero Unit” on page 187

• “Inquiry” on page 188

• “Request Sense” on page 190

• “Send Diagnostics” on page 190

• “Receive Diagnostics” on page 191

• “Mode Sense” on page 192

• “Custom Command” on page 192

Note: Common menu commands can only be accessed when browsing is 
disabled. When browsing is disabled, the Enable Browse button 
appears on the Device window.

Test Unit Ready
The Test Unit Ready command determines the ready state of a device. A 
device is in a ready state when all SCSI devices are connected properly and it 
operates without error. A drive in a library is in a ready state when the media is 
loaded and spun up, and when read or write operations can complete 
successfully.

If the device is in a ready state when it receives the command, it returns a 
status of “Ready”. If the device is not in a ready state, the status is “Not 
Ready” or “Not Found”. 
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Note: The Test Unit Ready command is the first command that should be 
performed on a device. It is a basic method for testing whether the 
device is functional.

To test the ready state of a device:

1. Be sure that media browsing is disabled. When browsing is disabled, the 
Enable Browse button appears on the Device window.

2. From the Common menu, select Test Unit Ready. The command appears 
in the Device window and the device is tested.

Figure 133.  Device Window with Test Unit Ready Results 

The results appear in the Status and Sense fields in the upper portion of 
the Device window.

Rezero Unit
Rezeroing is typically done on libraries. This command calibrates the device 
and places it into an initialized state. Usually this command is performed 
automatically when the device is powered on; however, certain devices do not 
perform this command automatically. Failure of this command could indicate 
hardware difficulties, like a jammed drive, making it potentially helpful as a 
diagnostic tool.

To rezero a library:

1. Be sure that media browsing is disabled. When browsing is disabled, the 
Enable Browse button appears on the Device window.

2. Be sure that media is present in the drive. A drive can only be rezeroed 
when media is present in the drive.

3. From the Common menu, select Rezero Unit. The command appears in 
the Device window and the device is calibrated.
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Figure 134.  Device Window with Rezero Unit Results 

The results appear in the Status and Sense fields in the upper portion of 
the Device window.

Inquiry
The Inquiry command is important during diagnostic testing, especially if you 
are unfamiliar with the hardware. It sends controller and drive information to 
the initiator. The result is a display of what is commonly called the “inquiry 
string”, which includes the device manufacturer, the product name, and 
firmware version.

To execute an inquiry:

1. Be sure that media browsing is disabled. When browsing is disabled, the 
Enable Browse button appears on the Device window.

2. From the Common menu, select Inquiry. The Inquiry Command dialog box 
appears.

Figure 135.  Inquiry Command Dialog Box 

3. You have the following choices:

• If the product you are using has additional page codes that can be 
used during inquiry and are unique to the device, select Yes for the 
Vital Product Data option. Then enter the page code in the Vital 
Product Data Page Code text box, as specified in the device manual.

• Leave the default setting of No for the Vital Product Data option.
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4. Enter a buffer length in the Return Buffer Length text box. The default 
value is 36. If a page code is entered, the buffer length must be changed to 
accommodate more data. 

Note: If you need to reset the values in the Inquiry Command dialog box 
to the default settings, click Reset.

5. Click OK. The results appear in the lower portion of the Device window. 

Figure 136.  Device Window With Inquiry Data 

In addition, the Data Structure button on the Device window becomes 
active. 

6. To view further details, click Data Structure. The Data Structure: Inquiry 
dialog box appears with read-only information.

Figure 137.  Data Structure: Inquiry Dialog Box 

7. Click OK to return to the Device window.
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Request Sense
After every command, the status of the command is checked for errors. If an 
error occurs, a “Check Condition” status is reported and Sense Data is 
updated. Sense Data is preserved until retrieved by a Request Sense 
command or until the same drive receives another command. Initiating the 
Request Sense command at the time an error is returned allows you to 
determine the specific error condition. For more information on Sense Data, 
see “Sense Data” on page 173.

Note: If a Send Diagnostics command is unsuccessful, the status reads 
“Check Condition”. The first command after a “Check Condition” status 
resets the Sense Data. This means that if a Request Sense command 
is not issued at this point, the error information is lost. For more 
information on the Send Diagnostics command, see “Send 
Diagnostics” on page 190.

To request Sense Data:

1. Be sure that media browsing is disabled. When browsing is disabled, the 
Enable Browse button appears on the Device window.

2. From the Common menu, select Request Sense. The Request Sense 
Command dialog box appears.

Figure 138.  Request Sense Command Dialog Box 

3. Enter a buffer length in the Return Buffer Length text box. The default 
value is 32.

Note: If you need to reset the buffer length in the Request Sense 
Command dialog box, click Reset.

4. Click OK. The results appear in the lower part of the Device window.

Send Diagnostics
The Send Diagnostics command initiates certain predefined diagnostic tests/
exercise routines in order to perform a self-test. The information specified for 
this command is unique to the device being used. To send diagnostics:

1. Be sure that media browsing is disabled. When browsing is disabled, the 
Enable Browse button appears on the Device window.

2. From the Common menu, select Send Diagnostics. The Send Diagnostics 
Command dialog box appears.
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Figure 139.  Send Diagnostics Command Dialog Box 

3. Set the appropriate options.

Note: If you need to reset the values in the Send Diagnostics Command 
dialog box to the default settings, click Reset.

4. Click OK. 

Note: If the test is not successful, the status reads “Check Condition” and 
a Request Sense command should be performed to describe 
details about the failure. For more information on performing a 
Request Sense command, see “Request Sense” on page 190.

Receive Diagnostics
The Receive Diagnostics command collects and displays the information 
gathered using the Send Diagnostics command. 

To receive diagnostics:

1. Be sure that media browsing is disabled. When browsing is disabled, the 
Enable Browse button appears on the Device window.

2. From the Common menu, select Receive Diagnostics. The Receive 
Diagnostics Command dialog box appears.

Figure 140.  Receive Diagnostics Command Dialog Box 

3. Enter a buffer length.

Note: If you need to reset the buffer length in the Receive Diagnostics 
Command dialog box, click Reset.

4. Click OK.
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Mode Sense
This command retrieves element parameter information, including element 
addresses, number of drives, and element characteristics. The results are 
unique to the device being used. For more information on elements, see 
“Element” on page 174.

To execute mode sense:

1. Be sure that media browsing is disabled. When browsing is disabled, the 
Enable Browse button appears on the Device window.

2. From the Common menu, select Mode Sense. The Mode Sense 
Command dialog box appears.

Figure 141.  Mode Sense Command Dialog Box 

3. Enter the appropriate information. 

Note: If you need to reset the values in the Mode Sense Command 
dialog box to the default settings, click Reset.

4. Click OK. 

Custom Command
For any command that is not available through a menu option, a customized 
command can be performed directly from SCSI Manager. For detailed 
information on Command Descriptor Blocks, lengths needed, and so on, refer 
to the SCSI reference manual for the specific device.

To execute a custom command:

1. Be sure that media browsing is disabled. When browsing is disabled, the 
Enable Browse button appears on the Device window.

2. From the Common menu, select Custom Command. The Custom 
Command dialog box appears.
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Figure 142.  Custom Command Dialog Box 

3. Enter the appropriate information.

Note: If you need to reset the values in the Custom Command dialog box 
to the default settings, click Reset.

4. Click Send.

■ Jukebox Menu Commands
The Jukebox menu provides functions for working with a library and its 
elements. Elements include storage slots, mailslots, drives, and the picker 
mechanism. For more information, see the following sections:

• "Initialize Element Status, " which follows

• “Read Element Status” on page 194

• “Move Medium” on page 195

• “Position to Element” on page 196

• “Medium Removal” on page 196

Note: Jukebox menu commands can only be accessed when browsing is 
disabled. When browsing is disabled, the Enable Browse button 
appears on the Device window.

Initialize Element Status
The Initialize Element Status command checks all elements for relevant 
status. This command acts as a kind of soft reset, to make sure the element is 
ready to receive commands. This information is retained and is available 
through the Read Element Status command. For more information on the 
Read Element Status command, see "Read Element Status, " which follows. 
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To initialize element status:

1. Be sure that media browsing is disabled. When browsing is disabled, the 
Enable Browse button appears on the Device window.

2. From the Jukebox menu, select Init Element Status. The command 
appears in the Device window.

Figure 143.  Device Window with Initialize Element Status Results 

The status reads “success” when the initialization is successful. 

Read Element Status
The Read Element Status command gives the exact status of the various 
elements within the library. 

To read element status:

1. Be sure that media browsing is disabled. When browsing is disabled, the 
Enable Browse button appears on the Device window.

2. From the Jukebox menu, select Read Element Status. The Read Element 
Status Command dialog box appears.

Figure 144.  Read Element Status Command Dialog Box 

3. Select the element type from the drop-down list. 

4. In the Start Element Address text box, enter the address of the element 
with which you want to start.
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5. In the Number of Elements text box, enter the number of elements.

6. In the Return Buffer Length text box, enter the maximum length of the 
return buffer.

Note: If you need to reset the values in the Read Element Status 
Command dialog box to the default settings, click Reset.

Note: For a list of Hex values needed for the specific device, click Help.

7. Click OK.

Move Medium
The Move Medium command allows you to move media between library 
elements. While you can perform this command using Jukebox Manager, it is 
advantageous to use SCSI Manager if you want to see the SCSI commands 
behind the action.

Note: When inserting media into a drive that uses the NTFS or FAT file 
system, use the FSMOUNT.EXE utility from a command prompt to 
mount the file system after the media is mounted. For details on using 
FSMOUNT.EXE, refer to the ASM Solutions Knowledge Base, which 
can be found either on the StorageTek website at http://
www.support.StorageTek.com in the Customer Resource Center 
(CRC) section. To move media between library elements:

1. Be sure that media browsing is disabled. When browsing is disabled, the 
Enable Browse button appears on the Device window.

2. From the Jukebox menu, select Move Medium. The Move Medium 
Command dialog box appears.

Figure 145.  Move Medium Command Dialog Box 

3. In the Source Element Address text box, enter the address of the element 
that contains the media you want to move.

4. In the Destination Element Address text box, enter the address of the 
element to which you want to move the media.

http://www.legato.com/support/knowledgebase
http://www.legato.com/support/knowledgebase
http://www.legato.com/support/knowledgebase
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5. If the media you are moving is double-sided, choose whether to invert the 
media while moving it. Click Yes to invert the media, or click No to move 
the media without inverting it.

Note: If you need to reset the values in the Move Medium Command 
dialog box to the default settings, click Reset.

Note: For a list of Hex values needed for the specific device, click Help.

6. Select OK.

Position to Element
This command positions the picker (transport element) in front of the specified 
element. This is useful for setting the picker to rest in front of a certain drive for 
faster performance, or to a location that is out of the way from blocking access 
to a storage element that requires manual intervention.

To position the picker in front of an element:

1. Be sure that media browsing is disabled. When browsing is disabled, the 
Enable Browse button appears on the Device window.

2. From the Jukebox menu, select Position to Element. The Position to 
Element Command dialog box appears.

Figure 146.  Position To Element Command Dialog Box 

3. Enter the Transport and Destination Element Addresses, and select 
whether to invert the picker.

Note: If you need to reset the values in the Move Medium Command 
dialog box to the default settings, click Reset.

Note: For a list of Hex values needed for the specific device, click Help.

4. Click OK.

Medium Removal
The Medium Removal command allows you to specify whether media can be 
ejected from the library using the Eject button on the front panel of the library. 
The Allow command may need to be sent in order to eject media from a drive 
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that is locked. Likewise, sending a Prevent command locks access to a drive 
from any other thread trying to access it.

To allow media removal:

1. Be sure that media browsing is disabled. When browsing is disabled, the 
Enable Browse button appears on the Device window.

2. From the Jukebox menu, select Medium Removal. The Medium Removal 
Command dialog box appears. 

Figure 147.  Medium Removal Command Dialog Box 

3. Choose whether to allow media to be removed from the drive using the 
Eject button on the front panel of the library.

• Select Allow to allow media removal using the Eject button.

• Select Prevent to require a SCSI command in order to remove media 
from the drive.

Note: If you need to reset the value in the Medium Removal Command 
dialog box to the default setting, click Reset.

4. Click OK.

■ Drive Menu Commands
The Drive menu provides functions that deal specifically with drive 
performance and media read/write capabilities. For more information, see the 
following sections:

• "Read Sector, " which follows

• “Write Sector” on page 198

• “Read Capacity” on page 200

• “Start/Stop Unit” on page 200

• “Medium Removal” on page 201

• “Format” on page 202

Note: Drive menu commands can only be accessed when browsing is 
disabled. When browsing is disabled, the Enable Browse button 
appears on the Device window.
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Read Sector
You can read information from a piece of media one sector at a time, or you 
can read multiple contiguous sectors at a time. The Read Sector command 
reads specified sectors and displays their contents.

To read media sectors:

1. Be sure that media browsing is disabled. When browsing is disabled, the 
Enable Browse button appears on the Device window.

2. Be sure that media is mounted in a drive and spun up using the start/stop 
unit command. For more information, see “Start/Stop Unit” on page 200.

3. From the Drive menu, select Read Sector. The Read Sector Command 
dialog box appears.

Figure 148.  Read Sector Command Dialog Box 

4. Set the appropriate Relative Address, Force Unit Access, and Disable 
Page Out options. The default for each of these options is No.

5. In the Logical Block Address text box, enter the first sector to be read. 
(The starting sector is 0.)

6. In the Logical Block Count text box, enter the number of sectors to be 
read.

Note: If you need to reset the values in the Read Sector Command dialog 
box to the default settings, click Reset.

7. Click OK. The sector data appears in the lower portion of the Device 
window and is saved in a memory buffer. All or part of the information can 
be written to a new media location to a specific sector or range of sectors. 
For more information, see "Write Sector, " which follows.

Write Sector
The Write Sector command is used in conjunction with Read Sector. Once 
information has been read, it is buffered and appears in the lower portion of 
the Device window. All or part of the information can be written to a new media 
location to a specific sector or range of sectors. For WORM media, this 
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information can be written only if there are unused sectors. Information cannot 
be rewritten to WORM. 

Note: Be sure that the number of sectors in the data buffer is at least as large 
as the number of sectors to be written. For example, if ten sectors are 
to be written, at least ten sectors must have been read and placed in 
the data buffer.

To write media sectors:

1. Be sure that media browsing is disabled. When browsing is disabled, the 
Enable Browse button appears on the Device window.

2. Use the Read Sector command to display the sector data to be copied. For 
instructions, see “Read Sector” on page 198.

3. From the System menu, select Copy Data.

4. Activate the Device window for the device containing the media to which 
the information is to be copied.

5. From the System menu, select Paste Data. The information is pasted into 
the buffer.

6. From the Drive menu, select Write Sector. The Write Sector Command 
dialog box appears.

Figure 149.  Write Sector Command Dialog Box 

7. Set the appropriate Relative Address, Force Unit Access, and Disable 
Page Out options.

8. Select the sector or range of sectors to which the data should be written 
using the Logical Block Address and Logical Block Count text boxes.

Note: If you need to reset the values in the Write Sector Command dialog 
box to the default settings, click Reset.

9. Click OK. The data is written to the specified sector(s) on the media.
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Read Capacity
The Read Capacity command reads the capacity of the media in the drive. 
The result is a hex value with total number of sectors.

To determine read capacity:

1. Be sure that media browsing is disabled. When browsing is disabled, the 
Enable Browse button appears on the Device window.

2. From the Drive menu, select Read Capacity. The Read Capacity 
Command dialog box appears.

Figure 150.  Read Capacity Command Dialog Box 

3. You have the following choices:

• To read partial sectors, select Yes and enter a starting sector number 
in the Logical Block Address text box.

• To read the entire media, select No. This is the default. 

Note: If you need to reset the values in the Read Capacity Command 
dialog box to the default settings, click Reset.

4. Click OK. The results appear in the lower part of the Device window. 

5. Click Data Structure to display a dialog box containing the read results.

Figure 151.  Data Structure: Read Capacity Dialog Box 

6. Click OK to return to the Device window.

Start/Stop Unit
The Start/Stop Unit command starts or stops the rotation of the media in the 
drive and/or ejects the media from the drive.
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To start or stop the unit:

1. Be sure that media browsing is disabled. When browsing is disabled, the 
Enable Browse button appears on the Device window.

2. From the Drive menu, select Start/Stop Unit. The Start/Stop Unit 
Command dialog box appears.

Figure 152.  Start/Stop Unit Command Dialog Box 

3. Choose whether to start or stop the unit by selecting the appropriate 
Operation option.

4. Choose whether to load or eject media by selecting the appropriate Load/
Eject option. In some instances, media may need to be ejected in order to 
be spun down.

Note: If you need to reset the values in the Start/Stop Unit Command 
dialog box to the default settings, click Reset.

5. Click OK.

Medium Removal
The Medium Removal command allows you to specify whether media can be 
ejected from the drive using the Eject button on the front panel of the device. 
The Allow command may need to be sent in order to eject media from a drive 
that is locked. Likewise, sending a Prevent command locks access to a drive 
from any other thread trying to access it.

To allow media removal:

1. Be sure that media browsing is disabled. When browsing is disabled, the 
Enable Browse button appears on the Device window.

2. From the Drive menu, select Medium Removal. The Medium Removal 
Command dialog box appears. 

Figure 153.  Medium Removal Command Dialog Box 

3. Choose whether to allow media to be removed from the drive using the 
Eject button on the front panel of the library.
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• Select Allow to allow media removal using the Eject button.

• Select Prevent to require a SCSI command in order to remove media 
from the drive.

Note: If you need to reset the value in the Medium Removal Command 
dialog box to the default setting, click Reset.

4. Click OK.

Format
You can perform a low-level format on a piece of media in a drive.

Note: Do not use the Format command to low-level format a piece of DVD-R 
media. Since DVD-R media can only be written to once, you cannot 
write additional files to the media if you low-level format it. 

To format media:

1. Be sure that media browsing is disabled. When browsing is disabled, the 
Enable Browse button appears on the Device window.

2. From the Drive menu, select Format. The Format Command dialog box 
appears.

Figure 154.  Format Command Dialog Box 

3. Select the appropriate options. 

Note: If you need to reset the values in the Format Command dialog box 
to the default settings, click Reset.

4. Click OK.

■ Shutting Down and Exiting SCSI Manager
When you finish viewing and managing SCSI devices, you can shut down and 
exit SCSI Manager. 

When you shut down SCSI Manager, SCSI Manager can run in a shutdown 
mode, so that SCSI devices can be seen and used by other applications/
services, such as MediaStor and Jukebox Manager. 

If you are finished using SCSI Manager, you can exit the utility.
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To shut down SCSI Manager:

• From the File menu of the SCSI Manager window, select Shutdown. A 
check mark appears by the Shutdown command in the menu, and all 
Device windows are closed.

To exit SCSI Manager:

• From the File menu, select Exit.
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BUsing Jukebox Manager

Jukebox Manager is a software utility that provides an interface for viewing 
and troubleshooting system libraries. Shipped with ASM MediaStor, Jukebox 
Manager allows you to view library profiles, perform a library inventory, and 
insert, eject, move, mount, exchange, flip, and dismount media.

Jukebox Manager provides only a general overview of the library and its 
contents, including whether media exists in drives and shelves. It does not 
specify any information about the media or their contents, nor does it allow 
media-related functions. This is sufficient for some diagnostic procedures; 
however, if more detailed diagnostics are necessary, it may be more helpful to 
use SCSI Manager. For more information on SCSI Manager, see “Appendix A: 
Using SCSI Manager” on page 139.

Note: Jukebox Manager provides barcode information for tape and optical 
media if the library supports volume tags.

For more information, see the following sections:

• "Starting Jukebox Manager, " which follows

• “Viewing a Library Profile” on page 208

• “Inventorying a Library” on page 209

• “Inserting Media” on page 209

• “Moving Media” on page 210

• “Mounting Media” on page 210

• “Flipping Media” on page 211

• “Dismounting Media” on page 212

• “Exchanging Media” on page 213

• “Ejecting Media” on page 213

• “Shutting Down and Exiting Jukebox Manager” on page 213

■ Starting Jukebox Manager
Once you start Jukebox Manager, you can begin using the utility to manage 
the libraries in your MediaStor system.
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To start Jukebox Manager:

1. Be sure that neither SCSI Manager nor the MediaStor service is running. 
Jukebox Manager cannot initialize if MediaStor or SCSI Manager is 
running. Only one of these services can access devices at a time. For 
more information on shutting down SCSI Manager, see “Shutting Down 
and Exiting SCSI Manager” on page 165. For information on stopping the 
MediaStor service, see “Managing the MediaStor Service” on page 91.

2. From the Windows Start menu, select Programs, thenASM MediaStor, 
Utilities, and then Jukebox Manager. The Jukebox Manager window 
appears and Jukebox Manager automatically initializes.

Figure 155.  Jukebox Manager Window 

As Jukebox Manager initializes, it looks for all SCSI libraries on the system 
and lists them along with their SCSI addresses and descriptions in the 
Jukebox List window, shown in the figure above. The description for each 
library is the actual inquiry string from the device. This can be helpful when 
working with a technical support representative to try to resolve an issue. 

Note: Serial libraries appear only after they are configured in MediaStor.

Note: If Jukebox Manager fails to initialize, you can initialize it manually. 
From the File menu in Jukebox Manager, select Initialize. A check 
mark appears beside the Initialize command in the File menu, and 
the Jukebox List window appears.

Note: If you close a Jukebox window or shut down Jukebox Manager, the 
Jukebox List window also closes. You can reopen it by selecting 
the List option from the Jukebox menu (when Jukebox Manager is 
initialized).

3. From the Jukebox List window, you have the following choices:
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• View a library’s profile. For more information, see "Viewing a Library 
Profile, " which follows. 

• Open a Jukebox window for a library, from which you can view and 
manage media in the library. To open a Jukebox window, select the 
library you want to manage and then click Select. (You can also 
double-click the library to open the Jukebox window.)

Figure 156.  Jukebox Window 

The Jukebox window displays basic information about the library, including 
its description, SCSI address, library type, interface type, number of 
drives, and number of shelves. 

In addition to basic information about the library, the Jukebox window also 
provides a shelf-by-shelf view of the library. Shelves are listed to the left of 
the window and a scroll bar allows you to browse all of the shelves. The 
center of the window lists the drives in the library, as well as the mailslot. 
Each shelf, drive, and mailslot appears at all times regardless of whether it 
contains media.

The SCSI address of the library also appears in the title bar of the Jukebox 
window so that you can easily note which library’s information is being 
displayed in the active window. All commands for a library must be 
performed while that library window is active. Any command executed 
affects the active window. The following sections explain the commands 
that can be performed through Jukebox Manager.

Note: All procedures (except for the library profile procedure below) 
outlined in the following sections assume you have opened the 
Jukebox window for the library for which you want to perform that 
function.
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■ Viewing a Library Profile
Since all libraries are different and have slightly different functionality, the 
Jukebox Profile is helpful for determining not only the SCSI ID and description 
of the library, but also particular functions of the library, such as whether 
double-sided media is supported. 

To view a library profile:

1. In the Jukebox List window, select the library whose profile you want to 
view and then click Profile. The Jukebox Profile dialog box appears, with 
the SCSI address listed in the title bar. 

Figure 157.  Jukebox Profile Dialog Box 

The Jukebox Profile dialog box contains the following information:

Table 23.  Jukebox Profile Information

Field Description
SCSI Address The SCSI address of the library

Description A description of the library, including the 
library’s vendor and model

Name Whether the library driver is loaded in the                      
ASM supported device list. If the driver is not 
loaded, you cannot see the device when 
adding hardware to MediaStor.

Type The type of library

Interface The type of interface the library uses

Number Of Drives The number of drives in the library

Number Of Shelves The number of shelves in the library



Inventorying a Library

ASM MediaStor System Guide 209
StorageTek Proprietary

2. When you finish, click OK to close the Jukebox Profile dialog box and 
return to the Jukebox List window.

■ Inventorying a Library
When you inventory a library in Jukebox Manager, an account is taken for all 
shelves, full and empty. After an inventory, the Jukebox window shows 
whether each shelf, drive, or mailslot currently contains media.

To inventory a library:

• In the Jukebox window, click the Inventory button, or, from the Jukebox 
menu in the Jukebox window, select Inventory. A confirmation message 
appears.

Figure 158.  Jukebox Inventory Confirmation Message 

3. Click OK. An “Inventory in Progress” status message appears while the 
library is inventoried. Once the inventory is complete, the Jukebox window 
shows media and their locations within the library.

■ Inserting Media
You can insert a piece of media into a library onto any empty shelf. The 
maximum number of drives supported for each jukebox is 128.

To insert a piece of media into a library:

1. Place the piece of media into the mailslot.

2. In the Jukebox window, select the empty shelf into which you want to insert 
the media.

Double Sided Media Whether the library supports double-sided 
media

Drive Eject Required Whether the library requires sending a 
command to eject a drive 

Insert/Eject Whether the library supports automated 
insert/eject of media 

Shelf-To-Shelf Move Whether the library supports automated 
movement of media from one shelf to another

Table 23.  Jukebox Profile Information (Continued)

Field Description



Using Jukebox Manager

210 Second Edition
StorageTek Proprietary

3. Click the Insert button, or, from the Jukebox menu, select Insert Media to 
Shelf. A status message reads “Inserting media” while the media is placed 
onto the shelf. Once inserted, the media appears on the selected shelf in 
the Jukebox window.

Note: If you select the Insert command before you insert the media into 
the mailslot, Jukebox Manager prompts you to insert the media 
before it proceeds.

■ Moving Media
You can move a piece of media from one shelf location to another, provided 
the target shelf location is empty.

To move a piece of media to another shelf:

1. In the Jukebox window, select the shelf that contains the media you want 
to move.

2. Click the Move button, or, from the Jukebox menu, select Move Media 
From Shelf to Shelf. The Move Jukebox Media dialog box appears.

Figure 159.  Move Jukebox Media Dialog Box 

3. In the New Shelf Location text box, enter the location of the shelf to which 
you want to move the media. The default location is the next empty shelf.

4. Click OK. A status message appears to indicate that the move is in 
progress. When the move is complete, the media appears in the new 
location in the Jukebox window.

■ Mounting Media
You can mount a piece of media from a shelf into an empty drive.

Note: When mounting media into a drive that uses the NTFS or FAT file 
system, use the FSMOUNT.EXE utility from a command prompt to 
mount the file system after the media is mounted. For details on using 
FSMOUNT.EXE, refer to the ASM Solutions Knowledge Base 
(accessed through either the StorageTek website, http://
www.support.storagetek.com/ or the program group on the Windows 
Start menu.

http://www.legato.com/support/knowledgebase


Flipping Media

ASM MediaStor System Guide 211
StorageTek Proprietary

To mount a piece of media:

1. In the Shelves list of the Jukebox window, select the shelf that contains the 
piece of media you want to mount in a drive.

2. In the Drives list, select the drive in which you want to mount the media.

3. Click the Mount button, or, from the Jukebox menu, select Mount Media in 
Drive. The Mount Jukebox Media dialog box appears.

Figure 160.  Mount Jukebox Media Dialog Box 

4. Select an invert option. To mount the media with side A up, select No. To 
mount the media inverted so that side B is up, select Yes.

5. Click OK. A status message reads “Mounting…” while the media is 
mounted in the drive. In the Shelves list of the Jukebox window, the media 
appears with the drive number to indicate that it is mounted. In the Drives 
list, the media appears in the selected drive along with its shelf number. 

Figure 161.  Jukebox Window After Mounting Media 

■ Flipping Media
You can flip, or invert, dual-sided media in a drive.
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To invert a piece of media in a drive: 

1. In the Drives list of the Jukebox window, select the drive that contains the 
media you want to flip.

2. Click the Flip button, or, from the Jukebox menu, select Flip Media in 
Drive.

The media is inverted. The Jukebox window reflects this by displaying the 
media with an "I" (for Inverted) after its shelf name (such as S18-I), in both 
the Shelves list and the Drives list.

Figure 162.  Jukebox Window After Flip 

■ Dismounting Media
You can dismount media in a drive and place it back on the shelf on which it 
was located before it was mounted in the drive.

Note: When dismounting media from drive that uses the NTFS or FAT file 
system, use the FSMOUNT.EXE utility from a command prompt to 
dismount the file system after the media is dismounted. For details on 
using FSMOUNT.EXE, refer to the ASM Solutions Knowledge Base 
(accessed through either the StorageTek website, http://
www.support.storagetek.com/ or the program group on the Windows 
Start menu).

To dismount a piece of media: 

1. In the Drives list of the Jukebox window, select the drive that contains the 
piece of media you want to dismount.

2. Click the Dismount button, or, from the Jukebox menu, select Dismount 
Media From Drive. The piece of media is dismounted and placed back on 
its original shelf.
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■ Exchanging Media
You can dismount a piece of media from a library drive, return it to its original 
shelf, and mount a new piece of media in the drive using one command. 

To exchange media in a library drive:

1. From the Shelves list in the Jukebox window, select the shelf that contains 
the media you want to mount in the drive.

2. From the Drives list, select the drive that contains the media you want to 
replace.

3. Click the Exchange button, or, from the Jukebox menu, select Exchange 
Media In Drive. The media in the drive is dismounted and placed back on 
its original shelf, and the other piece of media is mounted in the drive.

■ Ejecting Media
You can eject a piece of media from any shelf in the library, provided the 
media is not currently mounted in a drive. To eject media from a drive, you 
must dismount it from a drive first. For instructions, see “Dismounting Media” 
on page 212.

To eject a piece of media from a library:

1. From the Shelves list in the Jukebox window, select the shelf that contains 
the media you want to eject.

2. Click the Eject button, or, from the Jukebox menu, select Eject Media From 
Shelf. A status message reads “Ejecting media” while the media is ejected 
from the library. Once ejected, the media is placed into the mailslot. In the 
Jukebox window, the media appears in the mailslot.

3. Remove the piece of media from the mailslot.

■ Shutting Down and Exiting Jukebox Manager
Jukebox Manager can run in a shutdown mode so that libraries can be seen 
and used by other applications/services, such as MediaStor and SCSI 
Manager. Only one of these services can access devices at a time.

If you are finished using Jukebox Manager, you can exit Jukebox Manager.

To shut down Jukebox Manager:

• From the File menu of the Jukebox Manager window, select Shutdown. A 
check mark appears by the Shutdown command in the menu and all 
Jukebox windows are closed.
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To exit Jukebox Manager:

• From the File menu, select Exit.

About Jukebox Manager
The About dialog box displays information about your copy of Jukebox 
Manager, including the version number, copyright, and legal notices.

Jukebox List Window
As Jukebox Manager initializes, it looks for all SCSI libraries on the system 
and lists them along with their SCSI addresses and descriptions in the 
Jukebox List window. The description for each library is the actual inquiry 
string from the device. This can be helpful when working with a technical 
support representative to try to resolve an issue. 

Note: Serial libraries appear only after they are configured in MediaStor.

Note: If Jukebox Manager fails to initialize, you can initialize it manually. 
From the File menu in Jukebox Manager, select Initialize. A check 
mark appears beside the Initialize command in the File menu, and the 
Jukebox List window appears.

Note: If you close a Jukebox window or shut down Jukebox Manager, the 
Jukebox List window also closes. You can reopen it by selecting the 
List option from the Jukebox menu (when Jukebox Manager is 
initialized).

From the Jukebox List window, you have the following choices:

• View a library’s profile. 

• Open a Jukebox window for a library, from which you can view and 
manage media in the library. To open a Jukebox window, select the library 
you want to manage and then click Select. (You can also double-click the 
library to open the Jukebox window.)

Jukebox Window
The Jukebox window displays basic information about the library, including its 
description, SCSI address, library type, interface type, number of drives, and 
number of shelves. 

In addition to basic information about the library, the Jukebox window also 
provides a shelf-by-shelf view of the library. Shelves are listed to the left of the 
window and a scroll bar allows you to browse all of the shelves. The center of 
the window lists the drives in the library, as well as the mailslot. Each shelf, 
drive, and mailslot appears at all times regardless of whether it contains 
media.
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The SCSI address of the library also appears in the title bar of the Jukebox 
window so that you can easily note which library’s information is being 
displayed in the active window. All commands for a library must be performed 
while that library window is active. Any command executed affects the active 
window. The following topics explain the commands that can be performed 
through Jukebox Manager.

• “Inventorying a Library” on page 209

• “Inserting Media” on page 209

• “Moving Media” on page 210

• “Mounting Media” on page 210

• “Flipping Media” on page 211

• “Dismounting Media” on page 212

• “Exchanging Media” on page 213

• “Ejecting Media” on page 213
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CUsing RtfPad

Reports and event logs all appear in RtfPad. You can use RtfPad to save, 
print, and email logs, reports, and Event Viewer snapshots. You can also 
configure RtfPad to display event logs in a black-and-white interface, or with 
color to contrast errors and warnings from other events. When you encounter 
system errors, RtfPad allows you to easily find and view descriptions of the 
errors. For more information, see the following:

• "Saving in RtfPad, " which follows

• “Printing in RtfPad” on page 217

• “Previewing and Printing in RtfPad” on page 218

• “Setting up Printing in RtfPad” on page 219

• “Sending from RtfPad” on page 220

• “Changing the Error Format” on page 221

• “Using RtfPad Error Lookup” on page 221

■ Saving in RtfPad
You can save a log, report, or Event Viewer snapshot for future reference.

To save in RtfPad:

1. From RtfPad’s File menu, select Save As. The Save As dialog box 
appears. 

2. Navigate to the location where you want to save the file.

3. In the File name text box, specify a file name.

4. From the Save as type drop-down list, select the file format in which you 
want to save the file.

5. Click Save.

■ Printing in RtfPad
You can print a log, report, or Event Viewer snapshot for future reference.
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To print in RtfPad:

1. From the File menu, select Print, or press <CTRL>+P. The standard 
Windows Print dialog box appears.

Figure 163.  Print Dialog Box 

2. From the Name list, select the printer you want to use.

3. In the Number of copies text box, specify the number of copies you want to 
print. 

4. Make any other print setting selections and then click OK. The file is sent 
to the selected printer. 

■ Previewing and Printing in RtfPad
You can print a log, report, or Event Viewer snapshot for future reference, and 
you can preview it before printing.
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To preview and print in RtfPad:

1. From the File menu, select Print Preview. The text is displayed as it would 
appear when printed.

Figure 164.  Print Preview in RtfPad 

2. You have the following choices:

• To navigate to the next or previous page, click Next Page or Prev 
Page.

• To display two pages at a time, click Two Pages.

• To display one page at a time, click One Page.

• To zoom in on or zoom out, click Zoom In or Zoom Out. 

• To close the print preview without printing, click Close.

3. When you are ready to print the text, click Print.

■ Setting up Printing in RtfPad
You can configure how a log, report, or Event Viewer snapshot is printed from 
RtfPad.
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To set up printing in RtfPad:

1. From the File menu, select Print Setup. The Print Setup dialog box 
appears.

Figure 165.  Print Setup Dialog Box 

2. From the Name list, select the printer that you want to use as the default 
printer. 

3. Select the default paper size, source, and orientation. 

4. Make any other print setting selections and then click OK. 

■ Sending from RtfPad
You can send a log, report, or Event Viewer snapshot to someone by email.

To send an RtfPad file as an email attachment:

1. From the File menu, select Send. A mail dialog box corresponding to your 
email system appears. 

Figure 166.  E-Mail Message with an RtfPad File as an Attachment 
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2. Address the message to the desired user. 

3. Complete the message by adding any other comments.

4. Send the message using your email program’s Send command. 

■ Changing the Error Format
RtfPad can be viewed in a black-and-white interface, or with color to contrast 
errors and warnings from other events. If RtfPad is set for Error Format, text 
appears as described in the following table:

To set RtfPad to display information in error format:

• From the RtfPad View menu, select Error Format. This is a toggle 
command. When enabled (selected), a check mark appears to the left of 
the command.

To disable error format:

• From the RtfPad View menu, select Error Format again. This is a toggle 
command. When disabled, no check mark appears to the left of the 
command.

■ Using RtfPad Error Lookup
When an error appears in RtfPad, an error number appears in brackets with 
the error message. This error number identifies the error and allows you to 
use the RtfPad error lookup feature to obtain additional information about the 
error, including the error name and a brief description. 

To obtain additional information about an error:

1. With the error log open, select the error number.

2. From the View menu, select Error Lookup, or press <F2>. The System 
Error Lookup dialog box appears with the error name and description. 

Table 24.  RtfPad Error Format Colors

Text Color

Errors Red

Warnings Yellow

Header Green

All other text Black
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Figure 167.  System Error Lookup Dialog Box 

3. You have the following choices:

• To scroll through the list of system errors, click the forward or backward 
arrows. 

• To access context-sensitive help for the error glossary, click Help.

• To close the System Error Lookup dialog box, click Close.
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DRemoving MediaStor and Its 
Components

When ASM MediaStor is removed, all configuration settings and system files 
are deleted. If you reinstall MediaStor, new settings must be configured. 
Caution should be taken when removing the product, as all settings are 
permanently lost. 

The MediaStor setup wizard, accessed through the StorageTek MediaStor 
program group in the Windows Start menu, takes you step-by-step through the 
uninstall process. However, you should remove several key components 
before you attempt to uninstall the program. 

Note: If you plan to reinstall MediaStor later, you should create a copy of your 
MediaStor configuration before you uninstall MediaStor. The Repair 
Disk Wizard allows you to back up your MediaStor settings. For 
instructions, see “Copying the Repair Disk Backup” on page 151.

This chapter describes the steps you need to take before uninstalling 
MediaStor. In addition, you will find instructions on running the setup wizard to 
uninstall MediaStor and the MediaStor Remote Administrator. For more 
information, see the following sections:

• "Preparing for Uninstalling MediaStor, " which follows

• “Uninstalling MediaStor” on page 224

• “Uninstalling MediaStor Remote Administrator” on page 227

■ Preparing for Uninstalling MediaStor
For your convenience, the setup wizard allows you to uninstall ASM/DMS 
MediaStor from multiple computers at once. Be sure to prepare each 
computer from which you are removing MediaStor. 

Note: The steps below are only necessary if you are removing MediaStor 
itself. The preparation steps do not apply if you are uninstalling the 
Remote Administrator.

To prepare for removing MediaStor:

1. Remove the MediaStor media service from any Data Manager service 
pointing to the computer from which you are removing MediaStor. For 
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instructions, refer to the Managing Storage Media chapter of the ASM 
Data Manager System Guide.

2. Set all drives and devices offline. For instructions, see the following 
sections:

• “Setting a Library Offline” on page 79

• “Setting a Tower Offline” on page 88

• “Setting a Standalone Drive Offline” on page 97

3. Remove all hardware devices from the MediaStor configuration. For 
instructions, see the following sections:

• “Deleting a Library” on page 81

• “Deleting a Tower” on page 88

• “Deleting a Standalone Drive” on page 97

4. Reboot each MediaStor computer.

5. Stop the MediaStor service. For instructions, see “Managing the MediaStor 
Service” on page 111.

■ Uninstalling MediaStor
Once you have completed the steps listed in the Preparing for Uninstalling 
MediaStor section above, you are ready to uninstall MediaStor. The same 
setup wizard that installed the program can be used to uninstall the program. 
Because the setup wizard allows you uninstall MediaStor from multiple 
computers at once, you may want to determine which computers are to have 
MediaStor removed from them before you run the setup wizard, enabling you 
to run the wizard once rather than multiple times.

Note: If you are removing MediaStor from an active/passive clustered 
environment, you should run the setup wizard to remove the product 
directly on the Primary server (the server node currently in control). 

To remove MediaStor:

1. From the Windows Start menu, select Programs, StorageTek MediaStor, 
and then Setup. The setup wizard appears, starting with the welcome 
page.

2. Click Next. The Installation Options page appears.
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Figure 168.  MediaStor Removal – Installation Options Page 

3. Select Remove product and related items and then click Next. A warning 
appears informing you that uninstalling cannot be undone.

Figure 169.  Uninstall Warning Message 

4. Click Yes to continue. The Target Computers page appears. 

Figure 170.  MediaStor Removal – Target Computers Page 

Note: If you are removing MediaStor from an active/passive clustered 
environment, select the logical cluster name as the target computer 
for removal.

5. You have the following choices:
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• To remove MediaStor from only the computer(s) listed in the Target 
Computers list, click Next. The Summary page appears.

• To remove MediaStor from other computers in addition to the one(s) 
listed in the Target Computers list, click Add. The Browse Computers 
dialog box appears.

Figure 171.  Browse Computers Dialog Box 

6. In the Browse Computers dialog box you have two choices:

• Under Available Computers, navigate to and select the computer from 
which you want to remove MediaStor and then click Add to add the 
computer to the Selected Computers list. 

• In the Computer Name text box, type in the name or the IP address of 
the computer from which you want to remove MediaStor and then click 
Add to add the computer to the Selected Computers list.

Repeat this step for each additional computer from which you want to 
remove MediaStor. When you finish selecting target computers, click OK. 
You are returned to the Target Computers page. 

7. When the Target Computers list is complete, click Next. The Summary 
page appears.

8. Review the information in the summary.

9. If the information in the summary is correct, click Finish. A progress bar 
appears, indicating the completion percentage of the removal process. If 
you are uninstalling from multiple MediaStor computers, separate progress 
bars appear for each computer.

Any settings related to MediaStor in the Windows NT/2000 registry, all 
program files in the installation path, and the MediaStor program group/
folder are removed. 

Then, one of the following occurs:
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• If you are uninstalling from one or more remote computers, the 
MediaStor Setup Result dialog box appears, listing the results for each 
target computer. 

Figure 172.  MediaStor Setup Result Dialog Box 

Take note of any computers that need to be rebooted (or computers on 
which the uninstall failed) and then click OK. Restart each computer for 
which the MediaStor Setup Result dialog box indicates a reboot is 
required. 

• If you are uninstalling from the local machine, a message appears to 
prompt you to reboot the computer. Click Restart to close the message 
and reboot the computer immediately, or Exit to close the message 
without rebooting.

Reboot is necessary after the MediaStor uninstall in order to reset any 
SCSI devices being used by MediaStor on the specified machine(s).

■ Uninstalling MediaStor Remote Administrator
ASM/DMS MediaStor Remote Administrator can be removed from a computer 
if necessary. Removing the Remote Administrator from a remote machine 
does not affect the MediaStor computer to which it points. Only the system 
files for the Remote Administrator and Service Manager are deleted. This 
means that you do not need to perform the preparation steps necessary for 
uninstalling the MediaStor program itself.

The same Remote Administrator setup wizard that installed the program can 
be used to uninstall the program. Because the setup wizard allows you to 
uninstall the Remote Administrator from multiple computers at once, you may 
want to determine which computers are to have the Administrator removed 
from them before you run the setup wizard, enabling you to run the wizard 
once rather than multiple times.

Note: If you are removing the Remote Administrator from an active/passive 
clustered environment, you should run the setup wizard to remove the 
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product directly on the Primary server (the server node currently in 
control).

To remove the Remote Administrator:

1. From the Start menu, select Programs, StorageTek MediaStor 
Administrator, and then Setup. The setup wizard opens, starting with the 
welcome page.

2. Click Next. The Installation Options page appears. 

Figure 173.  Remote Administrator Removal – Installation Options Page 

3. Select Remove product and related items and then click Next. A warning 
appears to inform you that the uninstall cannot be undone.

Figure 174.  Uninstall Warning Message 

4. Click Yes to continue. The Target Computers page appears. 
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Figure 175.  Remote Administrator Removal – Target Computers Page 

Note: If you are removing the Remote Administrator from an active/
passive clustered environment, select the logical cluster name as 
the target computer for removal.

5. You have the following choices:

• To remove the Remote Administrator from only the computer(s) listed 
in the Target Computers list, click Next. The Summary page appears.

• To remove the Remote Administrator from other computers in addition 
to the one(s) listed in the Target Computers list, click Add. The Browse 
Computers dialog box appears.

Figure 176.  Browse Computers Dialog Box 

6. In the Browse Computers dialog box you have two choices:

• Under Available Computers, navigate to and select the computer from 
which you want to remove the Remote Administrator and then click 
Add to add the computer to the Selected Computers list. 
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• In the Computer Name text box, type in the name or the IP address of 
the computer from which you want to remove the Remote 
Administrator and then click Add to add the computer to the Selected 
Computers list.

Repeat this step for each additional computer from which you want to 
remove the Remote Administrator. When you finish selecting target 
computers, click OK. You are returned to the Target Computers page. 

7. When the Target Computers list is complete, click Next. The Summary 
page appears.

8. Review the information in the summary.

9. If the information in the summary is complete, click Finish. A progress bar 
appears indicating the completion percentage of the removal process. If 
you are uninstalling from multiple computers, separate progress bars 
appear for each computer.

Any settings related to the Remote Administrator in the Windows registry, 
all program files in the installation path, and the MediaStor Administrator 
program group/folder are removed. 

Then, one of the following occurs:

• If you are uninstalling from one or more remote computers, the 
MediaStor Administrator Setup Result dialog box appears, listing the 
results for each target computer. 

Figure 177.  MediaStor Administrator Setup Result Dialog Box 

Take note of any computers that need to be rebooted (or computers on 
which the uninstall failed) and then click OK. Restart each computer for 
which the MediaStor Administrator Setup Result dialog box indicates a 
reboot is required. 

• If you are uninstalling from the local machine, a message appears to 
prompt you to reboot the computer. Click Restart to close the message 
and reboot the computer immediately, or Exit to close the message 
without rebooting.
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Index

Symbols
.DAT files, 181

Numerics
8mm DAT tape, 15
9840 tape, 15

A
account, service

configuring in MediaStor, 113
configuring in Windows 2000, 117
configuring in Windows NT, 116

active/active cluster, 28
active/passive cluster, 28
Additional Sense Code (ASC), 173, 185
Additional Sense Code Qualifier (ASCQ),
173, 185
Administrative Tools, Windows 2000

managing the service, 117
Administrator, 5, 43

automatically refreshing, 52
components, 45
computer drop-down list, 50
contents view, 49
description view, 50
menu bar, 50
navigating, 43
refreshing, 52
remote, 6, 157
searching, 53
starting, 43
status bar, 52
toolbar, 50
tree view, 45
window, 44

Administrators

adding users, 23, 24
removing users, 25

AIT tape, 15
alerts

accessing, 122
adding, 123
configuring, 122
deleting, 125
modifying, 125

alignment, changing for reports, 144
All Events Log, 128

clearing, 133
configuring, 130
configuring format, 130
configuring maximum size, 130
opening, 128
selecting events to trace, 132

allocating media to the application pool, 99
application pool, 2, 4

allocating media to, 99
deallocating media from, 101

ASCII, 182
ASM, 13, 112
ASM file systems, 17, 20
ASM License Server, 7, 31
ASM MediaStor, 1

administering remotely, 6
components, 4
service, 5

auto clean library drives, 69
auto config

libraries, 57, 65
libraries, order of drives, 57, 65

auto refresh frequency, 52
Auto-Detect Wizard, 164

B
backup, 11, 149
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MediaStor configuration, 11, 28, 149
MediaStor configuration, copying, 151
MediaStor configuration, location, 150
restoring MediaStor from, 153

barcode, 205
binary data files, 182
buffer, 174, 198

data files, 181
data files, reading, 183
data files, writing, 182

buttons, toolbar, 50

C
calibrating SCSI libraries, 187
capacity, media, 106, 200
CDFS media support, 17, 20
CD-R, 15
CD-ROM, 10, 15

drives, support in SCSI Manager, 174
supported file systems, 18, 20, 21

CD-RW, 15
cleaning library drives automatically, 69
clearing

event logs, 133
media errors, 107

clustering, 2, 11, 28, 32
COM port, serial library, 61
command descriptor block, 173
command line utilities, 7
components, 4
computer drop-down list, 50, 169
computer specifications, 14
connecting

hardware, 32
to remote computers, 169

contents view, 49
Control Panel, NT service management, 115
copying media, 11
CPU recommendations, 27
CSS file system support, 17, 21
custom SCSI Manager commands, 192

D
data files, SCSI Manager, 181

ASCII format, 182
binary format, 182

reading, 183
writing, 182

Data Manager, 2
using with MediaStor, 1, 8

data security, 28
deallocating media from the application pool,
101
definition of terms, 2

SCSI, 172
deleting

alerts, 125
libraries, 81
media, 109
report layouts, 148
standalone drives, 97
towers, 88

description view, 50
device, 2

ID, serial library, 61
names, 55
names, serial, 56
report, 139
SCSI, calibrating, 187
SCSI, names, 55
SCSI, rezeroing, 187
SCSI, status, 185
SCSI, test unit ready, 186
status, 173
supported in SCSI Manager, 174

devices, 9
jukebox/library, 9
standalone drive, 9
storage/hardware, 9
tower, 9

diagnostic utilities, 111, 187, 188, 190, 191
disabling

event logging, 127, 130
library drive auto clean, 69

disaster recovery, 11, 149, 153
registry backup, 28

disclaimer, iv
disconnecting from remote computers, 169
dismounting media, 212
DLT tape, 15
drive

library, adding, 61
library, adding manually, 65
library, adding through auto config, 65
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library, auto clean options, 69
library, configuration test, 68
library, order when adding, 57, 65, 66
library, setting order, 67
removing media from, 196, 201
reserved, adding for libraries, 66
selecting type for libraries, 59
supported in SCSI Manager, 174
tower, activation settings, 85, 86
viewing type for standalone drives, 93,

94
drive See standalone drive
DVD libraries with different drive types, 59
DVD-R, 10, 15, 16

drives, support in SCSI Manager, 174
supported file systems, 18

DVD-RAM, 10, 15, 16
drives, support in SCSI Manager, 174
supported file systems, 18

DVD-ROM, 10, 15, 16
supported file systems, 18

DVD-RW, 15

E
ejecting

media, 109, 200
media from libraries, 72, 75, 213
media from standalone drives, 97

element, 174
addresses, 192
characteristics, 192
checking status, 193, 194
moving picker to, 196
parameter, 192

e-mailing
system errors and warnings, 122

emailing
logs and reports, 220

erasable optical media See magneto-optical
errors

configuring format in RtfPad, 221
displaying as alerts, 122
log, 11, 127, 128
log, clearing, 133
log, configuring, 130
log, configuring format, 130
log, configuring maximum size, 130

log, opening, 128
looking up, 128, 129, 221
media, 107
media, clearing, 107

evaluation license, 36
event log, 11, 127, 128

clearing, 133
configuring, 130
configuring format, 130
configuring maximum size, 130
configuring start time, 130
disabling, 130
opening, 128
selecting events to trace, 132

event viewer, 11, 127
clearing, 133
configuring, 130
print previewing in RtfPad, 218
print setup in RtfPad, 219
printing in RtfPad, 217
saving in RtfPad, 217
sending by email, 220

exchanging media, 213
extended drive, definition, 2

F
fail-over in a cluster, 28
FAT media support, 17, 20
file migration, definition, 2
file systems

ASM, 20
benefits and limitations, 18
CDFS, 20
CSS, 21
FAT, media, 20
mounting, 195, 210, 212
multiple, 17
NTFS, media, 20
OSS, 21
portability vs. performance, 18
selecting for libraries, 59
selecting for towers, 85, 86
supported, 17
TSS, 21
UDF, 21
UDF overwritable, 22
UDF sequential, 22
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viewing for standalone drives, 93
Windows Native, 19

find, 53
flipping media, 211
fonts, changing for reports, 144
footer, changing for reports, 142
formatting media, SCSI Manager, 202
free space on media, 106

G
glossary, 2

SCSI, 172

H
hard drive recommendations, 27
hardware, 2

choosing, 26
device, 2
device management, 111
device names, 55
device names, SCSI, 55
device names, serial library, 56
devices, 9
inventory, 80
libraries, 56
report, 135, 139
requirements, 13
verifying connections, 32

header, changing for reports, 142
help, 7

knowledge base, 7
hex, 172
host adapter, recommendations, 27

I
initializing

drives when tower is online, 85, 86
libraries when server starts, 59
standalone drives when server starts, 93

inquiry string, 188
inserting

media in libraries, 72, 73, 209
media in standalone drives, 97

installation

before running setup, 31
creating a service account, 32
date, 121
licensing, 31
MediaStor, 33
on a cluster, 28, 32
overview, 31
Remote Administrator, 159
Remote Administrator setup module, 6
running the wizard, 33
setup module, 5
to multiple computers, 37
upgrading, 33

inventory, library, 80, 209
maximum shelves to use, 71

J
jukebox, 9

definition, 3
managing through Jukebox Manager, 7

Jukebox Manager, 7, 205
dismounting media, 212
ejecting media, 213
exchanging media, 213
flipping media, 211
inserting media, 209
inventory, 209
jukebox profile, 177, 208
jukebox window, 177, 207, 214
mounting media, 210
moving media, 210
shutting down, 202, 213
starting, 175, 205

K
knowledge base, 7

L
layout editor, reports, 141
liability, iv
library, 9

adding drives, 61
adding drives manually, 65
adding drives through auto config, 65
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adding reserved drives, 66
adding to MediaStor, 57
configuring, 59
configuring automatically, 57
definition, 3
deleting, 81
double-sided media, 177, 208
drive auto clean options, 69
drive options, 70
drives, 177, 208
drives, configuration test, 68
DVD with different drive types, 59
ejecting media, 72, 75, 177, 208
element, 174, 192
idle drive dismount, 70
initializing element status, 193
inserting media, 72, 73, 177, 208
inventory, hardware, 80
managing, 56
managing media, 72
managing through Jukebox Manager, 7,

205
maximum shelves to use for inventory,

70, 71
model, 177, 208
modifying, 76, 86
monitoring media status, 72
moving media, 72, 74, 177, 195, 208
naming, 59
order of drives when adding, 57, 65, 66
profile, 177, 208
reading element status, 194
rezeroing, 187
SCSI address, 57, 177, 208
selecting drive type, 59
selecting file system, 59
serial, 61
serial, adding drives, 61
serial, adding drives manually, 65
serial, COM port, 61
serial, device ID, 61
serial, device name, 56
serial, SCSI Manager support, 175
setting drive order, 67
setting offline, 79
setting online, 79
setting online when server starts, 59
shelves, number of, 177, 208

statistics tab, 78
supported in SCSI Manager, 174
vendor, 177, 208
window, 177, 207, 214

license, 31
adding through MediaStor, 39
agreement for MediaStor, 34
agreement for Remote Administrator,

159
evaluation, 36
updating, 39

License Server, 7, 35
licensing information, 126
location of media, 105
logs, 11

all events, 127, 128
errors, 127, 128
event viewer, 127
event, clearing, 133
event, configuring, 130
event, configuring format, 130
event, configuring start time, 130
event, impact on performance, 132
event, limiting size, 130
event, selecting to trace, 132
impact on performance, 128, 130
opening, 128
previewing in RtfPad, 218
print setup in RtfPad, 219
printing in RtfPad, 217
saving in RtfPad, 217
sending by email, 220
warnings, 127, 128

looking up errors, 221

M
magneto-optical, 10, 15, 16

drives, support in SCSI Manager, 174
supported file systems, 18

Magstar tape, 15
manual registration, 166
media, 14

allocating to the application pool, 99
available space, 106
browsing, 178
capacity, 200
CD-R, 15
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CD-ROM, 10, 15
CD-RW, 15
copying, 11
deallocating from the application pool,

101
definition, 3
deleting, 109
description, 103
dismounting, 212
double-sided, 177, 208
DVD-R, 10, 15, 16
DVD-RAM, 10, 15, 16
DVD-ROM, 10, 15, 16
DVD-RW, 15
ejecting, 72, 75, 109, 177, 200, 208,

213
errors, statistics, 107
exchanging, 213
file read statistics, 107
file systems, 17, 103
file write statistics, 107
flipping, 211
formatting, 202
general tab, 103
inserting, 72, 73, 177, 208, 209
location tab, 105
magneto-optical, 10, 15, 16
managing, 72, 99
mount statistics, 107
mount, definition, 2, 3
mounting, 210
moving, 72, 74, 177, 208, 210
moving through SCSI Manager, 195
moving to the scratch pool, 101
name, 103
pool, 3
portability vs. performance, 18
properties, 102
reading sectors, 178
removing from devices, 109
removing from drives, 196, 201
report, 135, 137
rotation, 200
sectors, 178
sectors, reading, 198
sectors, writing to other media, 198
selecting type for libraries, 59
serial numbers, 104

services, 3, 8
size, 103
space tab, 106
standalone drive, 94
standalone drive, ejecting, 97
standalone drive, inserting, 97
standalone drive, managing, 97
standalone drive, viewing size, 94
standalone drive, viewing status, 94
standalone drive, viewing type, 93, 94
statistics tab, 107
status, 72, 103
supported file systems, 17
supported types, 15
tape, 10, 15, 16
type, 3, 10, 103
viewing properties, 94
WORM, 10, 15, 16
WORM-Tape, 10, 15, 17

MediaStor, 1
administering remotely, 6
Administrator, 43
components, 4
configuration backup, 28, 149
configuration restoration, 153
configuring, 39
installation date, 121
installing, 31, 33
licensing, 31, 39
licensing information, 126
managing the computer, 111
MSAdministrators, 22
preparing to uninstall, 223
registry report, 135, 140
security, 22
service, 5, 11, 111
service account, 113, 116, 118
service, managing, 112
setup module, 5
system management, 10
system planning, 13
uninstalling, 223, 224
upgrading, 33
using with Data Manager, 1, 8
version number, 121

memory
buffer, 174, 198
recommendations, 27
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requirements, 14
menu bar, 50
mode sense, 192
monitoring MediaStor with event logs, 127
mounting media, 210

definition, 2, 3
moving media, 72, 74, 195, 210
MSAdministrators, 22

adding users to, 23, 24
for remote administration, 158
removing users from, 25

N
name

changing for report layouts, 146
conventions for hardware devices, 55
setting for libraries, 59
viewing for standalone drives, 93

NTFS
file system, mounting, 195, 210, 212
media support, 17, 20

O
offline

library, 79
standalone drive, 97
tower, 88

online
library, 79
library, setting when server starts, 59
standalone drive, 97
tower, 88
tower drives, setting when tower is on-

line, 85, 86
online help, xi, 7
opening

MediaStor, 43
Remote Administrator, 163

operating system requirements, 14, 158
optical media See magneto-optical
optimizing performance, 25
order of library drives, 57, 65, 66, 67
OSS file system support, 17, 21
overwritable

definition, 3
UDF file system, 17, 22

P
performance

hardware, 26
SCSI device host adapter, 27
storage media, 18

picker, moving in libraries, 196
planning

MediaStor installation, 13, 31
Remote Administrator installation, 157

portability of storage media, 18
previewing

logs and reports before printing, 218
navigating, 219
report layouts, 147
zooming in/out, 219

printing
logs and reports, 217
setting up in RtfPad, 219

privileges, security, 22, 158
processor

recommendations, 28
requirements, 14

R
RAM

recommendations, 27
requirements, 14

reading
capacity, 200
media sectors, 198

receiving diagnostics, 191
recommended upgrades, 25

appropriate hardware, 26
dedicated computers, 27
dedicated host adapter, 27
fast network topology, 28
faster CPU, 27
multiple processors, 28
RAM, 27
two hard drives, 27

recovery, 11, 149, 153
confirmation, 155
MediaStor configuration, 153

refreshing, 52
automatically, 52

registering computers, 163
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automatically, 164
manually, 166

registration
MediaStor, 34
Remote Administrator, 160

registry
backup, 11, 149
backup location, 150
backup, copying, 151
report for MediaStor, 135, 140
restoring MediaStor configuration, 153

Remote Administrator, 6, 157
automatically registering, 164
connecting to remote computers, 169
disconnecting computers, 169
installing, 159
installing on multiple computers, 160
manually registering, 166
operating system requirements, 158
registering computers, 163
security and access, 158
setup module, 6
starting the first time, 163
uninstalling, 227

removable media, 4
removable media drive, 3
removing

media, 109
media through SCSI Manager, 196, 201
MediaStor and components, 223

renaming report layouts, 146
repair disk, 11, 149

copying current configuration, 151
restoring MediaStor configuration, 153
setting backup location, 150

Report Generator Wizard, 135
reports, 11, 135, 155

changing header and footer, 142
creating, 135
hardware configuration, 135, 139
layout editor, 141
layouts, 135
layouts, changing header and footer, 142
layouts, creating, 142
layouts, deleting, 148
layouts, editing styles, 144
layouts, previewing, 145, 147
layouts, renaming, 146

layouts, switching between, 147
media, 135, 137
print previewing in RtfPad, 218
print setup in RtfPad, 219
printing in RtfPad, 217
product registry information, 135, 140
saving in RtfPad, 217
sending by email, 220

requesting sense data, 190
requirements

security, 22
system, 13

reserved drives, adding for libraries, 66
resetting

event logs, 133
media statistics, 107

restoring
confirmation, 155
MediaStor, 149, 153

rezeroing libraries, 187
RPC connection, 28, 158
RtfPad

error format, configuring, 221
error lookup, 129, 221
print previewing logs and reports, 218
printing logs and reports, 217
saving logs and reports, 217
sending logs and reports by email, 220
setting up printing, 219
taking an event viewer snapshot, 127
viewing event logs in, 128

S
saving logs and reports, 127, 217
scratch pool

allocating media to the application pool,
99

deleting media from, 109
moving media to, 101

SCSI, 171
cable length, 32
device names, 55
device status, 185
libraries, adding drives, 61
libraries, adding drives manually, 65
libraries, adding drives through auto con-

fig, 65
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library address, 57
request, 185

SCSI Manager, 6, 171
browsing media, 178
buffer, 174
buffer data files, 181
buffer data files, reading, 183
buffer data files, writing, 182
command descriptor block (CDB), 173
custom commands, 192
determining read capacity, 200
device status, 173
device types, 174
ejecting media, 200
element, 174, 192
initializing element status, 193
inquiry string, 188
mode sense, 192
position to element, 196
reading element status, 194
receive diagnostics, 191
removing media, 196, 201
request, 185
request sense, 190
rezero unit, 187
send diagnostics, 190
sense dump, 185
sense structure, 185
serial libraries support, 175
starting, 175
starting media rotation, 200
stopping media rotation, 200
test unit ready, 186
using hex numbers, 172

searching, 53
media sectors, 179

sectors, media, 178
going to, 180
reading, 178, 198
searching, 179
speed test, 181
writing to other media, 198

security
data, 28
remote administration, 158
Windows, 22

sending
alerts of system errors or warnings, 122

diagnostics, 190
logs and reports by email, 220

sense data, 173, 185
requesting, 190

sequential
definition, 4
UDF file system, 17, 22

serial libraries, 61
adding drives, 61
adding drives manually, 65
COM port, 61
device names, 56
SCSI Manager support, 175

serial numbers, media, 104
service, 5

account, 35, 112, 113, 116, 118
account, system, 113, 116, 118
alerts tab, 122
configuring, 120
creating an account, 32
disabling, 111, 113, 116, 118
general tab, 121
licensing information tab, 126
managing, 11, 111
managing in Windows 2000, 117
managing in Windows NT, 115
managing through MediaStor, 112
pausing, 112, 115, 117
settings, configuring, 113, 115, 116,

117, 118
starting, 112, 115, 117
startup settings, 111, 112, 113, 116, 118
startup settings, automatic, 113, 116,

118
startup settings, disabled, 113, 116, 118
startup settings, manual, 113, 116, 118
stopping, 112, 115, 117

Service Manager, 112, 113
setup, 5

hardware connections, 32
licensing, 39
MediaStor, 33
Remote Administrator, 6, 159

space management on media, 106
speed test, 181
standalone drive, 9

deleting, 97
ejecting media, 97
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general tab, 93
inserting media, 97
managing, 89
managing media, 97
media information, 94
media size, 94
media status, 94
media tab, 94
modifying, 92
setting offline, 97
setting online, 97
setting online when server starts, 93
statistics tab, 95
supported in SCSI Manager, 174
viewing drive type, 93, 94
viewing file system, 93
viewing name, 93

starting
MediaStor, 43
Remote Administrator, 163

stationary drive, 4
stationary media, 4
statistics

library mount, 78
library read/write, 78
media, 107, 137
media errors, 107
media file reads/writes, 107
media mount, 107
reports, 135
standalone drive, 95

status bar, 52
storage devices, 9
storage media See media
StorageTek, xi
supported

file systems, 17
media types, 10, 15

system
backup and recovery, 149
error lookup, 129
errors and warnings, displaying as alerts,

122
errors and warnings, logs, 128
management, 10
performance, impact of logs, 128, 130
service account, 113, 116, 118

system requirements, 13

computer specifications, 14
considerations, 13
operating system, 14

T
tape, 10, 15, 16

8mm DAT, 15
9840, 15
AIT, 15
DLT, 15
drives, support in SCSI Manager, 174
file system support, 21
libraries, auto clean, 69
Magstar, 15
supported file systems, 18

testing
library drive configuration, 68
media speed, 181
SCSI devices, 190, 191

toolbar, 50
hiding, 50
showing, 50

tower, 9
adding, 82, 90
deleting, 88
drive activation settings, 85, 86
managing, 81
modifying, 86
selecting file systems, 85, 86
setting drives online when tower is on-

line, 85, 86
setting offline, 88
setting online, 88

tree view, 45
moving media to the application pool, 99
moving media to the scratch pool, 101

troubleshooting, 111, 190, 191
libraries, 205
logs, 127
looking up errors, 129, 221
SCSI, hardware difficulties, 187
using command line utilities, 7
using sense data, 185

TSS file system support, 17, 21
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U
UDF file system support, 17, 21
uninstalling

MediaStor, 223, 224
MediaStor, preparation, 223
Remote Administrator, 227

upgrades, 25
appropriate hardware, 26
dedicated computers, 27
dedicated host adapter, 27
fast network topology, 28
faster CPU, 27
multiple processors, 28
RAM, 27
two hard drives, 27

upgrading from previous versions, 33
user rights, 22

adding, 23, 24
removing, 25

utilities
command line, 7
diagnostic, 187, 188, 190, 191
Jukebox Manager, 7, 205
SCSI Manager, 6, 171

V
version number, MediaStor, 121

W
warning

displaying as alerts, 122
log, 11, 127, 128
log, clearing, 133
log, configuring, 130
log, configuring format, 130
log, configuring maximum size, 130
log, opening, 128

warranties, iv
Windows

application log, 130
managing the service in 2000, 117
managing the service in NT, 115
native file systems, 17, 19
NT/2000 service, MediaStor, 111
registry report for MediaStor, 135, 140

registry, supported devices in, 55, 57
security, 22, 158

wizard
Auto-Detect, 164
Hardware, 82, 90
MediaStor Setup, 33, 223
MediaStor Uninstall, 224
Remote Administrator Setup, 159
Remote Administrator Uninstall, 227
Repair Disk, 150, 151, 153
Report Generator, 11, 135

WORM, 10, 15, 16
drives, support in SCSI Manager, 174
supported file systems, 18

WORM-Tape, 10, 15, 17
supported file systems, 18

X
XtenderSolutions License Server, 35
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